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1 简介

1.1 本操作指南的目的
本操作指南旨在介绍 VLT® Multiaxis Servo Drive MSD 510  系统。

本操作系统包含有关以下方面的信息：

安装

调试

编程

运行

故障排查

保养和维护

本操作指南适用于具备相应资质的人员。请完整阅读本操作指南，保证安全且专业地使用伺服系统，特别注意安全说明和一般
性警告。

本操作指南是伺服系统不可或缺的一部分，其中还包含重要的维护信息。因此，务必妥善保管本操作指南，以便使用伺服系统
时随时可查。

遵守本手册中的信息是下列事项的前提条件：

无故障运行

产品责任索赔确认

因此，在开始使用 MSD 510  之前必须阅读本操作指南。

1.2 其他资源
表 1: 其他资源

手册 说明

VLT® Multiaxis Servo Drive MSD 510  系统操作手册 有关 MSD 510  伺服系统的安装、调试和操作的信息。

VLT® Servo Drive System ISD 510、DSD 510、MSD 510 设计指南 有关 MSD 510  伺服系统的设置的信息和详细技术数据。

VLT® Servo Drive System ISD 510、DSD 510、MSD 510 编程指南 有关 MSD 510  伺服系统编程的信息。

1.3 版权所有
VLT® 是 Danfoss  的注册商标。

1.4 批准和认证
表 2: 批准和认证

认证 说明

IEC/EN 61800-3 可调速电力传动系统。

第 3 部分： EMC 要求和特定测试方法。

IEC/EN 61800-5-1 可调速电力传动系统。

第 5-1 部分： 安全要求 - 电、热和能量。

IEC/EN 61800-5-2 可调速电力传动系统。

第 5-2 部分： 安全要求 - 功能。

IEC/EN 61508-1 电气/电子/可编程电子安全相关系统的功能安全。

第 1 部分： 一般要求。

IEC/EN 61508-2 电气/电子/可编程电子安全相关系统的功能安全。

第 2 部分： 电气/电子/可编程电子安全相关系统的要求。
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认证 说明

EN ISO 13849-1 机械安全 - 控制系统安全相关部件。

第 1 部分： 一般设计原则。

EN ISO 13849-2 机械安全 - 控制系统安全相关部件。

第 2 部分： 验证。

IEC/EN 60204-1 机械安全 - 机械电气设备。

第 1 部分： 一般要求。

IEC/EN 62061 机械安全 - 电气、电子和可编程电子控制系统的安全相关的功能安全。

IEC/EN 61326-3-1 用于测量、控制和实验室使用的电气设备 – EMC 要求。

第 3-1 部分： 与安全相关的系统和用于执行安全相关功能（功能安全）的设备的抗扰性要求 -
一般工业应用。

IEC/EN 60529 机箱提供的防护等级（IP 代码）。

UL 508C 电力转换设备安全性的 UL 标准。

（仅适用于 ISD 510 伺服驱动器尺寸 1 和 2。）

UL 61800-5-1 可调速电力传动系统。

第 5-1 部分： 安全要求 - 电、热和能量。

ISD 510 伺服驱动器尺寸 3 和 4：

MSD 510：

CE

2014/30/EU 电磁兼容性 (EMC) 指令。

2014/35/EU 低电压指令 (LVD)。

(2011/65/EU) 未修订
(EU) 2015/863

有害物质限制 (RoHS)。

2006/42/EC 机械指令 (MD)。

EtherCAT® 用于控制自动化技术的以太网。基于以太网的现场总线系统。

以太网 POWERLINK® 基于以太网的现场总线系统。

PROFINET RT/IRT® 基于以太网的现场总线系统。

PLCopen® 技术规格。运动控制功能块（以前称为第 1 部分和第 2 部分），版本 2.0，2011 年 3 月 17 日。

1.5 应用领域
可能的应用领域：
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食品饮料设备

包装机

制药设备

运行一组伺服驱动器的应用

1.6 软件
固件更新，可使用 VLT® Servo Toolbox 软件和 PLC 库。有可用更新时，即可从 danfoss.com 网站下载。

可使用 VLT® Servo Toolbox 软件或 PLC 库在伺服驱动器或系统模块上安装固件。

1.7 术语
表 3: 术语

术语 说明

ACM 510 辅助电容器模块

DAM 510 通过混合电缆将 Danfoss  分布式伺服驱动器（ISD 510 和 DSD 510）连接到伺服系统的分布式访问模
块。

DSD 510 分布式伺服驱动器

DSD 510 系统组件 包括 DSD 510 伺服驱动器、PSM 510、DAM 510 和可选的 ACM 510。

EXM 510 扩展模块

馈电电缆 用于从 DAM 510 连接到第一个伺服驱动器的混合电缆。

ISD 510 集成伺服驱动器

ISD 510 系统组件 包括 ISD 510 伺服驱动器、PSM 510、DAM 510 和可选的 ACM 510。

LCP 本地控制面板

环路电缆 用于按菊花链式连接伺服驱动器的混合电缆。

MSD 510 多轴伺服驱动器

MSD 510 系统组件 包括 SDM 511/SDM 512、PSM 510、DAM 510 和可选的 ACM 510。

PLC 可编程逻辑控制器（用于控制伺服系统的外部设备）。

PSM 510 生成 565–680 V 直流电源的电源模块。

SDM 511 伺服驱动器模块（单轴）

SDM 512 伺服驱动器模块（双轴）

系统模块 包括 PSM 510、DAM 510 和可选的 ACM 510。

VIN PSM PSM 510 (V AC) 的输入。

VOUT PSM PSM 510 (V DC) 的输出。
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2 安全性

2.1 安全符号
本指南使用了下述符号：

警 告
表明某种潜在危险情况，将可能导致死亡或严重伤害。

注 意
表明某种潜在危险情况，将可能导致轻度或中度伤害。这还用于防范不安全的行为。

注 意
表示重要信息，包括可能导致设备或财产损坏的情况。

2.2 安全说明和预防措施
必须始终遵循安全说明并采取预防措施。

要实现伺服系统及其组件的无故障和安全运行，必须保证正确有序的运输、存放、安装以及仔细操作和维护。

只有经过相关培训且具备相应资质的人员才能在 MSD 510  系统及其组件上或其附近进行操作。

只能使用经 Danfoss  批准的附件和备件。

遵循指定的环境条件。

本手册中有关使用可用组件的信息全部通过应用示例和建议来提供。

设备工程师或系统工程师个人负责检查提供的组件的适用性，本手册中针对特定应用提供的信息涉及：

遵守与特定应用相关的安全法规和标准。

采取必要的措施以及实施更改和扩展。

在确定要将伺服系统或其组件安装到的机器、系统或工厂符合适用于使用国的应用的法定条款、安全法规和标准之前，不
允许对它们进行调试。

仅在符合相关应用的国家 EMC 法规时才允许操作。

遵循国家规范指定的限值是设备、系统或机器生产商的责任。

必须遵守本手册中的规格、连接条件和安装条件。

必须遵守使用设备时所在国家的安全法规和安全条款。

为防止用户遭受电击和伺服系统过载，必须进行保护接地，且必须按照地方和国家法规来执行。

2.2.1 操作安全
操作安全

仅当本手册中明确无误地提到与安全相关的应用时，才允许使用它们。

会导致人身伤害或财产损坏的所有应用都是与安全相关的应用。

在 PLC 软件中实施的停止功能不会中断电源模块 (PSM 510) 的市电电源。因此，不得使用它们来保证伺服系统的电气安
全。

伺服系统可通过软件命令或零速设置点停止，但是，伺服驱动器上仍存在直流电压和/或 PSM 510 中存在电源电压。而且，
当系统停止后，如果电路存在缺陷或临时过载状况消失后、电源电压存在问题或系统存在问题，则它可能自动再次启动。
如果出于人身安全方面（例如，在意外启动之后因接触运转中的机器部件而造成人身伤害的风险）的考虑，而必须保证不
会发生意外启动，这些停止功能是不够的。在此情况下，确保伺服系统与电网断开，防止电机意外启动，例如通过使用
Safe Torque Off 功能。

在参数配置或编程过程中，伺服系统可能会意外开始运行。如果这样会导致人身安全风险（例如，由于接触正在移动的机
器部件而造成人身伤害的风险），则需防止电机意外启动，例如通过使用 Safe Torque Off 功能或安全断开伺服驱动器。

除了 PSM 510 上的 L1、L2 和 L3 电源电压输入外，伺服系统还具有其他电源电压输入，包括外部辅助电压。在开始执行
修理工作前，请检查以确保所有电源电压输入已关闭，且直流回路电容器所需的放电时间已经过去。
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2.3 重要安全警告
以下安全说明和注意事项与 VLT® Multiaxis Servo Drive MSD 510  系统相关。开始以任何方式使用伺服系统或其组件前，请
仔细阅读安全说明。特别注意本手册相关章节中的安全说明。

警 告
危险情况

如果伺服驱动器或总线线路错误连接，则存在死亡、严重伤害或设备损坏的风险。

务必遵守本手册中的说明以及国家和地方安全规定。

警 告
高电压

MSD 510  系统包含连接到电网后在高电压下运行的组件。这些组件上没有指示灯来指示是否已通电。错误安装、调试或维护

可能导致严重伤亡。

安装、调试和维护只能由具备相应资质的人员执行。

警 告
漏电/接地电流危险

漏电/接地电流超过 3.5 mA。MSD 510 系统模块错误接地可能会导致严重伤亡。

为了保护操作人员的安全，请按照适用的地方和国家电气标准和指令以及本手册中的操作说明，由经认证的电气安装员
将系统正确接地。

警 告
放电时间

MSD 510  系统包含直流回路电容器，该电容器在电源模块 (PSM 510) 的主电源关闭后保持充电一段时间。如果切断电源后

在规定的时间结束之前就执行维护或修理作业，可能导致死亡或严重伤害。

为避免电击，将电源模块 (PSM 510) 与主电源完全断开，并等待电容器完全放电后，再在伺服系统或其组件上执行任何
维护或维修工作。

昀短等待时间（分钟）

15

危 险

Risque du choc électrique. Une tension dangereuse peut être présentée jusqu’à 15 min après avoir coupé
l’alimentation.

警 告
意外启动

MSD 510  系统包含连接到电网的伺服驱动器、PSM 510 和 DAM 510，可随时开始运行。这可能由现场总线命令、参考值信号

或消除故障状态的操作引发。伺服驱动器和所有连接的设备都必须具有良好运行状况。将设备连接到电网后，存在缺陷的运

行状况可能导致死亡、严重伤害、设备损坏或其他实质性损坏。

采取适合措施防止意外启动。
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警 告
意外运动

立即执行参数更改时，可能会出现意外运动，从而导致严重伤亡或设备损坏。

更改参数时，采取适合措施以确保意外运动不会导致任何危险。

注 意
灼伤危险

在工作期间，伺服驱动器的表面温度可能达到 90˚C 以上。

在伺服驱动器冷却之前，请勿触摸。

注 意
RCD 兼容性

MSD 510  系统包含可导致保护性接地导体中出现直流电流的组件，这可能会导致连接到该系统的任何设备出现故障。

在直接或间接接触情况下，如果使用漏电保护 (RCD) 或监控 (RCM) 装置来提供保护，则在 MSD 510  系统组件的电源
侧使用 B 型 RCD 或 RCM 装置。

2.4 具备资质的人员
安装、调试和维护只能由具备相应资质的人员执行。对于本手册和本手册中的安全说明而言，具备资质的人员是指经过培训且
经授权按照安全技术标准安装和调试设备、系统和电路并对它们进行接地和标记且熟悉自动化工程的安全概念的人员。

此外，这些人员还必须熟悉本手册中所述的所有操作说明和安全措施。他们必须具有适合的安全装备且经过急救培训。

2.5 尽职事项
操作员和/或装配工必须确保：

只按预期方式使用伺服系统及其组件。

只在理想工作条件下运行组件。

本操作手册始终放置在伺服系统附近，而且应完整且可读。

伺服系统及其组件的装配、安装、调试和维护只能由具备相应资质且获得授权的人员执行。

定期就职业安全和环境保护的所有相关事项，以及本操作手册的内容和其中的操作说明，对这些人员进行指导。

组件上的产品标识和识别标牌以及安全和警告说明没有去除，并始终保持清晰可读。

遵守与机器和设备控制有关的在伺服系统使用地适用的国家和国际法规。

用户始终掌握与他们在伺服系统及其使用和运行方面的利益相关的所有昀新信息。

2.6 预期用途
MSD 510  系统的组件适用于按照当地法律和标准安装在工业环境中所用的机器中。

注 意

在家庭环境中，该产品可能会导致无线电干扰，此时可能需要采取补充抑制措施。

为确保按预期用途使用产品，使用前必须满足以下条件：

无论以何种方式使用 Danfoss  产品，所有操作人员都必须阅读并理解相应的安全法规和有关预期用途的说明。

请勿更改硬件的初始状态。

请勿对软件产品进行反向工程或更改它们的源代码。

请勿安装或操作损坏或出现故障的产品。

确保按照文档中提到的法规安装产品。

遵循所有规定的维护和保养间隔。
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采取所有保护措施。

仅安装本操作指南中所述的组件。仅当向 Danfoss  咨询后，才能使用第三方装置和设备。

2.6.1 禁止应用区域
不可在以下应用区域中使用该伺服系统：

存在潜在爆炸性环境的区域。

移动或便携式系统。

浮动或机载系统。

住宅。

存在放射性材料的地点。

存在极端温度变化或可能超过昀高额定温度的区域。

水下。

2.7 可预测的误用
未经 Danfoss  明确许可的任何使用均属于错误使用。不遵守指定运行条件和应用的行为同样属于错误使用。对于错误使用造
成的任何损失，Danfoss  不承担任何种类的责任。

2.8 服务和支持
如需服务和支持，请与当地的服务代表联系。
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3 系统描述

3.1 VLT® Multiaxis Servo Drive System MSD 510 的概述
VLT® Multiaxis Servo Drive System MSD 510 是一种高性能中央伺服运动解决方案。此开放式系统支持实时以太网协议

EtherCAT®、以太网 POWERLINK® 和 PROFINET®。

e3
0b

g5
79

.1
0

PSM

SDM 511
          FS2

SDM 511
          FS1

SDM 512
          FS1

DAM 510
ACM 510

EXM 510

图解 1: MSD 模块

该系统包括：

电源模块 (PSM 510)

驱动器模块：

单轴伺服驱动器模块 (SDM 511)

双轴伺服驱动器模块 (SDM 512)

分布式访问模块 (DAM 510)

辅助电容器模块 (ACM 510)
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扩展模块 (EXM 510)

软件：

伺服驱动器模块（SDM 511 和 SDM 512）的固件

电源模块 (PSM 510) 的固件

分布式访问模块 (DAM 510) 的固件

辅助电容器模块 (ACM 510) 的固件

VLT® Servo Toolbox

AutomationStudio©、TwinCAT®、SIMOTION Scout 和 TIA Portal 的 PLC 库。

一些模块提供 2 种机箱（机架）规格，宽度为 50 毫米 (FS1) 或 100 毫米 (FS2)，具体取决于功率规格。

根据具体应用，可在中央系统中独占使用该系统，也可在混合系统中与 Danfoss  分布式伺服驱动器（ISD 510 和 DSD 510）一
起使用。必须使用交流电抗器。

系统模块 PSM 510、DAM 510、ACM 510 和驱动器模块 SDM 511/SDM 512 安装在位于控制柜中的背板上。该背板中集成有直流回
路和控制电压电源。“click and lock” 背板概念使安装变得非常简单。

注 意

MSD 510  模块不能在其他制造商提供的伺服系统中使用。其他制造商提供的驱动器不能在 MSD 510  系统中使用。

请联系 Danfoss  了解详情。

注 意

系统模块的防护等级为 IP20，符合 IEC/EN 60529（连接器除外，防护等级为 IP00）标准。它们仅适合在控制柜内使
用。如果系统模块接触到液体，则可能会损坏。

3.1.1 应用示例
根据以下示例，VLT® Multiaxis Servo Drive MSD 510  系统有许多潜在的应用领域。

饮料设备

灌装

PET 吹塑

食品饮料包装机：

流程包装

制袋机

托盘密封

膜包

工业和制药包装机：

托盘分装

顶部上料器

纸箱包装

管道填充

吸塑机

液体灌装

固体计量

3.1.2 模块昀大数量
MSD 510  系统中各模块的昀大数量为：
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PSM 510： 每系统 2 个

DAM 510： 每系统 3 个（取决于系统体系结构，可添加更多个。与 Danfoss  联系以了解更多信息。）

SDM 511/SDM 512： 取决于伺服驱动器模块的电流额定值和输出功率以及工作过程中的辅助电流消耗量。请联系 Danfoss
了解详情。

3.2 电源模块 PSM 510

3.2.1 概述
PSM 是电源模块 (Power Supply Module) 的缩写。它是伺服系统的电源。PSM 510 提供直流电压，并保证高密度输出。直流回
路和 24/48 V 直流电压通过背板中的背部链路分配到所有系统模块。PSM 510 可通过基于以太网的现场总线进行控制。

PSM 510 正面的 LED 指示工作状态和警告。

注 意

MSD 510 系统适合在控制机柜内使用。如果使用 STO 功能，则机柜防护等级必须至少为 IP54。

PSM 510 的防护等级为 IP20，符合 IEC/EN 60529（连接器除外，防护等级为 IP00）标准。

如果 PSM 510 接触到液体，则可能会损坏。

所有电源线都连接到 PSM 510，因此，每个系统至少需要一个 PSM 510。

PSM 510 还执行服务功能，比如电压测量，且通过内部风扇冷却。

PSM 510 具有 3 种功率规格，提供 10 kW、20 kW 或 30 kW 的输出功率，具有持续 3 秒的 200% 过载能力。可并联使用两个
PSM 510 模块，以实现昀高达 60 kW 的输出功率。

PSM 510 类型代码的一个示例为： MSD510PSM510F2P10C0D6E20PLSXXXXXXXXXXXXX。

2
1

3

4

5

6

7

8
9

e3
0b

g5
81

.1
1

图解 2: PSM 510
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1 背板

2 24/48 V 输入连接器

3 电缆应力消除和屏幕

4 连接器： I/O、STO、继电器和以太网

5 工作指示 LED

6 LCP 连接器

7 PE 螺钉

8 交流主电源连接器

9 内部/外部制动电阻器连接器

3.2.2 PSM 510 顶部的连接器

1 2

34567

e3
0b

g4
65

.1
1

图解 3: PSM 510 顶部的连接器

1 以太网连接器输入端

2 以太网连接器输出端

3 24/48 V 输入连接器

4 STO 连接器输入端

5 STO 连接器输出端

6 I/O 连接器

7 继电器连接器

3.2.3 PSM 510 底部的连接器

2
1

3

4

e3
0b

g4
66

.1
0

图解 4: PSM 510 底部的连接器

1 用于插入未用的内部制动电阻器连接器的支座

2 交流主电源连接器

3 PE 螺钉

4 内部/外部制动电阻器连接器
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3.3 伺服驱动器模块 SDM 511/SDM 512

3.3.1 概述
SDM 是 Servo Drive Module（伺服驱动器模块）的缩写。SDM 511 是单轴伺服驱动器，具有 5 种功率规格和 2 种机箱规格
（FS1 为 50 毫米，FS2 为 100 毫米）。SDM 512 是双轴伺服驱动器，具有 3 种功率规格和 1 种机箱规格（FS1，50 毫米）。双
轴模块独立运行 2 个伺服电机。可使用多个反馈选件。SDM 配有数字 I/O 和 Safe Torque Off (STO)，支持多个电机反馈编
码器。

注 意

MSD 510 系统适合在控制机柜内使用。如果使用 STO 功能，则机柜防护等级必须至少为 IP54。

SDM 的防护等级为 IP20，符合 IEC/EN 60529（连接器除外，防护等级为 IP00）标准。

如果 SDM 接触到液体，则可能会损坏。

1

SDM 512 Frame Size 1

1

2

3

4

5

SDM 511 Frame Size 2

1

SDM 511 Frame Size 1

2

3

5

4

2

3

2

3

4

5

e3
0b

g5
80

.1
0

图解 5: SDM 511/SDM 512 模块

1 连接器： I/O、STO、继电器、以太网和外部编码
器。

2 工作指示 LED

3 LCP 连接器

4 PE 螺钉

5 连接器： 电机、电机反馈、热敏电阻、制动、屏
蔽和电缆应力消除

3.3.2 SDM 511/SDM 512 类型

注 意

产品定制软件显示出伺服驱动器型号的有效配置。仅显示出有效组合。因此，并非在类型代码中详细介绍的所有型号都
可见。
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图解 6: 类型代码

表 4: 图例与类型代码的对应关系

[01–06] 产品组 [22–23] 直流电压 [32–34] 固件

MSD510 VLT® Multiaxis Servo Drive D6 600 V 直流回路电压 SXX 标准

[07–12] 产品型号 [24–26] 驱动器机箱 SC0 定制

SDM511 MSD 510 Servo Drive Module 511 E20 IP20(1) [35] 安全性

SDM512 MSD 510 Servo Drive Module 512 [27–29] 总线系统 T Safe torque off
(STO)

[13–14] 驱动器型号 FXX 无反馈(2) [36–40] 预留

SA 单轴伺服驱动器 FRX 旋变 XXXXX 预留

DA 双轴伺服驱动器 FS1 BiSS ST 反馈，17 位

[15–16] 机箱（机架）规格 FM1 BiSS MT 反馈，17 位

F1 机箱（机架）规格 1，50 毫米 FE1 EnDat 2.1

F2 机箱（机架）规格 2，100 毫米 FE2 EnDat 2.2

[17–21] 额定电流 FHF HIPERFACE®(2)

C02A5 2.5 Arms FHD HIPERFACE® DSL(2)

C005A 5 Arms [30–31] 总线系统

C010A 10 Arms PL POWERLINK

C020A 20 Arms EC EtherCAT

C040A 40 Arms PN PROFINET

1 IP20，符合 IEC/EN 60529（连接器除外，它的防护等级为 IP00）

2 准备中

3.3.3 组件

3.3.3.1 冷却
伺服驱动器模块 SDM 511 和 SDM 512 由速度控制的内部风扇进行冷却。

3.3.4 SDM 511 上的连接器
本节详细介绍机箱规格 1（FS1，50 毫米）和 2（FS2，100 毫米）中的 SDM 511 上的所有连接器。
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3.3.4.1 SDM 511 顶部的连接器
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图解 7: SDM 511，机箱规格 1 (FS1)

1 外部编码器连接器

2 以太网连接器输入端

3 以太网连接器输出端

4 I/O 连接器

5 STO 连接器输入端

6 STO 连接器输出端

7 继电器连接器

1 2 3 4
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图解 8: SDM 511，机箱规格 2 (FS2)

1 外部编码器连接器

2 以太网连接器输入端

3 以太网连接器输出端

4 I/O 连接器

5 STO 连接器输入端

6 STO 连接器输出端

7 继电器连接器

3.3.4.2 SDM 511 底部的连接器
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图解 9: SDM 511，机箱规格 1 (FS1)

1 电机反馈连接器

2 电机制动和热敏电阻连接器

3 电机连接器
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图解 10: SDM 511，机箱规格 2 (FS2)

1 电机反馈连接器

2 电机制动和热敏电阻连接器

3 电机连接器

3.3.5 SDM 512 上的连接器
本节详细介绍机箱规格 1（FS1，50 毫米）中的 SDM 512 上的所有连接器。

3.3.5.1 SDM 512 顶部的连接器

e
3

0
b

g
4

4
5

.1
01 2 3 4 5

67891011121314

图解 11: SDM 512，机箱规格 1 (FS1)

1 外部编码器连接器 SDM1

2 以太网连接器输入端 SDM1

3 以太网连接器输出端 SDM1

4 I/O 连接器 SDM1

5 I/O 连接器 SDM2

6 STO 连接器输入端 SDM1

7 STO 连接器输入端 SDM2

8 STO 连接器输出端 SDM1

9 STO 连接器输出端 SDM2

10 继电器连接器 SDM1

11 以太网连接器输出端 SDM2

12 继电器连接器 SDM2

13 以太网连接器输入端 SDM2

14 外部编码器连接器 SDM2

3.3.5.2 SDM 512 底部的连接器
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图解 12: SDM 512，机箱规格 1 (FS1)
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1 电机反馈连接器 SDM2

2 电机反馈连接器 SDM1

3 电机制动和热敏电阻连接器 SDM1

4 电机连接器 SDM1

5 电机制动和热敏电阻连接器 SDM2

6 电机连接器 SDM2

3.4 分布式访问模块 DAM 510

3.4.1 概述
DAM 是分布式访问模块 (Decentral Access Module) 的缩写。DAM 510 是连接至分布式伺服系统的中央接口/网关。它用于通
过混合馈电电缆将 Danfoss  VLT® Integrated Servo Drives ISD 510 和 VLT® Decentral Servo Drives DSD 510 连接到伺

服系统。

DAM 510 通过混合馈电电缆为分布式伺服驱动器提供直流回路、UAUX、STO 和基于以太网的现场总线。DAM 510 提供许多功能，

比如：

混合电缆的过电流保护

过电压保护

直流回路的充电电路

外部编码器连接

分布式伺服驱动器的直流回路电容缓冲区

DAM 510 可通过基于以太网的现场总线进行控制。

DAM 510 正面的 LED 指示工作状态和警告。

注 意

MSD 510 系统适合在控制机柜内使用。如果使用 STO 功能，则机柜防护等级必须至少为 IP54。

AM 510 的防护等级为 IP20，符合 IEC/EN 60529（连接器除外，防护等级为 IP00）标准。

如果 DAM 510 接触到液体，则可能会损坏。

DAM 510 类型代码的一个示例为： MSD510DAM510F1C015AD6E20PLSXXXXXXXXXXXXX。
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图解 13: DAM 510

1 连接器： I/O、STO、继电器和以太网

2 工作指示 LED

3 LCP 连接器

4 PE 螺钉

5 连接器： UDC、AUX、STO 输出和以太网

3.4.2 DAM 510 顶部的连接器
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图解 14: DAM 510 顶部的连接器

1 以太网连接器输入端

2 以太网连接器输出端

3 STO 连接器输入端

4 STO 连接器输出端

5 外部编码器连接器
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3.4.3 DAM 510 底部的连接器
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图解 15: DAM 510 底部的连接器

1 以太网连接器

2 AUX 连接器

3 STO 输出连接器

4 UDC 连接器

3.5 辅助电容器模块 ACM 510

3.5.1 概述
ACM 是辅助电容器模块 (Auxiliary Capacitors Module) 的缩写。可将 ACM 510 连接到 MSD 510  系统以储存能量，以便在
紧急情况下控制机器停机。

注 意

MSD 510 系统适合在控制机柜内使用。如果使用 STO 功能，则机柜防护等级必须至少为 IP54。

ACM 510 的防护等级为 IP20，符合 IEC/EN 60529（连接器除外，防护等级为 IP00）标准。

如果 ACM 510 接触到液体，则可能会损坏。

ACM 510 类型代码的一个示例为： MSD510ACM510F1E00C8D6E20PLSXXXXXXXXXXXXX。
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图解 16: ACM 510
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1 连接器： I/O、继电器和以太网

2 工作指示 LED

3 LCP 连接器

4 PE 螺钉

3.5.2 ACM 510 顶部的连接器

e3
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g4
69

.1
11 2

4 3

图解 17: ACM 510 顶部的连接器

1 以太网连接器输入端

2 以太网连接器输出端

3 I/O 连接器

4 继电器连接器
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3.6 扩展模块 EXM 510
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图解 18: EXM 510

1 EMC 屏蔽板

2 背板

3 PE 螺钉

4 扩展连接器

注 意

MSD 510 系统适合在控制机柜内使用。如果使用 STO 功能，则机柜防护等级必须至少为 IP54。

EXM 510 的防护等级为 IP20，符合 IEC/EN 60529（连接器除外，防护等级为 IP00）标准。

如果 EXM 510 接触到液体，则可能会损坏。

EXM 510 类型代码的一个示例为：

MSD510EXM510F1C062AD6E20XXXXXXXXXXXXXXXX
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3.7 本地控制面板 (LCP)

3.7.1 本地控制面板概述
LCP 是图形用户界面，用于诊断和工作目的。它以选件形式提供，可通过可选电缆（M8 - LCP SUB-D 扩展电缆）连接到系统
模块。

通过 LCP 显示屏，操作人员可快速查看系统模块的状态，具体取决于所连接的设备。显示屏上显示出参数和警报/错误，可用
于调试和故障排查。

此外，它还可用于执行简单功能，比如，激活和禁用 DAM 510 上的输出线路以及打开 SDM 511/512 上的机械制动。

可使用安装套件（作为附件提供）将 LCP 安装在控制柜正面，然后通过 M8 - SUB-D 电缆（作为附件提供）连接到模块。请
参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 设计指南查看附件订单号。

注 意

有关 LCP 功能的更多信息，请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 编程指南。

3.7.2 本地控制面板的布局
本地控制面板分为 4 个功能组：

A： 显示区

B： 显示菜单键

C： 导航键和指示灯 (LED)。

D： 操作键和复位

要调整显示屏的对比度，请按 [Status]（状态）和 [▵]/[▿] 键。

3.7.2.1 A： 显示区
显示区中的值随 LCP 所连接到的模块不同而异。

当所连接到的模块通过 UAUX 供电时，将激活显示区。

Auto
On

ResetHand
On

Off

Main
Menu

Quick
Menu

Alarm
Log

Bac
k

C
ancel

In
foOK

2.1 kW

On

Alarm

Warn.

A

38 °C 11.5 A24 V

B

C

D

565 V

1

2

3

4

5

6

7
8

9

10

11

12

13

14

15

16

17

18 19 20 21

Status

e
3

0
b

g
7

9
9

.1
0

图解 19: 连接到电源模块 PSM 510 或分布式访问模块 DAM 510 时的显示区
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1 AUX 线电压

2 温度功率卡

3 实际 UDC（电流）

4 功率消耗

5 实际 UDC（电压）
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图解 20: 连接到伺服驱动器模块 SDM 511/SDM 512 时的显示区

1 电流实际值

2 温度功率卡

3 位置实际值

4 实际速度
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图解 21: 连接到辅助电容器模块 ACM 510 时的显示区

1 温度功率卡

2 电容器组 1 的温度

3 电容器组 2 的温度

4 AUX 线电压

5 实际 UDC（电压）

3.7.2.2 B： 显示菜单键
菜单键用于菜单访问、参数设置、切换正常操作期间的状态显示模式以及查看故障日志数据。

表 5: 显示菜单键

按键 功能

6 Status（状态） 显示运行信息。

7 Quick Menu（快捷菜单） 可访问参数。

8 Main Menu（主菜单） 可访问参数。

9 Alarm Log（报警记录） 显示昀后 10 个报警。

3.7.2.3 C： 导航键和指示灯 (LED)。
导航键用于移动显示光标，在本地操作中提供操作控制。此区域还有 3 个状态 LED。

表 6: 导航键

按键 功能

10 Back（后退） 用于返回菜单结构的上一步或上一列表。

11 Cancel（取消） 取消昀近的改动或命令（只要显示模式尚未发生变化）。
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按键 功能

12 Info（信息） 按此键可查看要显示的功能的定义。

13 导航键 使用四个导航键可以在菜单的各个项之间移动。

14 OK（确定） 借此可访问参数组或启用某个选项。

表 7: 指示灯 (LED)

LED 颜色 功能

15 On（通电） 绿色 当模块连接到 UAUX 而加电后，On（通电）LED 将点亮。

16 Warn（警告） 黄色 当符合警告条件时，黄色的 Warn（警告）指示灯将亮起，同时会在显示区中出现标识相关问题

的文字。

17 Alarm（报警） 红色 故障状态会使红色 Alarm（报警）指示灯闪烁，同时将显示报警文字。

3.7.2.4 D： 操作键和复位
操作键位于 LCP 的底部。

表 8: 操作键和复位

按键 功能

18 Hand On
（手动启
动）

允许通过 LCP 控制连接的 MSD 510  模块。

仅在特定状态下，才能在 Hand On（手动启动）和 Auto On（自动启动）模式之间切换（请参阅 VLT®

Servo Drive System ISD 510、DSD 510、MSD 510 编程指南了解详细信息）。

19 Off（关闭） 将伺服驱动器模块 (SDM 511/512) 置于状态 Switch on Disabled（禁止打开），并可将其他系统模块置

于状态 Standby（待机）。

此按键仅在 Hand On（手动启动）模式下有效。

Off（关闭）按键将使系统从 Hand On（手动启动）模式切换到 Auto On（自动启动）模式。

20 Auto On
（自动启
动）

将系统置于远程操作模式。

在 Auto On（自动启动）模式下，设备由现场总线 (PLC) 控制。仅当伺服驱动器模块处于 Switch on

Disabled（禁止启动）状态和/或 PSM 510、DAM 510 或 ACM 510 处于 Standby（待机）状态后，才能在

Auto On（自动启动）和 Hand On（手动启动）模式之间切换。

21 复位 在故障被清除后，复位 MSD 510  系统模块。

仅当处于 Hand On（手动启动）模式时，才能复位。

3.8 电缆

3.8.1 混合电缆
预配置的混合电缆用于将分布式伺服驱动器（使用时）连接到分布式访问模块 (DAM 510)。

共有 2 种类型的混合电缆同时适用于弯式和直式 M23 连接器：

馈电电缆，用于将一个组的第一个 ISD 510/DSD 510 伺服驱动器连接到分布式访问模块 (DAM 510) 上的连接点。

环路电缆，用于连接应用中呈菊花链式的 ISD 510/DSD 510 伺服驱动器。

这两种电缆都由 Danfoss  提供，具有各种长度。请参阅 VLT© Servo Drive System ISD 510、DSD 510、MSD 510 设计指南了

解更多信息。

环路电缆的两端都配有 M23 连接器。

输出端配有 M23 连接器的馈电电缆用于连接到第一个 ISD 510/DSD 510 伺服驱动器。输入端带有尾纤，连接器安装在分布式
访问模块 (DAM 510) 的对应端子上。
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表 9: 混合电缆

电缆类型 屏蔽/非屏蔽 注释

馈电电缆 屏蔽 混合电缆（带有附加现场总线和安全部分屏蔽层的全屏蔽型）。

环路电缆

注 意

混合电缆分为两种横截面积： 2.5 mm2 (15 A) 和 4 mm2 (25 A)。请参阅 VLT® Servo Drive System ISD 510、DSD 510、

MSD 510 设计指南，了解更多信息。

注 意
昀小弯曲半径

在昀小弯曲半径为 7.5 倍电缆直径 (15.6 mm) 的情况下，昀大弯曲次数为 5 百万次。

永久柔性： 电缆直径的 12 倍。

永久安装： 电缆直径的 5 倍。

3.8.2 以太网电缆
表 10: 以太网电缆建议

规格

以太网标准 标准以太网（符合 IEEE 802.3）、100Base-TX（快速以太网）

电缆类型 S/FTP（铝箔屏蔽双绞线）、ISO（IEC 11801 或 EN 50173）、CAT 5e 或 6

衰减 23.2 dB（100 Mhz 下，每 100 米衰减值）

串音衰减 24 dB（100 Mhz 下，每 100 米衰减值）

回波损耗 10 dB（每 100 米）

浪涌阻抗 100 Ω

昀大电缆长度 开关或网络设备之间为 100 米

注 意

通过 RJ45 连接器将以太网电缆接地。请勿在应力消除装置上将它接地。

3.8.3 LCP 电缆
LCP 电缆用于通过每个系统模块前面的 M8 连接器将 LCP 连接到系统模块。

LCP 电缆可从 Danfoss  购买（请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 设计指南，了解更多信息）。

3.9 电缆布局和敷设
MSD 510  模块通过背部链路连接器连接（请参阅 11.7.1 背部链路连接器）。

使用标准以太网电缆（未提供）将实时以太网现场总线连接到 MSD 510  系统中的第一个模块。

使用 Danfoss  提供的以太网回路电缆采用菊花链式连接到其他模块。
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3.9.1 昀大电缆长度
表 11: 昀大电缆长度

电缆类型 规格 昀大长度

混合电缆 M23 馈电 40 m

M23 环路 25 m

现场总线扩展 长度： 2 m

至下一端口的昀大长度： 100 m

每个线路的昀大电缆长度 100 m

电机电缆 – 无附加输出滤波器或电抗器的昀大长度： 30 m

带附加输出滤波器或电抗器的昀大长度： 80 m

反馈电缆 – 80 m

扩展模块电缆 – 5 m

3.9.2 输出滤波器的接线
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图解 22: 输出滤波器的接线图

3.9.3 用于 2 个分布式访问模块 (DAM 510) 的标准布线概念
在此例中，通过带有速卸连接器的混合馈电电缆，可从 DAM 510 为第一个 ISD 510/DSD 510 伺服驱动器供电。
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图解 23: 用于 2 个分布式访问模块 (DAM 510) 的标准布线概念

1 混合馈电电缆

2 混合环路电缆

3 交流电抗器

3.10 软件
伺服系统的软件包括：

已安装到模块上的系统模块的固件。

用于操作 MSD 510  设备的 Automation Studio© 的 PLC 库的文件包（请参阅 6.11.2 创建 Automation Studio™ 项目

了解更多信息）。

用于操作 MSD 510  设备的 TwinCAT® 2 的 PLC 库（请参阅 6.12.2 创建 TwinCAT® 项目 了解更多信息）。

用于操作 MSD 510  设备的 SIMOTION SCOUT 的 PLC 库（请参阅 6.14.3 创建 SIMOTION SCOUT® 项目）。

用于操作 MSD 510  设备的 TIA Portal 的 PLC 库。

VLT® Servo Toolbox： Danfoss  提供的基于 PC 的软件，用于调试设备。

3.11 现场总线
伺服系统具有通过基于快速以太网 (100BASE-T) 通信来实现的开放系统架构。该系统支持 EtherCAT®、以太网 POWERLINK®

和 PROFINET® 现场总线。请参阅 VLT© Servo Drive System ISD 510、DSD 510、MSD 510 编程指南，了解更多信息。

在生产环境中，与设备的通信始终通过作为主站的 PLC 来进行。ISD 510/DSD 510 伺服驱动器、伺服驱动器模块 SDM 511/
SDM 512 和系统模块可通过以下通信方法来控制：
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使用 VLT® Servo Motion 库（适用于 TwinCAT®、Automation Studio©、SIMOTION SCOUT® 和 TiA Portal）。

使用 TwinCAT 的 NC 轴功能®（仅限 ISD 510/DSD 510 和 SDM 511/SDM 512）。

通过读取并写入到对象来使用 CANopen® CiA DS 402 标准。

使用应用类 1 (AC1)，仅适用于 PROFINET®。

ISD 510/DSD 510 伺服驱动器、伺服驱动器模块 SDM 511/SDM 512 和系统模块可使用以下周期时间来运行：

EtherCAT® 和以太网 POWERLINK® 现场总线：

400 µs 及其倍数（例如，800 µs 和 1200 µs）。

500 µs 及其倍数（例如，1 ms）。

PROFINET® 现场总线

500 µs 及其倍数（例如，1 ms）。

当周期时间为 400 µs 和 500 µs 的倍数时，使用 500 µs 的时基。

ISD 510/DSD 510 伺服驱动器、伺服驱动器模块 SDM 511/SDM 512 和系统模块已根据相应规定和法规通过现场总线认证。这些
伺服驱动器符合 CANopen® CiA DS 402 变频器行规。

3.11.1 EtherCAT®

ISD 510/DSD 510 伺服驱动器、伺服驱动器模块 SDM 511/SDM 512 和系统模块支持以下 EtherCAT® 协议：

CANopen over EtherCAT® (CoE)

File Access over EtherCAT® (FoE)

Ethernet over EtherCAT® (EoE)

ISD 510/DSD 510 伺服驱动器、伺服驱动器模块 SDM 511/SDM 512 和系统模块支持分布式时钟。为补偿系统中的通信电缆部分
的故障，所有现场总线都可使用冗余电缆。请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 系统设计指南了解

更多信息。

EtherCAT
Slave  Controller 

(ESC)

OUT
LAN 1 (B)

O
U

T  2
 (C

)

IN  0
 (A

)

X2X1 

X3

e3
0b

e6
95

.1
1

LA
N

LA
N

图解 24: ISD 510/DSD 510 伺服驱动器的 EtherCAT© 端口分配

X1 用于连接至分布式访问模块 (DAM 510) 或上一伺
服驱动器的 M23 混合电缆连接器。

X2 用于连接至下一伺服驱动器的 M23 混合电缆连接
器。

X3 用于连接至其他 EtherCAT® 从站（比如 Ether‐

CAT® 编码器）的 M8 以太网电缆连接器。

该连接器仅在高级伺服驱动器上可用。
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图解 25: 分布式访问模块 (DAM 510) 的 EtherCAT© 端口分配

X1 用于连接到上一从站的 RJ45 电缆连接器。

X2 用于将 M23 混合馈电电缆连接到第一个 ISD 510/
DSD 510 伺服驱动器的 RJ45。

X3 用于连接到 PLC（冗余电缆）或下一从站的 RJ45
电缆连接器。

 
 

X1 X2
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图解 26: 电源模块 (PSM 510)、伺服驱动器模块 SDM 511/SDM 512 和辅助电容器模块 (ACM 510) 的 EtherCAT© 端口分配

X1 用于连接到 PLC 或上一从站的 RJ45 电缆连接器。

X2 用于连接到 PLC（冗余电缆）或下一从站的 RJ45 电缆连接器。

3.11.2 以太网 POWERLINK®

ISD 510/DSD 510 伺服驱动器、伺服驱动器模块 SDM 511/SDM 512 和系统模块通过 DS 301 V1.1.0 认证，支持以下功能：

作为受控节点工作。

可作为多路复用站工作。

支持交叉通信。

对介质冗余支持环冗余。

对以太网 POWERLINK® 未分配特定端口。

3.11.3 PROFINET®
ISD 510/DSD 510 伺服驱动器、伺服驱动器模块 SDM 511/SDM 512 和系统模块支持 PROFINET® 一致性等级 C，符合

IEC 61158-5-10:2014、IEC 61158-6-10:2014、IEC 61784-2:2014 和 IEC 61784-5-3:2013 标准。所有系统组件（伺服驱动器
和系统模块）都可在 PROFINET® 网络中用作 I/O 设备。

支持以下功能：

I/O-设备 - 由 I/O 控制器控制的设备

动态模块配置

Net load class III

环路冗余 (MRPD) 作为客户端

PROFINET® 现场总线设备始终通过现场总线设备中集成的交换机作为网络组件连接。ISD 510/DSD 510 伺服驱动器、伺服驱动

器模块 SDM 511/SDM 512、 PSM 510 和 ACM 510 上有 2 个端口。DAM 510 上有 3 个端口。
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4 机械安装

4.1 提供的物品
为 MSD 510  系统提供的物品如下（具体取决于应用）：

VLT® Power Supply Module (PSM 510)

VLT® Single axis Servo Drive Module (SDM 511)

VLT® Double axis Servo Drive Module (SDM 512)

VLT® Decentral Access Module (DAM 510)

VLT® Auxiliary Capacitors Module (ACM 510)

VLT® Expansion Module (EXM 510)

交流电抗器

本操作指南

馈电（混合）电缆

环路（混合）电缆

注 意

在伺服系统中使用 ISD510/DSD510 伺服驱动器时，需要使用混合馈电和回路电缆。

包装情况取决于交付的模块数。将包装箱保留好，以便在需要退回产品时使用。

4.2 运输

始终使用具有足够承载能力的运输和起吊装置来运输伺服系统组件。

避免运输过程中振动。

避免重击和冲击。

4.3 收货查验

操作步骤

在收到货物后，应立即检查提供的物品是否与发运单据一致。Danfoss 将不承认以后登记的差错索赔。

如果发现明显的运输损坏，立即向承运商处进行投诉登记。

如果发现明显缺陷或交付物品不完整，立即向 Danfoss  负责代表进行投诉登记。

4.4 安装过程中的安全措施
在安装过程中，务必遵守本手册中的安全说明。特别注意确保始终遵守以下各点：

安装只能由具备相应资质的人员执行。

安装时必须保持适当地小心谨慎。

必须遵守所有安全法规、采取相应保护措施并保持相应环境条件。

已阅读并理解手册。

4.5 安装环境

4.5.1 系统组件
MSD 510  系统组件的环境状况为：

不得超过允许的工作环境温度范围和振动级别（请参阅 11.8 MSD 510 系统的一般规格和环境条件）。

允许的相对湿度范围为 5–93%，无冷凝。

系统模块上方和下方必需的昀小空隙在 4.7.1 系统模块的空间要求中详细说明。
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4.6 安装准备

4.6.1 系统模块
进行以下准备以确保能够可靠有效地安装伺服系统。

始终按照当地法规安装系统模块。

操作步骤

提供适合应用的安装布置。这取决于模块类型和重量。

为避免未对齐，确保背板完全水平。

为确保冷却不足，注意指定的昀小空间要求。

将模块接地。

4.6.2 钻孔样板

(100 x number of FS2 + 50 x number of FS1) - 50

FS2 FS1

50 50

[1.97]

[0.42]

[1
4.

45
]
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50 50
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图解 27: 用于 50 mm 和 100 mm 系统模块的钻孔样板

4.7 安装过程

4.7.1 系统模块的空间要求
这些模块可并排安装，但需要在顶部和底部留出昀小空间以便冷却。
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图解 28: 顶部和底部所需的昀小空间
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图解 29: 侧面所需的昀小空间

4.7.2 需要的安装辅助装置和工具
安装 MSD 510  系统模块时，需要使用与固定螺钉相配套的工具（不含）。

4.7.3 系统模块安装说明

注 意

将输出功率昀高的 MSD 510 系统组件安装在 PSM 510 旁边。然后按输出功率从高到低安装剩余系统组件。

操作步骤

按照钻孔样板（请参阅 4.6.2 钻孔样板）钻取用于安装背板的孔。

通过 "click and lock" 方法连接背板。

AQ262450196490zh-000101 / 175R1170 | 47Danfoss A/S © 2019.10

机械安装

VLT® Multiaxis Servo Drive MSD 510 System

操作指南





3.

e
3

0
b

g
8

0
2

.1
0

图解 30: 连接背板

使用具有 9.5 毫米的昀小螺钉头直径或垫圈直径的 M5 螺钉将背板安装到控制柜中的安装板上。紧固力矩为 3 Nm。
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图解 31: 在控制柜中安装背板

将模块滑到背板底部的支架上。

将第一个模块按入到背板顶部的背部链路连接器中。
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图解 32: 将模块按入到背部链路连接器中

要固定模块，按下背板顶部的固定夹（图解 33 中的 [1]）。
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图解 33: 按下背板顶部的固定夹

对剩余模块重复步骤 4、5 和 6，确保第 2 个模块左侧的边沿位于第一个模块右侧的导向槽内（图解 34 中的 ([1]）。
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图解 34: 导向槽
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5 电气安装

5.1 电气安装警告
在电气安装过程中，除遵守本手册中的信息外，还需遵守相关的地方和国家法规。

警 告
漏电/接地电流危险

漏电/接地电流超过 3.5 mA。MSD 510 系统模块错误接地可能会导致严重伤亡。

为了保护操作人员的安全，请按照适用的地方和国家电气标准和指令以及本手册中的操作说明，由经认证的电气安装员
将系统正确接地。

警 告
高电压

MSD 510  系统包含连接到电网后在高电压下运行的组件。这些组件上没有指示灯来指示是否已通电。错误安装、调试或维护

可能导致严重伤亡。

安装、调试和维护只能由具备相应资质的人员执行。

警 告
高电压

连接器上存在可能致命的电压，这可能会导致严重伤亡。

在电源连接器（断开或连接电缆）上开始操作之前，应将 PSM 510 与主电源断开，然后等待一段时间，直到放电完毕。

5.2 电气环境条件
要安全高效地操作伺服系统，必须满足以下电气环境条件：

仅适用于 TN-S、TN-C、TN-CS、TT（非角接地）电源接地系统

预期短路电流： 5 kA

保护等级 I

接地 3 相电网，400–480 V AC ±10%

3 相频率 44–66 Hz

3 相线路和 PE 线路

辅助电压的外部电源，24–48 V DC (PELV)

交流电抗器（请参阅 5.9.1 交流线路电抗器）

遵守国家法律规定。

漏电电流大于 3.5 mA。

注 意
RCD 兼容性

MSD 510  系统包含可导致保护性接地导体中出现直流电流的组件，这可能会导致连接到该系统的任何设备出现故障。

在直接或间接接触情况下，如果使用漏电保护 (RCD) 或监控 (RCM) 装置来提供保护，则在 MSD 510  系统组件的电源
侧使用 B 型 RCD 或 RCM 装置。

注 意

所有模块都必须安装在控制柜中。
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5.3 接地

5.3.1 接地确保电气安全

e3
0b

h3
91

.1
0

图解 35: 接地确保电气安全

使用馈电电缆的 PE 线缆将 ISD 510/DSD 510 伺服驱动器接地。DSD 510 伺服驱动器的正面有一个专用 PE 螺钉，背面也有
一个。

确保将机器框架通过正确的电气连接方式连接到伺服驱动器的法兰。使用正面的法兰面。确保机器该部件已进行 PE 连
接。

为符合 CE 要求，确保昀小接地线缆横截面积至少为 16 mm2（昀低 70 °C，铜芯）。

为符合 UL 要求，确保昀小接地线缆横截面积至少为 6 AWG（昀低 60 °C，铜芯）。

如果使用 10 kW 的 PSM 510 模块，则可将电缆横截面积降低至：

10 mm2（昀低 70 °C，铜芯），符合 CE 要求

8 AWG（昀低 60 °C，铜芯），符合 UL 要求

请勿以菊花链方式将 MSD 510 系统组件接地。使用 图解 35 中描述的接地方法。

地线连接应尽可能短

遵守本手册中的接线要求。

5.3.2 接地确保安装符合 EMC 规范

在每个模块上使用 I/O 屏蔽板在电缆屏蔽层和机箱之间建立电气接触。
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图解 36: 系统组件顶部的电缆屏蔽层

1 电缆
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3 I/O 屏蔽板
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图解 37: 系统组件底部的电缆屏蔽层

1 电缆扎带

2 EMC 金属屏蔽板

3 PE 螺钉

使用带有高覆盖率的屏蔽层的电缆来减小电气干扰。

请勿使用辫子状线缆来连接屏蔽层。建议采用 360° 线缆连接。

注 意
电位均衡

如果伺服系统和机器之间的大地电位不同，可能会出现电气干扰。在它们之间安装等势电缆。推荐的电缆横截面积为
16 mm2。
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注 意
EMC 干扰

使用屏蔽电缆作为控制线缆，对电源线和控制线缆使用单独的电缆。未隔离电源线和控制线缆可能会导致意外操作或降
低性能。

确保信号电缆和电源线之间至少相距 200 毫米。

只能以 90° 交叉电缆。

5.4 主电源要求
确保电源具有以下属性：

TN-S、TN-C、TN-CS、TT（非角接地）电源接地系统。

预期短路电流： 5 kA。

保护等级 I。

接地 3 相电网，400–480 V AC ±10%。

3 相线路和 PE 线路。

3 相频率： 44–66 Hz

30 kW 时，1 个 PSM 510 的昀大输入电流： 55 Arms

5.4.1 熔断器

注 意

在电源模块 PSM 510 的供电侧使用符合 CE 和 UL 要求的熔断器（请参阅 表 12）。

使用 2 个 PSM 510 模块时，每个 PSM 510 都必须有自己的专用熔断器组。

表 12: 熔断器

型号和功率额定值 符合 CE 要求 (IEC 60364) 符合 UL 要求 (NEC 2014)

熔断器昀大规格 熔断器昀大规格

PSM 510 (10 kW) gG 25 A 30 A（仅限 T 类或 J 类）

PSM 510 (20 kW) gG 50 A 50 A（仅限 T 类或 J 类）

PSM 510 (30 kW) gG 63 A 80 A（仅限 T 类或 J 类）

5.4.2 断路器
使用分断能力为 PSM 510 额定电流的 1.5 倍的 B 类或 C 类断路器来满足 CE 要求。

注 意

不允许在要求 C-UL 认证的装置中使用断路器。仅允许使用 UL 推荐的熔断器。

5.5 辅助电源要求
为 PSM 510 提供输出为 24/48 V DC ±10% (PELV)、昀大电流 50 A（实际电流取决于所用模块）的电源。所需输出取决于系统
拓扑结构。电源的输出纹波电压必须小于 250 mVpp。

有关额定功率的壳层图，请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 设计指南。
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注 意

只能使用符合 PELV 规范的电源。

对于工业用途，使用带有 CE 标志的符合 EN 61000-6-2、EN 61000-6-4 或类似标准的电源。

辅助电路必须由外部单独电源供电。

提供辅助电压的 24/48 V 直流外部电源必须由 MSD 510  系统专用，这意味着，该电源仅用于为 PSM 510 供电。该电源和
PSM 510 之间的电缆昀大长度为 3 米。

5.5.1 熔断器
推荐使用 UL 列名的熔断器来保护 24–48 V 直流线路上的线缆。

表 13: 熔断器

符合 CE 要求 (IEC 60364) 符合 UL 要求 (NEC 2014)

熔断器昀大规格 熔断器昀大规格

50 A(1) 63 A(2)

1 如果昀大电流低于此值，则可使用具有更低电流额定值的熔断器。IEC 熔断器的等级： 根据昀大电流的 100% 确定。使用根据所用的直流

电压分级的延时熔断器。

2 如果昀大电流低于此值，则可使用具有更低电流额定值的熔断器。UL 熔断器的等级： 根据昀大电流的 125% 确定。使用根据所用的直流电

压分级的延时熔断器。

5.6 安全电源要求
使用具有以下属性的 24 V 直流电源为 STO 线路供电：

输出范围： 24 V DC ±10%

昀大电流： 1 A

对工业用途使用通过 CE 认证的 24 V 电源。确保电源满足 PELV 规格，且仅适用于系统安全输入。

可对辅助和安全电源使用公用电源，只要两个电路的唯一连接点靠近该电源。这可避免由于公用电源出现压降而导致的干扰。
24 V 电源和伺服系统之间的电缆昀大长度为 3 米。

安全电源可从 PSM 510 沿环路连接到其他 MSD 510  系统组件（ACM 510 除外），且未连接到 STO。不提供用于此连接的电缆。
有关详细信息，请参阅 8.6 安装。

注 意

确保安全信号和其他信号、电源（主电源）和外露的导电部件之间采用了加强绝缘。

5.7 UL 要求

注 意

集成的固态短路保护装置不提供支路保护功能。提供支路保护功能时必须遵守国家电气规范/加拿大电气规范和任何其
他地方规范或同等规定。

适用于在使用昀大 80 A 的 J 类或 T 类熔断器进行保护时，能够提供不超过 5000 rms 对称电流且昀大电压为 480 V
的电路。

为符合 UL（美国安全检测实验室）规范，请使用昀低耐热能力为 60 °C 的 UL 认可的铜线。只能使用 1 类线缆。对
于额定功率为 30 kW 的 PSM 510，使用昀大耐热能力 75 °C。

需要使用控制电路过电流保护功能。
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5.8 连接伺服驱动器模块 SDM 511/SDM 512

5.8.1 连接电机电缆

1

2

3

4

5
e3
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g8
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40

Axis 2:170
Axis 1:120

10

60

12

图解 38: 用于 50 毫米宽伺服驱动器模块的电机电缆

1 屏蔽区域

2 U
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4 W

5 PE
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图解 39: 用于 100 毫米宽伺服驱动器模块的电机电缆

1 屏蔽区域

2 U

3 V

4 W

5 PE
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图解 40: 连接 50 毫米宽伺服驱动器模块上的电机电缆
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图解 41: 连接 100 毫米宽伺服驱动器模块上的电机电缆

操作步骤

将线缆插入到电机连接器中。

插入电机连接器 [1]。

使用电缆扎带 [2] 固定和屏蔽电机电缆。

5.8.2 连接制动/热敏电阻电缆
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图解 42: 制动/热敏电阻电缆

1 电机温度 –

2 电机温度 +

3 电机制动器 –

4 电机制动器 +
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图解 43: 连接制动/热敏电阻电缆

1 电机 PE 螺钉

2 制动/热敏电阻连接器

3 制动/热敏电阻电缆的电缆扎带

4 EMC 板

5 EMC 板螺钉

注 意

在热敏电阻和电机绕组之间使用具有加强绝缘功能的电机（在 4300 V 直流和 8000 Vpeak 脉冲下经过测试）。

操作步骤

将线缆插入到制动/热敏电阻连接器中。

将制动/热敏电阻连接器 [2] 插入到伺服驱动器模块 SDM 511/SDM 512 中。

使用电缆扎带 [3] 固定制动/热敏电阻电缆。

拧紧 EMC 板螺钉 [5]。紧固力矩为 3 Nm。

将电机反馈连接器（SUB-D，26 引脚）插入伺服驱动器模块中。

要将伺服驱动器模块 SDM 511/SDM 512 连接到 PE，将 PE 线缆连接到模块正面的 PE 螺钉 [1] 即可。紧固力矩为 3
Nm。

5.8.3 连接伺服驱动器模块 SDM 511/SDM 512 顶部的电缆
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图解 44: SDM 511/SDM 512 顶部的连接器（示例）
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1.

2.

3.

4.

5.

6.

1 外部编码器连接器 (E SDM 511/512)

2 以太网连接器输入端 (X1 IN)

3 以太网连接器输出端 (X2 OUT)

4 I/O 连接器 (I/O SDM 511/512)

5 STO 连接器输入端 (STO SDM 511/512)

6 STO 连接器输出端 (STO SDM 511/512)

7 继电器连接器 (REL SDM 511/512)

操作步骤

使用以太网电缆将上一模块的输出端连接到输入连接器 [2]。

将线缆从上一模块的 STO 输出端连接到 24 V IN（STO 输入端）连接器中。

将 24 V 输入（STO 输入端）连接器 [5] 插入到 SDM 511/SDM 512 中。

如果需要，插入外部编码器连接器 [1]。

如果需要 I/O，将线缆插入 I/O 连接器中，然后插入连接器 [4]。

如果需要继电器，将线缆插入继电器连接器中，然后插入连接器 [7]。

5.9 连接电源模块 PSM 510

5.9.1 交流线路电抗器
必须使用 3 相交流线路电抗器（请参阅 5.9.1.1 将 1 个 PSM 510 连接到交流电抗器和 5.9.1.2 将 2 个 PSM 510 模块连
接到交流电抗器）。

表 14: 用于 1 个 PSM 510 的线路电抗器特征

型号 昀低 Irms [A] Urms [V] 电感 [mH]

PSM 510 (10 kW) 20 500 昀小值： 0.47

昀大值： 1.47

PSM 510 (20 kW) 40 500 昀小值： 0.47

昀大值： 1.47

PSM 510 (30 kW) 60 500 0.47 ±10%

如果并联安装了 2 个 PSM 510 模块，则使用表 15 中指定的交流电抗器。有关详细信息，请参阅 5.9.1.2 将 2 个 PSM 510
模块连接到交流电抗器。

表 15: 用于并联安装的 2 个 PSM 510 的线路电抗器特征

型号 昀低 Irms [A] Urms [V] 电感 [mH]

PSM 510 (2 x 30 kW) 125 500 0.24 ±10%

Danfoss  建议将交流线路电抗器安装在 PSM 510 近处。

昀大电缆长度取决于横截面积以及直流回路所需的电压和电流。

如果将交流线路电抗器安装在距 PSM 510 较远的位置，则昀大电缆距离为 5 米。

5.9.1.1 将 1 个 PSM 510 连接到交流电抗器
将 PSM 510 连接到带有适用于 PSM 510 的功率规格的正确交流电抗器的电网。
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图解 45: 将 1 个 PSM 510 连接到交流电抗器

5.9.1.2 将 2 个 PSM 510 模块连接到交流电抗器
将 PSM 510 模块连接到同一交流电抗器，如图解 46 所示。

确保所用的电抗器是与 PSM 510 模块的总功率相匹配的正确规格。

使用 2 个 PSM 510 模块时，交流线路电抗器和每个 PSM 510 之间的线缆长度必须相同，容差在 0.5 米内。

将每个 PSM 510 直接连接到交流电抗器。不允许将线缆并联。
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图解 46: 将 2 个 PSM 510 模块连接到交流电抗器

5.9.1.3 将 2 个 PSM 510 模块连接到带有系统拆分装置的交流电抗器
无论负载位置如何（比如，安装在系统拆分装置之前或之后），将 PSM 510 模块连接到同一交流电抗器，如图解 47 所示。

确保所用的电抗器是与 PSM 510 模块的总功率相匹配的正确规格。

使用 2 个 PSM 510 模块时，交流线路电抗器和每个 PSM 510 之间的线缆长度必须相同，容差在 0.5 米内。
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将每个 PSM 510 直接连接到交流电抗器。不允许将线缆并联。
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图解 47: 将 2 个 PSM 510 模块连接到带有系统拆分装置的交流电抗器

如果使用 2 个交流电抗器（每个 PSM 510 一个）且两个 PSM 510 模块都安装在系统拆分装置的同一侧，则允许将降容设置为
等于交流电抗器的容差，即 60 kW。例如，降容 10% 后为 54 kW。

如果使用 2 个交流电抗器（每个 PSM 510 一个）且一个 PSM 510 模块安装在系统拆分装置之前，另一个安装在该装置之后，
则必须均衡分配负载。否则，两个 PSM 510 模块的降容将等于交流电抗器的容差。例如，容差为 10% + 10%，则表示降容
20%。

如果使用 2 个交流电抗器（每个 PSM 510 一个）且一个 PSM 510 模块安装在系统拆分装置之前，另一个安装在该装置之后，
则将一半负载设置在系统拆分装置之前，将另一半负载设置在系统拆分装置之后，且允许将降容设置为等于交流电抗器的容
差，即 60 kW。例如，降容 10% 后为 54 kW。

注 意

有关 EXM 510 模块和接线的更多信息，请参阅 11.7.15 扩展模块连接器。

5.9.2 连接电源模块 PSM 510 上的电缆

5.9.2.1 连接电源模块 PSM 510 顶部的电缆

1 2
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图解 48: PSM 510 顶部的连接器

1 以太网连接器输入端 (X1 IN)

2 以太网连接器输出端 (X2 OUT)

3 24/48 V 输入连接器 (INPUT 24/48 V)

4 STO 连接器输入端 (STO PSM)

5 STO 连接器输出端 (STO PSM)

6 I/O 连接器 (I/O PSM)

7 继电器连接器 (REL PSM)
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2.

3.

4.

5.

6.

7.

8.

9.

10.

1.

2.

3.

a.

b.

4.

操作步骤

将以太网电缆从 PLC 连接到以太网输入连接器 [1]。

将以太网电缆从以太网输出连接器 [2] 连接到下一模块。

将线缆插入到 24/48 V 输入端连接器中。

插入 24/48 V 输入连接器 [3]。

将线缆插入 STO 连接器输入端连接器中。

插入 STO 连接器输入端 (STO PSM) 连接器 [4]。

将线缆插入 STO 连接器输出端连接器中。

插入 STO 连接器输出端 (STO PSM) 连接器 [5]。

如果需要 I/O，将线缆插入 I/O 连接器中，然后插入连接器 (I/O PSM) [6]。

如果需要继电器，将线缆插入继电器连接器中，然后插入连接器 (REL PSM) [7]。

5.9.2.2 连接电源模块 PSM 510 底部的电缆
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图解 49: PSM 510 底部的连接器

1 用于插入未用的内部制动电阻器连接器的支座

2 交流主电源连接器

3 PE 螺钉

4 内部/外部制动电阻器连接器

操作步骤

将线缆插入到交流电源连接器中。

插入交流电源连接器 [2] 中。

如果需要使用外部制动电阻器：

拔下内部制动电阻器连接器 [4] 然后将外部制动连接器插入到位。

将内部制动电阻器连接器插入到内部制动连接器座 [1] 中。

使用 PE 线缆将 PSM 510 连接到正面的 PE 螺钉 [3] 上。紧固力矩为 3 Nm。

5.10 连接分布式访问模块 (DAM 510)

5.10.1 连接分布式访问模块 DAM 510 顶部的电缆
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图解 50: DAM 510 顶部的连接器
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1.

2.

3.

4.

1 以太网连接器输入端 (X1 IN)

2 以太网连接器输出端 (X3 OUT)

3 STO 连接器输入端 (STO DAM)

4 STO 连接器输出端 (STO DAM)

5 外部编码器连接器 (E DAM)

操作步骤

使用以太网电缆将上一模块的输出端连接到输入连接器 [1]。

将上一模块的 STO 输出端的线缆插入到 24 V 输入（STO 输入）连接器中，请参阅 11.7.10.3.1 DAM 510 顶部的 STO
连接器。

将 24 V 输入（STO 连接器输入端）连接器 [3] 插入到 DAM 510 中。

如果需要，连接外部编码器连接器 [5]。

5.10.2 连接馈电电缆
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图解 51: DAM 510 底部的连接器

1 以太网连接器

2 AUX 连接器

3 STO 输出连接器

4 UDC 连接器
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图解 52: 馈电电缆
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1.

2.

3.

4.

5.

6.

7.

1 屏蔽区域

2 UDC+（黑色，2.5 mm2/4 mm2）

3 UDC–（灰色，2.5 mm2/4 mm2）

4 STO+（粉色，0.5 mm2）

5 STO–（灰色，0.5 mm2）

6 AUX+（红色，2.5 mm2）

7 AUX–（蓝色，2.5 mm2）

8 以太网/现场总线（绿色，RJ45 连接器）

9 PE（黄色/绿色，2.5 mm2/4 mm2，叉形接线头）
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图解 53: 连接馈电电缆

1 馈电电缆 PE 螺钉

2 总线连接器

3 馈电电缆的扎带

4 STO 电缆的扎带

5 EMC 板

6 EMC 板螺钉

操作步骤

将线缆插入 UDC、AUX 和 STO 连接器中。

使用电缆扎带 [3] 固定馈电电缆，确保屏蔽区域恰好位于电缆扎带下。

使用电缆扎带 [4] 固定 STO 电缆，确保屏蔽区域恰好位于电缆扎带下。

将馈电电缆上的连接器插入到 DAM 510 上的对应端子块中。

拧紧 EMC 板上的螺钉 [6]。紧固力矩为 3 Nm。

插入 RJ45 总线连接器 [2]。

使用 PE 线缆将 DAM 510 连接到正面的 PE 螺钉 [1] 上。紧固力矩为 3 Nm。

5.11 连接辅助电容器模块 ACM 510

e3
0b

h3
50

.1
11 2

4 3

图解 54: ACM 510 顶部的连接器
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1.

2.

3.

4.

1 以太网连接器输入端 (X1 IN)

2 以太网连接器输出端 (X2 OUT)

3 I/O 连接器 (I/O ACM)

4 继电器连接器 (REL ACM)

操作步骤

使用以太网电缆将上一系统模块的输出端连接到输入连接器 (X1 IN) [1]。

如果需要 I/O，将线缆插入 I/O 连接器 (I/O ACM) 中，然后插入连接器 [3]。

如果需要继电器，将线缆插入继电器连接器 (REL ACM) 中，然后插入连接器 [4]。

使用 PE 线缆将 ACM 510 连接到正面的 PE 螺钉上。紧固力矩为 3 Nm。

5.12 连接扩展模块 EXM 510

12

5315
8

1

2

3

4

5

6

7

e3
0b

h6
61

.1
0

图解 55: 扩展模块电缆

1 24/48 V

2 GND

3 功能地

4 DC–

5 DC–

6 DC+

7 DC+

8 屏蔽区域

e3
0b

h3
92

.1
1

1

23

4

5

6

7

图解 56: 连接扩展模块 EXM 510
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1.

2.

3.

4.

5.

6.

-

1 EMC 屏蔽板螺钉

2 PE 螺钉

3 直流电缆

4 功能地电缆

5 GND 电缆

6 24/48 V 电缆

7 电缆扎带

注 意

如果使用两个单独的背部链路（通过 1 或 2 对 EXM 510 模块连接），还必须使用横截面积为 16 mm2 (6 AWG) 的电缆

将 2 个接地汇流条连接在一起。

操作步骤

将线缆 [3]、[4]、[5] 和 [6] 插入扩展连接器中。

使用电缆扎带 [7] 固定直流电缆 [3]，确保屏蔽区域恰好位于电缆扎带下。

使用电缆扎带 [7] 固定电缆 [4]、[5] 和 [6]。

将连接器插入背板中。

拧紧 EMC 屏蔽板 [1] 上的螺钉。紧固力矩为 3 Nm。

使用 PE 线缆和 PE 螺钉 [2] 将扩展模块连接到 PE 以接地。紧固力矩为 3 Nm。

5.13 连接 PSM 510 上的制动电阻器
PSM 510 连接到内部制动电阻器，如图解 57 所示。

或者，也可将 PSM 510 连接到外部制动电阻器。在此情况下，PSM 510 上的内部制动电阻器必须保持未连接状态，可将连接器
置于内部制动电阻器连接器座中（请参阅 3.2.3 PSM 510 底部的连接器）。

不允许并联或串联制动电阻器。

AQ262450196490zh-000101 / 175R1170 | 67Danfoss A/S © 2019.10

电气安装

VLT® Multiaxis Servo Drive MSD 510 System

操作指南



•
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STATUS PSM
DEV
SVS ST
NET ST

LINK/ACT
X1
X2

LCP

1

e3
0b

h4
23

.1
0

PS
M

 5
10

图解 57: 连接 1 个 PSM 510 上的内部制动电阻器

1 内部制动电阻器

使用 2 个 PSM 510 模块时，将每个 PSM 510 连接到各自的内部制动电阻器，如图解 58（出厂设置）中所示。

2 个 PSM 510 模块的允许替代配置为：

将一个 PSM 510 连接到内部制动电阻器，另一个连接到外部制动电阻器。

两个 PSM 510 模块都连接到外部制动电阻器。在此情况下，PSM 510 上的内部制动电阻器必须保持未连接状态，可将连接
器置于内部制动电阻器连接器座中（请参阅 3.2.3 PSM 510 底部的连接器）。

不允许并联或串联制动电阻器。
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STATUS PSM

DEV
SVS ST

NET ST

LINK/ACT
X1

X2

LCP

STATUS PSM

DEV
SVS ST

NET ST

LINK/ACT
X1

X2

LCP

1

1
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10
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M
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10

图解 58: 连接 2 个并联 PSM 510 模块上的制动电阻器

1 内部制动电阻器
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1.

2.

3.

4.

5.

•

•

•

•

•

-

6 调试

6.1 调试警告

警 告
意外启动

MSD 510  系统包含连接到电网的伺服驱动器、PSM 510 和 DAM 510，可随时开始运行。这可能由现场总线命令、参考值信号

或消除故障状态的操作引发。伺服驱动器和所有连接的设备都必须具有良好运行状况。将设备连接到电网后，存在缺陷的运

行状况可能导致死亡、严重伤害、设备损坏或其他实质性损坏。

采取适合措施防止意外启动。

6.2 预调试检查表
在初次调试前以及在长时间停机或存储后开始运行前，请务必完成这些检查。

操作步骤

检查机械和电气组件的所有螺纹连接器是否牢靠拧紧。

检查能否确保冷却空气自由流动（入口和出口）。

检查电气连接是否正确。

确保已为可能会变得很烫的旋转部件和表面准备好接触防护装置。

如果使用 STO 功能，则执行功能安全概念启用测试（请参阅 8.8 启用测试）。

6.3 SDM 511/SDM 512 配置参数和变频器调试

6.3.1 配置参数子工具
配置参数子工具是 VLT® Servo Toolbox 子工具，用于配置：

电机数据

应用数据

控制数据

输入 / 输出配置

外部编码器

e3
0b

h6
57

.1
01 2 3

图解 59: 配置参数子工具

1 “保存/另存为”按钮

2 “从设备读取配置”按钮

3 “将配置写入设备”按钮

配置参数存储在一个文件中。
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•

•
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1.

2.

3.

4.

5.

6.

-

单击从设备读取配置 按钮 [2] 可加载该文件。

单击保存/另存为 按钮 [1] 可在本地保存文件。

单击将配置写入设备 按钮 [3] 可将该文件传输到设备。重新启动设备以激活传输的配置。

注 意

请参考子工具了解每个参数的详细说明。

6.3.2 变频器调试子工具
变频器调试子工具是 VLT® Servo Toolbox 子工具，用于执行调试任务，比如：

电机反馈调整

旋变振幅校准

惯量测量

e3
0b

h6
58

.1
0

图解 60: 变频器调试子工具

6.4 EtherCAT® ID 分配
EtherCAT® 无需特殊 ID 分配（IP 地址）。仅当通过 VLT® Servo Toolbox 软件使用间接通信时，才需要特殊 ID 分配。

6.5 以太网 POWERLINK® ID 分配

6.5.1 概述
使用 VLT® Servo Toolbox 为设备分配 ID 时，不得激活以太网 POWERLINK® 主站通信。仅当使用非循环以太网 POWERLINK®

通信时，才能通过 VLT® Servo Toolbox 分配 ID。如果已启动以太网 POWERLINK® 循环通信，则重新启动以停止它。

设置 ID 之前，断开 PLC 连接并重新启动。或者，在 POWERLINK® 界面中，在 Service Mode（维护模式）下重启计算机，同

时，将参数 Basic Ethernet in Service Mode（维护模式下的基本以太网）设置为 Basic Ethernet enabled（已启用基本以

太网）。

6.5.2 单设备 ID 分配
为单个设备分配 ID 时，使用 VLT® Servo Toolbox 中的 Device Information（设备信息）窗口（请参阅 VLT® Servo Drive

System ISD 510、DSD 510、MSD 510 编程指南 了解更多信息）。

此外，还可通过 LCP 将一个 ID 分配给一个设备。

6.5.2.1 在伺服驱动器或系统模块上直接设置节点 ID
所有与 IP 相关的参数都位于参数组 12-0* IP Settings（12-0* IP 设置）中。根据以太网 POWERLINK® 标准，IP 地址固定

为 192.168.100.xxx。昀后一个数字是参数 12-60 Node ID（12-60 节点 ID）中的值。对于参数 12-02 Subnet Mask（12-02

子网掩码），IP 地址固定为 255.255.255.0，无法更改。

操作步骤

将 LCP 连接到应更改 节点 ID 的伺服驱动器或系统模块。

按 Hand On（手动启动）按钮并保持 1 秒以上以将 LCP 设置为控制界面。

按 Main Menu（主菜单）按钮，向下滚动到子菜单 12-** Ethernet（12-** 以太网）然后按 OK（确定）。

向下滚动到子菜单 12-6* Ethernet POWERLINK（12-6* 以太网 POWERLINK）然后按 OK（确定）。

将 PSM 510/DAM 510 节点 ID 更改为所需值 (1–239)。

按 OK（确定）以确认选定内容，然后等待 ID 分配过程完成。
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1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

a.

b.

c.

13.

•

•

•

•

•

•

•

•

•

•

执行重启以确保所有 ID 更改都生效且能够在现场总线上正常工作。

6.5.2.2 通过 LCP 为连接到电源模块 (PSM 510) 或分布式访问模块 (DAM 510) 的单个伺服驱
动器设置节点 ID
当 LCP 连接到 PSM 510 或 DAM 510 时，还可更改伺服驱动器的节点 ID。此功能包括在子组 54-1* Manual（54-1* 手动）中

的参数组 54-** ID Assignment（54-** ID 分配）中。

操作步骤

将 LCP 连接到特定 PSM 510/DAM 510，后者已连接到应更改节点 ID 的伺服驱动器和系统模块。

按 Hand On（手动启动）按钮并保持 1 秒以上以将 LCP 设置为 PSM 510/DAM 510 的控制界面。

按 Main Menu（主菜单）按钮，向下滚动到子菜单 12-** Ethernet（12-** 以太网）然后按 OK（确定）。

向下滚动到子菜单 12-6* Ethernet POWERLINK（12-6* 以太网 POWERLINK）然后按 OK（确定）。

通过按 OK（确定）按钮，将 PSM 510/DAM 510 节点 ID 更改为所需值 (1–239) 。

返回到 Main Menu（主菜单），然后选择参数 54-** ID Assignment（54-** ID 分配）。

选择参数 54-1* Manual（54-1* 手动）。

仅限 PSM 510： 在参数 54-01 Epl id assignment line（54-01 Epl ID 分配线路）中，选择以太网端口 X1 或 X2。
PSM 510 将通过所选端口和现场总线网络把 ID 分配给选定设备。在 DAM 510 端口上，将自动使用 X2。

选择参数 54-12 Epl ID assignment start id（54-12 Epl ID 分配启动 ID）然后选择一个有效值 (1–239)。该值

将被分配给指定位置索引处的设备。连接到 LCP 的 PSM 510/DAM 510 处于位置 0，选定端口上第一个可用设备位于位
置索引 1，以此类推。

选择参数 54-14 Manual Epl ID assignment start（54-14 手动 Epl ID 分配启动），然后将状态从 [0] ready（[0]

就绪）更改为 [1] start（[1] 启动）。

按 OK（确定）以确认选定内容，然后等待 ID 分配过程完成。

使用以下参数检查 ID 分配是否已成功完成：

参数 54-15 Epl ID assignment state（54-15 Epl ID 分配状态）

参数 54-16 Epl ID assignment error code（54-16 Epl ID 分配错误代码）

参数 54-17 Epl ID assignment device count（54-17 Epl ID 分配设备计数）

执行重启以确保所有 ID 更改都生效且能够在现场总线上正常工作。

如果在 ID 分配过程中出错，则 LCP 上将显示出检测到的错误。可能会报告以下错误：

无效 NMT 状态

无效备粒

无效以太网端口

无效节点 ID

ID 分配失败

MAC 地址重复

无效软件版本

不完整的分配

找不到设备

内部错误

6.5.3 多设备 ID 分配
为多个设备分配 ID 时（例如，设置一个新网络时），使用 VLT® Servo Toolbox 子工具 DAM ID assignment（DAM ID 分配）

（请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 编程指南了解更多信息）。

同时为连接到分布式访问模块 (DAM 510) 或电源模块 (PSM 510) 的所有伺服驱动器设置 ID 时，当 DAM 510/PSM 510 连接有
LCP 时，还可通过 LCP 来完成。

6.5.3.1 设置分布式访问模块 (DAM 510)/电源模块 (PSM 510) 线路上的所有伺服驱动器和系
统模块的节点 ID
使用自动 PSM 510/DAM 510 ID 分配功能，可自动设置指定 PSM 510/DAM 510 线路的所有伺服驱动器和系统模块上的节点 ID。

此功能包括在子组 54-0* Automatic（54-0* 自动）中的参数组 54- ** ID Assignment（54-** ID 分配）中。
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操作步骤

将 LCP 连接到特定 PSM 510/DAM 510，后者已连接到应更改节点 ID 的伺服驱动器和系统模块。

按 Hand On（手动启动）按钮并保持 1 秒以上以将 LCP 设置为 PSM 510/DAM 510 的控制界面。

按 Main Menu（主菜单）按钮，向下滚动到子菜单 12-** Ethernet（12-** 以太网）然后按 OK（确定）。

向下滚动到子菜单 12-6* Ethernet POWERLINK（12-6* 以太网 POWERLINK）然后按 OK（确定）。

通过按 OK（确定）按钮，将 PSM 510/DAM 510 节点 ID 更改为所需值 (1–239) 。

返回到 Main Menu（主菜单），然后选择参数 54-** ID Assignment（54-** ID 分配）。

选择参数 54-0* Automatic（54-0* 自动）。

仅限 PSM 510： 在参数 54-01 Epl id assignment line（54-01 Epl ID 分配线路）中，选择以太网端口 X1 或 X2。
PSM 510 将通过所选端口和现场总线网络把 ID 分配给选定设备。在 DAM 510 端口上，将自动使用 X2。

选择参数 54-02 Epl ID assignment start id（54-02 Epl ID 分配启动 ID）然后选择一个有效值 (1–239)。该值

将被分配给指定位置索引处的设备。连接到 LCP 的 PSM 510/DAM 510 处于位置 0，选定端口上第一个可用设备位于位
置索引 1，以此类推。

选择参数 54-03 Automatic Epl ID assignment start（54-03 自动 Epl ID 分配启动），然后将状态从 [0] ready

（[0] 就绪）更改为 [1] start（[1] 启动）。

按 OK（确定）以确认选定内容，然后等待 ID 分配过程完成。

使用以下参数检查 ID 分配是否已成功完成：

参数 54-04 Epl ID assignment state（54-04 Epl ID 分配状态）

参数 54-05 Epl ID assignment error code（54-05 Epl ID 分配错误代码）

参数 54-06 Epl ID assignment device count（54-06 Epl ID 分配设备计数）

执行重启以确保所有 ID 更改都生效且能够在现场总线上正常工作。

如果在 ID 分配过程中出错，则 LCP 上将显示出检测到的错误。可能会报告以下错误：

无效 NMT 状态

无效备粒

无效以太网端口

无效节点 ID

ID 分配失败

MAC 地址重复

无效软件版本

不完整的分配

找不到设备

内部错误

6.6 PROFINET® ID 分配
每个 PROFINET® 设备都需要一个设备名称和 IP 地址。建立与 I/O 设备的连接后，IP 地址和设备名称将由 I/O 控制器分

配。

通过 VLT® Servo Toolbox 软件使用间接通信时，也需要进行 IP 地址分配（请参阅 VLT® Servo Drive System ISD 510、

DSD 510、MSD 510 编程指南了解更多信息）。

IP 地址和设备名还可使用 PRONETA 分配，这是一个支持 PROFINET® 网络分析和配置的免费工具。

6.7 加电时间
系统组件的昀长加电时间为 15 秒。这是指，从使用辅助电源为系统供电到模块完全初始化所需的时间。

列出的加电时间是相应的状态指示时间。模块的准确状态可通过状态字查看。

注 意

在所有系统模块全都正确加电之前，请勿操作任何系统模块。

如果并联安装 2 个 PSM510 模块，则同时为两个 PSM 510 模块加电（昀多延迟 1 秒）。
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6.8 系统模块充电时间
系统充电时间由每个单独系统模块的昀长充电时间决定。

每个模块的准确状态可通过状态字查看。

注 意

在所有系统模块都完全充电且处于 Operation enabled（允许运行）状态之前，请勿操作任何系统模块。

表 16: PSM 510、DAM 510 和 ACM 510 的直流回路 (UDC) 充电时间

规格 单位 PSM 510 DAM 510 ACM 510

UDC 充电时间 s 2.0 2.0 3.5

表 17: SDM 511 的直流回路 (UDC) 充电时间

规格 单位 SDM 511

2.5 A

SDM 511

5 A

SDM 511

10 A

SDM 511

20 A

UDC 充电时间 s 2.0

表 18: SDM 512 的直流回路 (UDC) 充电时间

规格 单位 SDM 512

2 x 2.5 A

SDM 512

2 x 5 A

SDM 512

2 x 10 A

UDC 充电时间 s 2.0

6.9 打开 MSD 510 系统
在对伺服驱动器模块 (SDM 511/SDM 512) 加电前，完成 MSD 510  系统的接线。此线路可为 MSD 510  系统提供电源电压和通
信信号。这是伺服驱动器正常工作的基本要求。

通过使用 UAUX 为电源模块 (PSM 510) 供电，可打开 MSD 510  系统。然后，该电源将被自动输送到连接的所有系统模块，仅

连接的模块的控制单元在运行。当主电源和 STO 加电后，系统将准备好运行。

6.9.1 打开 MSD 510 系统的操作步骤

操作步骤

打开 UAUX 电源，与 PSM 510、DAM 510 和 SDM 模块建立通信。

打开主电源。

将 PSM 510 设置为状态 Operation enabled（允许运行）。

现在，系统模块已准备好运行。

将 DAM 510 设置为状态 Operation enabled（允许运行）。

6.10 库
为 MSD 510  系统提供的库可在以下工具中使用：

TwinCAT® V2

SIMOTION SCOUT® V4.4 和 V4.5：

V4.4 中的 C240

V4.4 中的 D410-2

V4.4 中的 D425-2

V4.4 中的 D435-2

V4.4 中的 D445-2
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V4.4 中的 D455-2

V4.4 中的 P320

Automation Studio© 环境（版本 3.0.90 和 4.x，支持的平台 SG4），可轻松集成功能，而无需控制器上具有专用运动运

行时。

V13 中的 TiA

提供的功能块符合 PLCopen® 标准。不必具备有关基础现场总线通信和/或 CANopen® CiA DS 402 行规的知识。

库中包含：

用于控制和监测 ISD 510/DSD 510 伺服驱动器、伺服驱动器模块 SDM 511/SDM 512 和系统模块的功能块。

用于 ISD 510/DSD 510 伺服驱动器和 SDM 511/SDM 512 伺服驱动器模块的所有可用运动命令的功能块。

用于控制和监测 PSM 510、DAM 510 和 ACM 510 的功能块。

用于创建基本 CAM 轨迹的功能块和结构。

用于创建标记 CAM 轨迹的功能块和结构。

6.11 使用 Automation Studio™ 编程

6.11.1 使用 Automation Studio™ 编程的要求
要将 ISD 510/DSD 510 伺服驱动器、SDM 511/SDM 512 伺服驱动器模块和系统模块集成到 Automation Studio© 项目中，需要

使用以下文件：

用于 MSD 510  伺服系统的库文件包： Danfoss_VLT_ServoMotion_V_x_y_z.zip

用于标准型 ISD 510 伺服驱动器的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_ISD510_S.xdd

用于高级型 ISD 510 伺服驱动器的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_ISD510_A.xdd

用于标准型 DSD 510 伺服驱动器的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_DSD510_S.xdd

用于高级型 DSD 510 伺服驱动器的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_DSD510_A.xdd

用于 SDM 511/SDM 512 伺服驱动器模块的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_SDM510.xdd

用于电源模块 (PSM 510) 的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_PSM.xdd

用于分布式访问模块 (DAM 510) 的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_DAM.xdd

用于辅助电容器模块 (ACM 510) 的 XDD 文件（XML Device Description，XML 设备描述）： 0x0300008D_ACM.xdd

6.11.2 创建 Automation Studio™ 项目
除非另外指明，否则，本章中所述的操作步骤适用于 Automation Studio© 版本 3.0.90 和 V4.x。

有关如何安装 Automation Studio© 的详细信息，请参阅 Automation Studio© 帮助。打开 B&R Help Explorer（B&R 帮助管

理器）然后转到 [Automation software → Software Installation → Automation Studio]（自动化软件 → 软件安装 →
Automation Studio）。

有关如何在 Automation Studio© 中创建项目的详细信息，请参阅 Automation Studio© 帮助。

V3.0.90：

打开 B&R Help Explorer（B&R 帮助管理器）然后转到 [Automation Software → Getting Started → Creating programs
with Automation Studio → First project with X20 CPU]（自动化软件 → 入门 → 使用 Automation Studio 创建程序
→ 使用 X20 CPU 的第一个项目）。

V4.x：

打开 B&R Help Explorer（B&R 帮助管理器）然后转到 [Automation Software → Getting Started → Creating programs
with Automation Studio → Example project for a target system with CompactFlash]（自动化软件 → 入门 → 在
Automation Studio 中创建程序 → 使用 CompactFlash 的目标系统的示例项目）。

6.11.3 在 Automation Studio™ 项目中包括伺服运动库

操作步骤

在 Logical View（逻辑视图）中，打开菜单条目 [File → Import...]（文件 → 导入...）。

在下一窗口中，选择 Danfoss_VLT_ServoMotion_V_x_y_z.zip 文件（根据在硬盘上的位置）。

单击 Open（打开）。

在下一窗口中，将库分配给 CPU。

单击 Finish（完成）。现在，库已被集成到 Automation Studio© 项目中。
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在集成过程中，将创建包含 ISD 库的新文件夹：

DDS_Drive

包含由 PLCopen® 定义的程序组织单元 (POU)（名称以 MC_ 开头）和由 Danfoss  定义的 POU（名称以 DD_

开头）。Danfoss POU 为轴提供附加功能。

可组合使用由 PLCopen® 定义的 POU 和由 Danfoss  定义的 POU。

面向伺服驱动器的 POU 的名称全都以 _DDS 结尾。

DDS_PSM

包含由 Danfoss  定义的 POU（名称以 DD_ 开头），为电源模块 (PSM) 提供功能。

面向 PSM 的 POU 的名称全都以 _PSM 结尾。

DDS_DAM

包含由 Danfoss  定义的 POU（名称以 DD_ 开头），为分布式访问模块 (DAM) 提供功能。

面向 DAM 的 POU 的名称全都以 _DAM 结尾。

DDS_ACM

包含由 Danfoss  定义的 POU（名称以 DD_ 开头），为辅助电容器模块 (ACM) 提供功能。

面向 ACM 的 POU 的名称全都以 _ACM 结尾。

DDS_BasCam

包含用于创建基本 CAM 的 POU。

DDS_LabCam

包含用于创建标记 CAM 的 POU。

DDS_Intern

包含使用库时内部需要的 POU。

请不要在应用程序中使用这些 POU。

集成 DDS_Drive 文件包时，将自动集成一些标准库，除非这些库已是项目的组成部分。

注 意

请勿删除这些库，否则，Danfoss  伺服运动库将无法使用。

6.11.4 DDS_Drive 库内的常量
在该库内，定义了以下列出的常量：

Danfoss_VLT_ServoMotion

包含库的版本信息。

DDS_AxisErrorCodes

轴的错误代码的常量。

可使用功能块 MC_ReadAxisError_DDS 和/或 DD_ReadAxisWarning_DDS 读取错误代码。

DDS_AxisTraceSignals

轴的轨迹信号的常量。

适合与功能块 DD_Trace_DDS 一起使用。

DDS_BasCam

用于创建基本 CAM 的常量。

DDS_CamParsingErrors

分析 CAM 问题的常量。

错误原因由功率块 MC_CamTableSelect_DDS 返回。

DDS_FB_ErrorConstants
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POU 内错误的常量。

原因在所有 POU 中都可用的输出 ErrorInfo.ErrorID 中提供。

DDS_Intern

库在系统内部需要的常量。

它们不适合在应用中使用。

DDS_LabCam

用于创建标记 CAM 的常量。

DDS_SdoAbortCodes

有关读取和写入参数的错误的常量。

原因在多个 POU 中可用的输出 AbortCode 中提供。

PSM_ErrorCodes

电源模块 (PSM 510) 的错误代码的常量。

可使用功能块 DD_ReadPsmError_PSM 和/或 DD_ReadPsmWarning_PSM 读取错误代码。

PSM_TraceSignals

电源模块 (PSM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_PSM 一起使用。

DAM_ErrorCodes

分布式访问模块 (DAM 510) 的错误代码的常量。

可使用功能块 DD_ReadDamError_DAM 和/或 DD_ReadDamWarning_DAM 读取错误代码。

DAM_TraceSignals

分布式访问模块 (DAM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_DAM 一起使用。

ACM_ErrorCodes

辅助电容器模块 (ACM 510) 的错误代码的常量。

可使用功能块 DD_ReadAcmError_ACM 和/或 DD_ReadAcmWarning_ACM 读取错误代码。

ACM_TraceSignals

辅助电容器模块 (ACM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_ACM 一起使用。

6.11.5 在 Automation Studio™ 中实例化 AXIS_REF_DDS

操作步骤

为必须控制或监测的每个 SDM 511/SDM 512 驱动器模块和伺服驱动器创建功能块 AXIS_REF_DDS（位于文件夹

DDS_Drive 中）的一个实例。

要创建指向物理伺服驱动器的链接，将 AXIS_REF_DDS 的每个实例链接到 1 个物理伺服驱动器。这将使它成为一个物

理伺服驱动器的逻辑表示。

打开 Logical View（逻辑视图）。

使用其节点编号和所连接到的插槽的名称（如，IF3）初始化每个实例。

使用 DriveType 初始化每个驱动器实例。
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示例

图解 61: AXIS_REF_DDS 的实例化和初始值的设置

6.11.6 在 Automation Studio™ 中实例化 PSM_REF

操作步骤

为每个必须控制或监测的电源模块 (PSM) 创建功能块 PSM_REF（位于文件夹 DDS_PSM 中）的一个实例。

要创建指向物理 PSM 的链接，将 PSM_REF 的每个实例都链接到一个物理 PSM。这将使它成为一个物理 PSM 的逻辑表

示。

打开 Logical View（逻辑视图）。

使用其节点编号和所连接到的插槽的名称（如，IF3）初始化每个实例。

6.11.7 在 Automation Studio™ 中实例化 DAM_REF

操作步骤

为每个必须控制或监测的分布式访问模块 (DAM) 创建功能块 DAM_REF（位于文件夹 DDS_DAM 中）的一个实例。

要创建指向物理 DAM 的链接，将 DAM_REF 的每个实例都链接到一个物理 DAM。这将使它成为一个物理 DAM 的逻辑表

示。

打开 Logical View（逻辑视图）。

使用其节点编号和所连接到的插槽的名称（如，IF3）初始化每个实例。

6.11.8 在 Automation Studio™ 中实例化 ACM_REF

操作步骤

为每个必须控制或监测的辅助电容器模块 (ACM) 创建功能块 ACM_REF（位于文件夹 DDS_ACM 中）的一个实例。

要创建指向物理 ACM 的链接，将 ACM_REF 的每个实例都链接到一个物理 ACM。这将使它成为一个物理 ACM 的逻辑表

示。

打开 Logical View（逻辑视图）。

使用其节点编号和所连接到的插槽的名称（如，IF3）初始化每个实例。

6.11.9 将伺服驱动器导入到 Automation Studio™ 中

注 意

对于每个物理伺服驱动器，在 Automation Studio© 的 Physical View（物理视图）中添加一个条目。

6.11.9.1 版本 V3.0.90
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操作步骤

选择菜单项 [Tools → Import Fieldbus Device...]（工具 → 导入现场总线设备...）。

从硬盘上的相应位置选择 XDD 文件（例如，0x0300008D_ISD510_S.xdd 或 0x0300008D_ISD510_A.xdd）。对于每个项

目，仅需执行一次此导入。然后，Automation Studio© 将能识别该设备。

现在，在 Physical View（物理视图）中，为控制器的以太网 POWERLINK® 接口添加 SDM 511/SDM 512 驱动器模块或

伺服驱动器：

在 Physical View（物理视图）中，右键单击相应控制器，然后选择 [Open POWERLINK]（打开 POWERLINK）。

右键单击该接口然后选择 Insert..（插入..）。

在 Select controller module（选择控制器模块）窗口中，在组 POWERLINK Devices（POWERLINK 设备）中选择

伺服驱动器。

单击 Next（下一步）。

在下一窗口中，输入伺服驱动器的节点数量。

e3
0b

h5
13

.1
0

图解 62: 在 V3.0.90 中为项目添加伺服驱动器

6.11.9.2 版本 V4.x

操作步骤

选择菜单项 [Tools → Import Fieldbus Device...]（工具 → 导入现场总线设备...）。

从硬盘上的相应位置选择 XDD 文件（例如，0x0300008D_ISD510_S.xdd 或 0x0300008D_ISD510_A.xdd）。然后，Au‐

tomation Studio© 将能识别该设备。

现在，在 Physical View（物理视图）中，为控制器的以太网 POWERLINK® 接口添加 SDM 511/SDM 512 驱动器模块或

伺服驱动器：

选择菜单项 [Open → System Designer]（打开 → 系统设计器）以打开 System Designer（系统设计器）。

要在 Physical View（物理视图）或 System Designer（系统设计器）中添加硬件模块，在 Hardware Catalog（硬

件目录）工具箱中的组 POWERLINK 中选择伺服驱动器。

将选定模块拖到目标位置以将它连接到所选硬件模块、网络接口或插槽。

要更改节点编号，右键单击相应设备然后选择 [Node Number → Change Node Number]（节点编号 → 更改节点编
号）。
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图解 63: 在 V4.x 中为项目添加伺服驱动器

6.11.10 将 PSM 510、DAM 510 和 ACM 510 导入到 Automation Studio™ 中

注 意

对于每个物理电源模块 (PSM 510)、分布式访问模块 (DAM 510) 和辅助电容器模块 (ACM 510)，在 Automation Studio©

的 Physical View（物理视图）中添加一个条目。

6.11.10.1 版本 V3.0.90

操作步骤

选择菜单项 [Tools → Import Fieldbus Device...]（工具 → 导入现场总线设备...）。

从硬盘上的相应位置选择 PSM 510、DAM 510 或 ACM 510 的 XDD 文件。对于每个项目，仅需执行一次此导入。然后，
Automation Studio© 将能识别该设备。

电源模块 (PSM 510)： 0x0300008D_PSM.xdd

分布式访问模块 (DAM 510)： 0x0300008D_DAM.xdd

辅助电容器模块 (ACM 510)： 0x0300008D_ACM.xdd

现在，在 Physical View（物理视图）中，为控制器的以太网 POWERLINK® 接口添加 PSM 510、DAM 510 或 ACM 510：

在 Physical View（物理视图）中，右键单击相应控制器，然后选择 [Open POWERLINK]（打开 POWERLINK）。

右键单击该接口然后选择 Insert...（插入..）。

在 Select controller module（选择控制器模块）窗口中，在组 POWERLINK Devices（POWERLINK 设备）中选择

PSM 510、DAM 510 或 ACM 510。

单击 Next（下一步）。

在下一窗口中，输入 PSM 510、DAM 510 或 ACM 510 的节点数量。

e3
0b

h5
15

.1
0

图解 64: 在 V3.0.90 中，为以太网 POWERLINK® 接口添加了 1 个 PSM 510、1 个 DAM 510 和 2 个 ISD 510 伺服驱动器

6.11.10.2 版本 V4.x

操作步骤

选择菜单项 [Tools → Import Fieldbus Device...]（工具 → 导入现场总线设备...）。

从硬盘上的相应位置选择 PSM 510、DAM 510 或 ACM 510 的 XDD 文件。然后，Automation Studio© 将能识别该设备。

AQ262450196490zh-000101 / 175R117080 | Danfoss A/S © | 2019.10

调试

VLT® Multiaxis Servo Drive MSD 510 System

操作指南



-

-

-

3.

-

-

-

-



1.

-

-

2.

-

-

3.

-

电源模块 (PSM 510)： 0x0300008D_PSM.xdd

分布式访问模块 (DAM 510)： 0x0300008D_DAM.xdd

辅助电容器模块 (ACM 510)： 0x0300008D_ACM.xdd

现在，在 Physical View（物理视图）中，为控制器的以太网 POWERLINK® 接口添加 PSM 510、DAM 510 或 ACM 510：

选择菜单项 [Open → System Designer]（打开 → 系统设计器）以打开 System Designer（系统设计器）。

要在 Physical View（物理视图）或 System Designer（系统设计器）中添加硬件模块，在 Hardware Catalog（硬

件目录）工具箱中的组 POWERLINK 中选择 PSM 510、DAM 510 或 ACM 510。

将选定模块拖到目标位置以将它连接到所选硬件模块、网络接口或插槽。

要更改节点编号，右键单击相应设备然后选择 [Node Number → Change Node Number]（节点编号 → 更改节点编
号）。

PSM： Danfoss _VLT_R_PSM

DAM： Danfoss _VLT_R_DAM

ACM： Danfoss _VLT_R_ACM
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图解 65: 在 V4.x 中，为以太网 POWERLINK® 接口添加了 1 个 PSM 510、1 个 DAM 510 和 2 个 ISD 510 伺服驱动器

6.11.11 I/O 配置和 I/O 映射

操作步骤

对 SDM 511/SDM 512 驱动器模块或伺服驱动器的 I/O 配置进行参数化，以便库有权访问所有必需对象。

右键单击 SDM 511/SDM 512 驱动器模块或伺服驱动器的条目，然后，在 V3.0.90 中，选择 Open I/O Configuration

（打开 I/O 配置），在 V4.x 中， 选择 Configuration（配置）。

在 Channels（通道）部分，更改以下对象的 Cyclic transmission（循环传输）：

将对象 0x5050 (Lib pdo rx_I5050 ARRAY[]) 的所有子索引更改为 Write（写入）。

将对象 0x5051 (Lib pdo tx_I5051 ARRAY[]) 的所有子索引更改为 Read（读取）。

对电源模块 (PSM 510)、分布式访问模块 (DAM 510) 和辅助电容器模块 (ACM 510) 的 I/O 配置进行参数化，以便库
有权访问所有必需对象。

右键单击 PSM/DAM/ACM 的条目，然后，在 V3.0.90 中，选择 Open I/O Configuration（打开 I/O 配置），在

V4.x 中， 选择 Configuration（配置）。

在 Channels（通道）部分，更改以下对象的 Cyclic transmission（循环传输）：

将对象 0x5050 (Lib pdo rx_I5050 ARRAY[]) 的所有子索引更改为 Write（写入）。

将对象 0x5051 (Lib pdo tx_I5051 ARRAY[]) 的所有子索引更改为 Read（读取）。

这些设置用于配置与设备的循环通信。要使库正常工作，必须对这些参数进行设置。

注 意

可使用复制和粘贴功能向同一类型的多个设备应用同一 I/O 配置。

对于伺服驱动器和 PSM/DAM/ACM，将 Module supervised（监督的模块）设置为 off（关闭）。可在设备的 I/O 配置

中找到该参数。
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图解 66: ISD 510 设备的 I/O 配置
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图解 67: 成功配置后的 I/O 配置

映射 AXIS_REF_DDS 功能块的实例的输入和输出以及 ISD 510 伺服驱动器的物理数据点（其中，myAxis 是 AX‐

IS_REF_DDS 的一个实例）：
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图解 68: ISD 510 伺服驱动器的 I/O 映射

分别映射 PSM_REF、DAM_REF 和 ACM_REF 功能块的实例的输入和输出以及 PSM/DAM/ACM 的物理数据点。

6.11.12 设置 PLC 周期时间
昀短周期时间为 400 µs。伺服系统设备运行以太网 POWERLINK® 的周期时间可以为 400 µs 和 500 µs 的倍数。这些设备在

启动时由 PLC 自动参数化，具体取决于物理接口的 POWERLINK® 配置。要访问以太网 POWERLINK® 配置：对于 V3.0.90，在

Physical View（物理视 图）中，右键单击 [CPU → Open IF3 POWERLINK Configuration]（CPU → 打开 IF3 POWERLINK 配

置）；对于 V4.x，右键单击 [PLK → Configuration]（PLK → 配置）。

注 意

确保 PLC 程序的任务周期时间与以太网 POWERLINK® 周期时间相同。否则，数据可能会丢失，性能将降低。
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图解 69: 用于参数化以太网 POWERLINK® 周期时间的以太网 POWERLINK<® 配置窗口

在 Automation Studio 中设置 PLC 时间的操作步骤©

在 Physical View（物理视图）中，对于 V3.0.90，右键单击 [CPU → Open Software Configuration]（CPU → 打

开软件配置），对于 V4.x，右键单击 [CPU → Configuration → Timing]（CPU → 配置 → 定时）。

确保 PLC 周期时间与以太网 POWERLINK® 周期时间相同。

6.11.13 连接到 PLC
有关如何连接到 PLC 的详细信息，请参阅 Automation Studio© 帮助。

版本 V3.0.90：

打开 B&R Help Explorer（B&R 帮助管理器）然后转到 [Automation Software → Getting Started → Creating programs

with Automation Studio → First project with X20 CPU → Configure online connection]（自动化软件 → 入门 → 使
用 Automation Studio 创建程序 → 使用 X20 CPU 的第一个项目 → 配置联机连接）。

版本 V4.x：

打开 B&R Help Explorer（B&R 帮助管理器）然后转到 [Automation Software → Getting Started → Creating programs

in Automation Studio → Example project for a target system with CompactFlash]（自动化软件 → 入门 → 在 Au‐
tomation Studio 中创建程序 → 使用 CompactFlash 的目标系统的示例项目）。
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6.12 使用 TwinCAT® 编程

6.12.1 使用 TwinCAT® 编程的要求
要将 ISD 510/DSD 510 伺服驱动器、伺服驱动器模块 SDM 511/SDM 512 和 PSM 510、DAM 510 或 ACM 510 集成到 TwinCAT® 项

目中，需要使用以下文件：

用于 MSD 510  伺服系统的库： Danfoss_VLT_ServoMotion_V_x_y_z.lib

用于标准型 ISD 510 伺服驱动器的 ESI 文件（EtherCAT® Slave Information，从站设备描述）： Danfoss_ISD510_S.xml

用于高级 ISD 510 伺服驱动器的 ESI 文件（EtherCAT® Slave Information，从站设备描述）： Danfoss_ISD510_A.xml

用于标准型 DSD 510 伺服驱动器的 ESI 文件（EtherCAT® Slave Information，从站设备描述）： Danfoss_DSD510_S.xml

用于高级 DSD 510 伺服驱动器的 ESI 文件（EtherCAT® Slave Information，从站设备描述）： Danfoss_DSD510_A.xml

用于伺服驱动器模块的 ESI 文件（EtherCAT® Slave Information，从站设备描述）： Danfoss_SDM510.xml

用于电源模块的 ESI 文件（EtherCAT® Slave Information，从站设备描述）： Danfoss_PSM510.xml

用于分布式访问模块的 ESI 文件（EtherCAT® Slave Information，从站设备描述）： Danfoss_DAM510.xml

用于辅助电容器模块的 ESI 文件（EtherCAT® Slave Information，从站设备描述）： Danfoss_ACM510.xml

6.12.2 创建 TwinCAT® 项目
有关如何安装 TwinCAT® 的详细信息，请访问 Beckhoff 信息系统 (https://infosys.beckhoff.com/)。打开该信息系统，然

后选择 [TwinCAT 2 → TwinCAT Quick Start → Installation]（TwinCAT 2 → TwinCAT 快速入门 → 安装）。

有关如何在 TwinCAT® 中创建项目的详细信息，请访问 Beckhoff 信息系统 (https://infosys.beckhoff.com/)。打开该信息

系统，然后选择 [TwinCAT 2 → TwinCAT Quick Start or TwinCAT 2 → TX1200 TwinCAT PLC → TwinCAT PLC Control]
（TwinCAT 2 → TwinCAT 快速入门或 TwinCAT 2 → TX1200 TwinCAT PLC → TwinCAT PLC Control）。

6.12.3 在 TwinCAT® 项目中包括 TwinCAT® 库

操作步骤

在 TwinCAT® PLC Control 的 Resources（资源）选项卡中，打开 Library Manager（库管理器）。

在 Library Manager（库管理器）窗口的左上区域中，右键单击然后选择 Additional Library...（附加库...）。

选择 Danfoss_VLT_ServoMotion_V_x_y_z 文件（根据在硬盘上的位置）。

单击 Open（打开）。现在，库已被集成到 TwinCAT® PLC Control 项目中。
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图解 70: 包括 ServoMotion 库后的库管理器

在库内，POU 以文件夹形式来组织：

DDS_Drive

包含由 PLCopen® 定义的程序组织单元 (POU)（名称以 MC_ 开头）和由 Danfoss  定义的 POU（名称以 DD_

开头）。Danfoss POU 为轴提供附加功能。
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可组合使用由 PLCopen® 定义的 POU 和由 Danfoss  定义的 POU。

面向 SDM 511/SDM 512 驱动器模块和伺服驱动器的 POU 的名称全都以 _DDS 结尾。

DDS_PSM

包含由 Danfoss  定义的 POU（名称以 DD_ 开头），为电源模块 (PSM 510) 提供功能。

面向 PSM 510 的 POU 的名称全都以 _PSM 结尾。

DDS_DAM

包含由 Danfoss  定义的 POU（名称以 DD_ 开头），为分布式访问模块 (DAM 510) 提供功能。

面向 DAM 510 的 POU 的名称全都以 _DAM 结尾。

DDS_ACM

包含由 Danfoss  定义的 POU（名称以 DD_ 开头），为辅助电容器模块 (ACM 510) 提供功能。

面向 ACM 510 的 POU 的名称全都以 _ACM 结尾。

DDS_BasCam

包含用于创建基本 CAM 的 POU。

DDS_LabCam

包含用于创建标记 CAM 的 POU。

DDS_Intern

包含使用库时内部需要的 POU。

请不要在应用程序中使用这些 POU。

集成 VLT® Multiaxis Servo Drive  库时，将自动集成一些标准库，除非这些库已是项目的组成部分。

注 意

请勿删除这些库，否则，DDS 库将无法使用。

6.12.4 DDS_Drive 库内的常量
在该库内，定义了以下列出的常量：

Danfoss_VLT_ServoMotion

包含库的版本信息。

DDS_AxisErrorCodes

轴的错误代码的常量。

可使用功能块 MC_ReadAxisError_DDS 和/或 DD_ReadAxisWarning_DDS 读取错误代码。

DDS_AxisTraceSignals

轴的轨迹信号的常量。

适合与功能块 DD_Trace_DDS 一起使用。

DDS_BasCam

用于创建基本 CAM 的常量。

DDS_CamParsingErrors

分析 CAM 问题的常量。

错误原因由功率块 MC_CamTableSelect_DDS 返回。

DDS_FB_ErrorConstants

POU 内错误的常量。

原因在所有 POU 中都可用的输出 ErrorInfo.ErrorID 中提供。

DDS_Intern
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库在系统内部需要的常量。

它们不适合在应用中使用。

DDS_LabCam

用于创建标记 CAM 的常量。

DDS_SdoAbortCodes

有关读取和写入参数的错误的常量。

原因在多个 POU 中可用的输出 AbortCode 中提供。

PSM_ErrorCodes

电源模块 (PSM 510) 的错误代码的常量。

可使用功能块 DD_ReadPsmError_PSM 和/或 DD_ReadPsmWarning_PSM 读取错误代码。

PSM_TraceSignals

电源模块 (PSM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_PSM 一起使用。

DAM_ErrorCodes

分布式访问模块 (DAM 510) 的错误代码的常量。

可使用功能块 DD_ReadDamError_DAM 和/或 DD_ReadDamWarning_DAM 读取错误代码。

DAM_TraceSignals

分布式访问模块 (DAM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_DAM 一起使用。

ACM_ErrorCodes

辅助电容器模块 (ACM 510) 的错误代码的常量。

可使用功能块 DD_ReadAcmError_ACM 和/或 DD_ReadAcmWarning_ACM 读取错误代码。

ACM_TraceSignals

辅助电容器模块 (ACM 510) 的轨迹信号的常量。

适合与功能块 DD_Trace_ACM 一起使用。

6.12.5 在 TwinCAT® 中实例化 AXIS_REF_DDS

操作步骤

为必须控制或监测的 SDM 511/SDM 512 驱动器模块或伺服驱动器创建功能块 AXIS_REF_DDS（位于文件夹 DDS_Drive

中）的一个实例。

对其他 SDM 511/SDM 512 驱动器模块或伺服驱动器重复步骤 1。
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图解 71: AXIS_REF_DDS 的实例化

6.12.6 在 TwinCAT® 中实例化 PSM_REF

操作步骤

为每个必须控制或监测的电源模块创建功能块 PSM_REF（位于文件夹 DDS_PSM 中）的一个实例。

对其他电源模块重复步骤 1。

6.12.7 在 TwinCAT® 中实例化 DAM_REF

操作步骤

为每个必须控制或监测的分布式访问模块创建功能块 DAM_REF（位于文件夹 DDS_DAM 中）的一个实例。

对其他分布式访问模块重复步骤 1。

6.12.8 在 TwinCAT® 中实例化 ACM_REF

操作步骤

为每个必须控制或监测的辅助电容器创建功能块 ACM_REF（位于文件夹 DDS_ACM 中）的一个实例。

对其他辅助电容器模块重复步骤 1。

6.12.9 在 TwinCAT® System Manager 中添加 PLC 项目
要在 TwinCAT® PLC Control 项目和 TwinCAT® System Manager 之间创建链接，将保存的项目连接到 TwinCAT® System

Manager，尤其是输入和输出：

操作步骤

要在 TwinCAT® System Manager 中添加项目信息，右键单击 PLC-Configuration（PLC 配置）然后选择 Append PLC

project...（添加 PLC 项目...）。

在 Insert IEC 1131 Project（插入 IEC 1131 项目）窗口中，根据硬盘上的位置选择项目信息文件。该文件与 PLC

项目具有相同名称，但文件扩展名为 .tpy。

单击 Open（打开）。

6.12.10 将设备导入 TwinCAT®
以下操作步骤是如何将 ISD 510 伺服驱动器导入到 TwinCAT® 中的示例。

操作步骤

将 ESI 文件 Danfoss ISD 510 S.xml 复制到硬盘上的文件夹 TwinCAT Installation Folder\Io\EtherCAT 中。对

于每个项目，仅需执行一次此操作。TwinCAT® System Manager 自动在启动过程中在硬盘上的此位置搜索 ESI 文件。
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要添加一个 EtherCAT® 主站，右键单击 [I/O-Configuration → I/O Devices]（I/O 配置 → I/O 设备）然后选择

Append Device...（附加设备...）。

在以下窗口中，选择 [EtherCAT → EtherCAT] 然后单击 OK（确定）。
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图解 72: 在项目中添加 EtherCAT 主站

选择 Device 1 (EtherCAT)（设备 1 (EtherCAT)）然后在 Adapter（适配器）选项卡中的窗口右侧选择正确的 Network

Adapter（网络适配器）。

要添加一个电源模块，右键单击 Device1 (EtherCAT)（设备 1 (EtherCAT)）然后选择 Append Box...（附加框...）。

在 Insert EtherCAT Device（插入 EtherCAT 设备）窗口中，选择 [Danfoss  GmbH → VLT® FlexMotion → VLT®

Power Supply Module PSM 510] 然后单击 OK（确定）。

要添加一个分布式访问模块，右键单击 Device1 (EtherCAT)（设备 1 (EtherCAT)）然后选择 Append Box...（附加

框...）。

在 Insert EtherCAT Device（插入 EtherCAT 设备）窗口中，选择 [Danfoss  GmbH → VLT® FlexMotion → VLT®

Decentral Access Module] 然后单击 OK（确定）。

要添加一个辅助电容器模块，右键单击 Device1 (EtherCAT)（设备 1 (EtherCAT)）然后选择 Append Box...（附加

框...）。

在 Insert EtherCAT Device（插入 EtherCAT 设备）窗口中，选择 [Danfoss  GmbH → VLT® FlexMotion → VLT®

Auxiliary Capacitors Module] 然后单击 OK（确定）。

要在分布式访问模块 DAM 510 中添加伺服驱动器，右键单击 Box 1 (VLT® Decentral Access Module)（框 1 (VLT®

Decentral Access Module)）然后选择 Append Box...（附加框...）。

在 Insert EtherCAT Device（插入 EtherCAT 设备）窗口中，选择 [Danfoss  GmbH → VLT® FlexMotion → VLT®MSD

510  Integrated Servo Drive Standard] 然后单击 OK（确定）。

AQ262450196490zh-000101 / 175R117088 | Danfoss A/S © | 2019.10

调试

VLT® Multiaxis Servo Drive MSD 510 System

操作指南





e3
0b

h5
17

.1
0

图解 73: 为项目添加伺服驱动器
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图解 74: 附加 PLC 项目并添加分布式访问模块和 2 个 ISD 510 伺服驱动器后的 TwinCAT System Manager

如果将伺服驱动器用作 NC 轴，则对问题回答 No（否）。如果要将伺服驱动器用作 NC 轴，则请参阅 6.12.15 配置为

TwinCAT® NC 轴。

注 意

对于每个物理伺服驱动器、PSM 510、DAM 510 和 ACM 510，在 TwinCAT System Manager 的 EtherCAT® 主站

中添加一个条目。将伺服驱动器添加到正确的 DAM 510 线路。

6.12.11 I/O 配置和 I/O 映射
连接多个 SDM 511/SDM 512 驱动器模块或伺服驱动器时，将上一伺服驱动器的端口 C (X2) 连接到下一伺服驱动器的端口 A
(X1)。此外，为分布式访问模块 (DAM 510) 执行端口分配。

如果已显示出硬件设置选项，则可使用 TwinCAT® System Manager Scan devices（扫描设备）功能按正确顺序自动将连接的

设备添加到配置。

使用 TwinCAT® System Manager，配置 SDM 511/SDM 512 驱动器模块或伺服驱动器，以便 PDO 映射与库的要求相匹配。

操作步骤（以 ISD 510 伺服驱动器为例）
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单击 ISD 510 伺服驱动器项。

在右侧窗口中选择 Slots（插槽）选项卡。

通过选择 Slot（插槽）框中的 Module 1 (CSV PDO)（ 模块 1 (CSV PDO)）条目，删除当前 PDO 配置。

单击 X。

在 Module（模块）框中选择 Library PDO（库 PDO）。

单击 <。
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图解 75: 具有正确 I/O 配置的 ISD 510 伺服驱动器

6.12.12 将输入和输出变量与物理数据点相关联
使用 TwinCAT® System Manager，可将 PLC 程序的输入和输出变量与设备的物理输入和输出相关联。这可确保库能够访问所

有必需的对象。

警 告

对 Box 1 (VLT® Power Supply Module)（框 1 (VLT Power Supply Module)）和实例 myPSM 重复步骤 2–22。

对 Box 2 (VLT® Decentral Access Module)（框 2 (VLT Decentral Access Module)）和实例 myDAM 重复步骤 2–

22。

操作步骤

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT) → Box 1 (VLT Decentral
Access Module) → Drive 1 (VLT ISD 510 Integrated Servo Drive) → Module 1 (Library PDO) → Library
TxPDO]（I/O 配置 → I/O 设备 → 设备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 1
(VLT ISD 510 Integrated Servo Drive) → 模块 1（库 PDO）→ 库 TxPDO），然后选择 Library TxPDO（库 TxPDO）。

选择窗口右侧从 Lib pdo tx1 至 Lib pdo tx9 的所有条目。

e3
0b

h5
19

.1
0

图解 76: 将输入和输出与物理数据点相关联

右键单击然后选择 Change Multi Link...（更改多链路...）。

AQ262450196490zh-000101 / 175R1170 | 91Danfoss A/S © 2019.10

调试

VLT® Multiaxis Servo Drive MSD 510 System

操作指南



4.

5.

6.

7.

8.

9.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

在 Attach Variable 36.0 Byte(s) (Input)（关联变量 36.0 字节（输入））窗口中，选择 [PLC-Configuration →

MyFirstFlexMotionProject → Standard → .myAxis.TPDO]（PLC 配置 → MyFirstFlexMotionProject → 标准
→ .myAxis.TPDO）。确保在 Attach Variable（关联变量）窗口中选中 Matching Size（匹配大小）选项。

单击 OK（确定）。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT©) → Box1 (VLT© Decentral

Access Module) → Drive2 (VLT© ISD 510 Integrated Servo Drive) → Module1 (Library PDO) → Library

RxPDO]（I/O 配置 → I/O 设备 → 设备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 2
(VLT ISD 510 Integrated Servo Drive) → 模块 1（库 PDO）→ 库 RxPDO），然后单击库 RxPDO。

选择窗口右侧从 Lib pdo rx1 至 Lib pdo rx9 的所有条目。

右键单击然后选择 Change Multi Link...（更改多链路...）。

在 Attach Variable 36.0 Byte(s) (Output)（关联变量 36.0 字节（输出））窗口中，选择 [PLC-Configuration →

MyFirstIsd510Project → Standard → .myAxis.RPDO]（PLC 配置 → MyFirstIsd510Project → 标准 → .myAx‐
is.RPDO）。

单击 OK（确定）。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT©) → Box1 (VLT© Decentral

Access Module) → Drive2 (VLT© ISD 510 Integrated Servo Drive) → WcState]（I/O 配置 → I/O 设备 → 设

备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 2 (VLT ISD 510 Integrated Servo Drive)
→ WcState），右键单击 WcState，然后选择 Change Link...（更改链路...）。

在 Attach Variable State (Input)（关联变量状态（输入））窗口中，选择 [PLC-Configuration → MyFirst‐

Isd510Project → Standard → .myAxis.WcState]（PLC 配置 → MyFirstIsd510Project → 标准 → .myAx‐
is.WcState）。

单击 OK（确定）。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT©) → Box1 (VLT© Decentral

Access Module) → Drive2 (VLT© ISD 510 Integrated Servo Drive) → InfoData]（I/O 配置 → I/O 设备 → 设

备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 2 (VLT ISD 510 Integrated Servo Drive)
→ InfoData），右键单击 State（状态），然后选择 Change Link...（更改链路...）。

在 Attach Variable State (Input)（关联变量状态（输入））窗口中，选择 [PLC-Configuration → MyFirst‐

Isd510Project → Standard → .myAxis.State]（PLC 配置 → MyFirstIsd510Project → 标准 → .myAx‐
is.State）。

单击 OK（确定）。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT→) → Box1 (VLT® Decentral

Access Module) → Drive2 (VLT ISD 510 Integrated Servo Drive) → InfoData → AdsAddr]（I/O 配置 → I/O
设备 → 设备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 2 (VLT ISD 510 Integrated
Servo Drive) → InfoData → AdsAddr），右键单击 netId，然后选择 Change Link...（更改链路...）。

在 Attach Variable netId (Input)（关联变量 netId（输入））窗口中，选择 [PLC-Configuration → MyFirst‐

Isd510Project → Standard → .myAxis.AmsNetId]（PLC 配置 → MyFirstIsd510Project → 标准 → .myAx‐
is.AmsNetId）。

单击 OK（确定）。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT→) → Box1 (VLT Decentral
Access Module) → Drive2 (VLT ISD 510 Integrated Servo Drive) → InfoData → AdsAddr]（I/O 配置 → I/O
设备 → 设备 1 (EtherCAT) → 框 1 (VLT Decentral Access Module) → 驱动器 2 (VLT ISD 510 Integrated
Servo Drive) → InfoData → AdsAddr），右键单击 Port（端口），然后选择 Change Link...（更改链路...）。

在 Attach Variable port (Input)（关联变量端口（输入））窗口中，选择 [PLC-Configuration → MyFirst‐

Isd510Project → Standard → .myAxis.NodeNumber]（PLC 配置 → MyFirstIsd510Project → 标准 → .myAx‐
is.NodeNumber）。

单击 OK（确定）。

6.12.13 将映射传回 PLC 程序
要将映射传回 PLC 程序，在菜单项 Actions（操作）中选择 Activate Configuration...（激活配置...）。

在 TwinCAT® PLC Control 中重建后，TwinCAT® 配置如图解 77 所示（其中，myAxis 和 mySecondAxis 是 AXIS_REF_DDS 的

实例，myPSM 是 PSM_REF 的实例，myDAM 是 DAM_REF 的实例）。具体地址可能不同。
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图解 77: TwinCAT® 配置： 2 个伺服驱动器、1 个 PSM 510 和 1 个 DAM 510 的 I/O 映射

注 意

将 PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 连接到一个 SYNC 单元，将 ISD 510/DSD 510 伺服驱动器连接到另
一个单元。如果由于错误而关闭了分布式伺服驱动器的 UAUX 电源，则可防止与 PSM 510 和 DAM 510 的通信中断。

6.12.14 在 TwinCAT® PLC Control 中设置 PLC 周期时间
昀短周期时间为 400 µs。MSD 510 设备运行的 EtherCAT® 周期时间为 400 µs 或 500 µs 的倍数。这些设备在启动时由

PLC 自动参数化，具体取决于物理接口的 EtherCAT® 配置。要访问系统基础时间，在 TwinCAT® System Manager 中选择

[SYSTEM-Configuration → Real-Time Settings]（系统配置 → 实时设置）。然后，即可使用此基础时间的倍数来作为
EtherCAT® 周期时间。

注 意

将 PLC 程序的任务周期时间设置为与 EtherCAT® 周期时间相同。否则，数据可能会丢失，性能将降低。

操作步骤

在 Resources（资源）选项卡中双击 Task configuration（任务配置）。

确保 PLC 周期时间与 EtherCAT® 周期时间相同。

e
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g
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5
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0

图解 78: 用于参数化 PLC 周期时间的任务配置
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注 意

在 TwinCAT® PLC Control 中更改任务周期时间后，在 TwinCAT® System Manager 内执行 PLC 配置的

ReScan 以更新设置。然后，激活 PLC 中的配置。

6.12.15 配置为 TwinCAT® NC 轴
伺服驱动器可与 TwinCAT® 的内置 NC 功能一起使用。

与 PSM 510 和 DAM 510 相关的一切都必须按 6.12.2 创建 TwinCAT® 项目中所述执行。

操作步骤

除 Danfoss_VLT_ServoMotion_V_x_y_z.lib 文件外，包括 TcMC2.lib 文件。

为每个用作 NC 轴的 ISD 510/DSD 510 伺服驱动器创建一个 AXIS_REF（而不是 AXIS_REF_DDS）实例。

在 TwinCAT® System Manager 中附加 PLC 项目，导入设备然后将它们添加到 TwinCAT® 中，但是，在昀后一步，如

果将伺服驱动器用作 NC 轴，则对问题回答 Yes（是）。然后，将自动创建 NC 任务。

6.12.15.1 用作 NC 轴的伺服驱动器的 I/O 配置
在 TwinCAT® System Manager 中，为用作 NC 轴的伺服驱动器选择一个不同 I/O 配置。

操作步骤

根据要使用的运行模式，选择插槽 CSP PDO 或 CSV PDO。默认情况下，已映射并预先选定 CSV PDO。如果需要使用

VLT® Multiaxis Servo Drive  伺服驱动器来与 CSP PDO 一起使用，则映射以下变量：

在 NC 轴的 Settings（设置）选项卡中，选择 [NC-Configuration → NC-Task 1 SAF → Axes → Axis 1]（NC

配置 → NC 任务 1 SAF → 轴 → 轴 1）。单击 Link To (all Types)...（链接到（所有类型）...）按钮，然后

选择目标伺服驱动器。

在同一选项卡中，选择首选 Unit（单位）。

根据所选单位，通过 Parameter（参数）选项卡中的菜单 [NC-Configuration → NC-Task 1 SAF → Axes → Axis 1

→ Axis 1_Enc]（NC 配置 → NC 任务 1 SAF → 轴 → 轴 1 → 轴 1_Enc）为轴编码器调整 Scaling Factor（标定

因数）。示例： 当选中单位 Degrees（度）时，标定因数为 360°/220 = 0.00034332275390625。

在菜单项中依次选择 [NC-Configuration → NC-Task 1 SAF → Axes → Axis 1 → Axis 1_Enc]（NC 配置 → NC
任务 1 SAF → 轴 → 轴 1 → 轴 1_Enc），然后在 Parameter（参数）选项卡中设置 Reference Velocity（参考速

度）。

将 Output Scaling Factor（输出标定因数）（速度）设置为 125。

在轴的 Online（联机）选项卡中，测试功能和配置。

6.12.16 连接到 PLC
有关如何连接到 PLC 的详细信息，请访问 Beckhoff Information System 。

打开信息系统然后转到 [TwinCAT 2 → TwinCAT System Manager → Operation → Controls → Choose Target System]
（TwinCAT 2 → TwinCAT System Manager → 操作 → 控制 → 选择目标系统）。

6.13 Automation Studio™ 和 TwinCAT® 编程指南
实施建议：

初始化通常不会在程序开始时只更改一次的参数。在 Automation Studio© 中，使用 _INIT 部分。

在程序开始时使用 Enable（启用）输入调用提供状态或错误信息的功能块。

对每个轴使用功能块 MC_Power_DDS 的一个实例来控制其功率级。在每个 PLC 循环中调用此功能块。

对每个电源模块使用功能块 DD_Power_PSM 的一个实例来控制输出端的直流回路电压。在每个 PLC 循环中调用此功能块。

对每个分布式访问模块使用功能块 DD_Power_DAM 的一个实例来控制输出端的直流回路电压。在每个 PLC 循环中调用此

功能块。

对每个辅助电容器模块使用功能块 DD_Power_ACM 的一个实例来控制直流回路与 ACM 510 之间的连接。在每个 PLC 循环

中调用此功能块。

调用在程序结束时执行（运动）命令的功能块。
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请勿使用任何来自库（文件夹）DDS_Intern 的 POU。

请勿在一个功能块正忙时更改对其轴的引用。

注 意

完整参数列表可在 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 编程指南中找到。

6.14 使用 SIMOTION SCOUT® 编程

6.14.1 使用 SIMOTION SCOUT® 编程的要求
要将伺服系统模块集成到 SIMOTION SCOUT® 项目中，需要使用以下文件：

表 19: 需要的文件

系统模块 需要的文件

整个伺服系统 用于 MSD 510  伺服系统的库文件包： Danfoss_VLT_ServoMotion_V_x_y_z.zip

联机帮助文件 (.chm)： 使用 SIMOTION SCOUT 编程®

伺服驱动器模块 SDM 511/SDM 512 和
ISD 510/DSD 510 伺服驱动器

GSDML 文件（通用站描述）：

GSDML-V2.31-Danfoss-DDS-yyyymmdd.xml

电源模块 PSM 510 GSDML 文件（通用站描述）：

GSDML-V2.31-Danfoss-PSM-yyyymmdd.xml

分布式访问模块 DAM 510 GSDML 文件（通用站描述）：

GSDML-V2.31-Danfoss-DAM-yyyymmdd.xml

辅助电容器模块 ACM 510 GSDML 文件（通用站描述）：

GSDML-V2.31-Danfoss-ACM-yyyymmdd.xml

6.14.2 连接到 PLC
有关如何连接到 PLC 的详细信息，请参阅 SIMOTION SCOUT® 帮助。

打开 SIMOTION SCOUT®，转到 [Help → Help Topics → Getting Started with SIMOTION SCOUT → Download the project

to the target system → Connect to selected target devices → Go online]（帮助 → 帮助主题 → SIMOTION SCOUT
入门 → 将项目下载到目标系统 → 连接到所选目标设备 → 联机 ）。

6.14.3 创建 SIMOTION SCOUT® 项目
有关如何安装 SIMOTION SCOUT®® 的详细信息，请参阅 SIMOTION SCOUT® 配置手册。

注 意

必须安装带有 HF11 的 SIMATIC STEP 7 V5.5 或更高版本才能创建项目。

有关如何在 SIMOTION SCOUT® 中创建项目的详细信息，请参阅 SIMOTION SCOUT® 联机帮助。打开 SIMOTION SCOUT® 然后转

至 [Help → Help Topics → Getting started with SIMOTION SCOUT → Create SIMOTION device and configure PG/PC
communication connection]（帮助 → 帮助主题 → SIMOTION SCOUT 入门 → 创建 SIMOTION 设备和配置 PG/PC 通信连
接）。

6.14.4 在 SIMOTION SCOUT® 项目中包括伺服运动库
Project（项目）选项卡中的文件夹 LIBRARIES 包含以下库：

DDS_Drive
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包含由 PLCopen® 定义的程序组织单元 (POU)（名称以 MC_ 开头）和由 Danfoss  定义的 POU（名称以 DD_ 开头）。

Danfoss POU 为伺服驱动器提供附加功能。

可组合使用由 PLCopen® 定义的 POU 和由 Danfoss  定义的 POU。

面向 SDM 511/SDM 512 驱动器模块和伺服驱动器的 POU 的名称全都以 _DDS 结尾。

DDS_PSM

包含由 Danfoss  定义的 POU（名称以 DD_ 开头），为电源模块 (PSM 510) 提供功能。

面向 PSM 510 的 POU 的名称全都以 _PSM 结尾。

DDS_DAM

包含由 Danfoss  定义的 POU（名称以 DD_ 开头），为分布式访问模块 (DAM 510) 提供功能。

面向 DAM 510 的 POU 的名称全都以 _DAM 结尾。

DDS_ACM

包含由 Danfoss  定义的 POU（名称以 DD_ 开头），为辅助电容器模块 (ACM 510) 提供功能。

面向 ACM 510 的 POU 的名称全都以 _ACM 结尾。

DDS_BasCam

包含用于创建基本 CAM 的 POU。

DDS_LabCam

包含用于创建标记 CAM 的 POU。

DDS_Intern

包含使用库时内部需要的 POU。

请不要在应用程序中使用这些 POU。

集成 DDS_Drive 文件包时，将自动集成一些标准库，除非这些库已是项目的组成部分。
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图解 79: 包括丹佛斯伺服运动库后的项目树

注 意

请勿删除或重命名这些库。

操作步骤

从 Danfoss_VLT_ServoMotion_V_x_y_z.zip 文件（根据在硬盘上的位置）解压文件。

必须将 DDS_Xxxx.xml 文件和 XML_DDS_Xxxx 文件夹置于同一文件夹下以导入库。

在 Project（项目）选项卡中，右键单击 LIBRARIES（库），然后选择 [Export/import → Import folders/objects]

（导出/导入 → 导入文件夹/对象）。
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图解 80: 导入库

根据在硬盘上的位置选择文件 DDS_Intern.xml。

单击 OK（确定）。现在，库已被集成到 SIMOTION SCOUT® 项目中。

对 DDS_BasCam.xml、DDS_Drive.xml、DDS_LabCam.xml、DDS_PSM.xml、DDS_DAM.xml 和 DDS_ACM.xml 重复步骤 2–

4。

6.14.5 将设备导入 SIMOTION SCOUT®

注 意

对于每个物理伺服驱动器、PSM 510、DAM 510 或 ACM 510，在 HW Config（硬件配置）工具中的 PROFINET® 以太网中添

加一项。

操作步骤

打开 HW Config（硬件配置）工具。

选择 [Options → Install GSD File...]（选项 → 安装 GSD 文件...）。

要添加 SDM 511/SDM 512 驱动器模块或伺服驱动器，选择以下 xml 文件之一（根据在硬盘上的位置）然后单击 Install

（安装）。

GSDML-V2.31-Danfoss-DDS-yyyymmdd.xml

GSDML-V2.32-Danfoss-DDS-yyyymmdd.xml

GSDML-V2.33-Danfoss-DDS-yyyymmdd.xml

GSDML-V2.34-Danfoss-DDS-yyyymmdd.xml

对以下模块重复步骤 2 和 3：

电源模块 (PSM 510)： GSDML-V2.31-Danfoss-PSM-yyyymmdd.xml

分布式访问模块 (DAM 510)： GSDML-V2.31-Danfoss-DAM-yyyymmdd.xml

辅助电容器模块 (ACM 510)： GSDML-V2.31-Danfoss-ACM-yyyymmdd.xml

将设备 Danfoss Drive Servo IRT 拖到现有 PROFINET® 以太网中。

在屏幕右侧的硬件目录中展开 PROFINET IO 条目然后选择 [Additional Field Devices → Drives → VLT®

FlexMotion]（附加现场设备 → 驱动器 → VLT FlexMotion），查找名为 Danfoss Drive Servo IRT 的伺服
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驱动器设备。如果看不到该设备，则选择 [Options → Update catalog]（选项 → 更新目录）以更新硬件目
录。

在屏幕右侧的硬件目录中展开 Drive Object 1（驱动器对象 1）和文件夹 Profile，然后将 Danfoss Telegram（丹

佛斯报文）拖到屏幕底部的 Drive Object 1（驱动器对象 1）的可用插槽中。
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图解 81: 将丹佛斯报文拖到可用插槽

要设置通信参数，在显示出以太网的主窗口中双击表示伺服驱动器的图标。

在 General（常规）选项卡中，在字段 Device name（设备名称）中输入一个名称。

在 General（常规）选项卡中，单击 Ethernet...（以太网...）按钮以设置伺服驱动器的 IP 地址，然后单击 OK（确

定）。

对以下模块重复步骤 6–9：

电源模块 (PSM 510)： VLT PSM IRT

分布式访问模块 (DAM 510)： VLT DAM IRT

辅助电容器模块 (ACM 510)： VLT ACM IRT

6.14.6 分配 IP 配置和设备名

注 意

如果在同一 PROFINET® 网络中使用了多个伺服驱动器，则每个伺服驱动器都必须具有不同名称和 IP 地址。

通过 VLT® Servo Toolbox 软件使用间接通信时，也需要进行 IP 地址分配（请参阅 VLT® Servo Drive System

ISD 510、DSD 510、MSD 510 编程指南了解更多信息）。

操作步骤

打开菜单 [PLC → Ethernet → Edit Ethernet Node]（PLC → 以太网 → 编辑以太网代码）。

在下一窗口中，单击 Browse（浏览）。
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图解 82: 编辑以太网节点

此窗口中显示出所有可访问的以太网节点。

ISD 510 伺服驱动器在设备类型 VLT® ISD 510 下列出。

DSD 510 伺服驱动器在设备类型 VLT® DSD 510 下列出。

SDM 511/SDM 512 伺服驱动器模块在设备类型 VLT® SDM 510 下列出。

选择所需的伺服驱动器然后单击 OK（确定）（使用 Flash（快闪）按钮来识别特定伺服驱动器）。
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图解 83: 选择伺服驱动器

在 Edit Ethernet Node（编辑以太网节点）窗口中，选择选项 Use IP parameters（使用 IP 参数）。

输入 IP address（IP 地址）和 Subnet mask（子网掩码）然后单击 Assign IP configuration（分配 IP 配置）。
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图解 84: 输入 IP 地址和分配 IP 配置

输入以前选择的设备名称，然后单击 Assign Name（分配名称），然后选择 Close（关闭）。
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图解 85: 分配设备名称

6.14.7 创建同步域
同步域是一组同步到共用周期时钟的 PROFINET® 设备。一个设备的角色是同步主站（时钟发生器）。所有其他设备是同步从

站。

注 意

通过同步实时 (IRT) 交换数据的所有设备都必须属于同一同步域。

操作步骤

打开 HW Config（硬件配置）工具。

选择包含要参与 IRT 通信的 PROFINET® 设备的站点。

在 Station/IO system（站点/IO 系统）部分中选择 PROFINET® I/O 接口。

选择菜单 [Edit → PROFINET IO → Domain management]（编辑 → PROFINET IO → 域管理）。
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图解 86: 域管理

在 Sync Domain（同步域）选项卡中，在 Nodes（节点）区域的上部字段中选择站点。

在 Nodes（节点）区域的下部字段中，双击应配置为同步主站的设备。

出现 Device properties（设备属性）窗口后，为 Synchronization role（同步角色） 选择 Sync master（同步主

站），然后单击 OK（确定）。
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图解 87: 设备属性： 同步主站

在 Domain management（域管理）窗口中，在 Nodes（节点）区域选中要配置为同步从站的所有设备（按住 CTRL 键

可选择多个设备）。

单击 Device Properties（设备属性）按钮。

在 Device Properties（设备属性）窗口中，为 Synchronization role（同步角色）选择 Sync slave（同步从站）

然后单击 OK（确定）。
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图解 88: 设备属性： 同步从站

在 Domain management（域管理）窗口中，单击 OK（确定）。

选择包含 PROFINET® 设备的站点。

选择菜单 [Edit → Object properties]（编辑 → 对象属性）。

在下一窗口中，打开 Isochronous Tasks（同步任务）选项卡，为 I/O 数据更改选择同步模式，然后单击 OK（确定）。
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图解 89: 使用与伺服同步的 I/O 数据

单击 VLT® ISD 510 IRT 设备。

在 Module（模块）中双击 PN-IRT-Inteface（PN-IRT 接口）。

在下一窗口中，打开 IO Cycle（IO 循环）选项卡，将字段 Assign IO device in isochronous mode（在同步模式下

分配 IO 设备）设置为 Servo（伺服）。
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图解 90: 在同步模式下分配 IO 设备

6.14.8 配置拓扑结构
必须配置拓扑结构并进行参数化。

操作步骤

打开 HW Config（硬件配置）工具。

为 PROFINET® I/O 系统或 PROFINET® 模块选择路径，比如 Danfoss MSD 510  系列。

选择菜单 [Edit → PROFINET IO → Topology]（编辑 → PROFINET IO → 拓扑结构）。

在下一窗口中，选择 Graphic view（图形视图）选项卡。
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图解 91: 拓扑结构编辑器中的“图形视图”选项卡

将 PROFINET® 设备与站点相连。按住鼠标左键，在两个端口之间绘制一条线，可在端口之间建立连接。

完成所有连接后，单击 OK（确定）。
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6.14.9 定义发送时钟和更新时间

6.14.9.1 配置发送时钟时间

操作步骤

打开 HW Config（硬件配置）工具。

选择包含要参与 IRT 通信的 PROFINET® 设备的站点，比如 PNxIO。

选择菜单 [Edit → PROFINET IO → Domain management]（编辑 → PROFINET IO → 域管理）。

在下一窗口中，打开 Sync Domain（同步域）选项卡，在 Send clock time [ms]（发送时钟时间 [ms]）字段中，为

该过程选择一个适合的时间，例如 1.000 ms，然后单击 OK（确定）。
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图解 92: 为 PROFINET® IRT 配置发送时钟

6.14.9.2 配置更新时间

操作步骤

打开 HW Config（硬件配置）工具。

为 PROFINET® I/O 系统选择路径。

选择菜单 [Edit → Object properties]（编辑 → 对象属性）。

在下一窗口中，打开 Update Time（更新时间）选项卡，突出显示 I/O 设备，然后单击 Edit（编辑）按钮。

在下一窗口（Edit Update Time/Mode（编辑更新时间/模式））中，选择 Update Time（更新时间）然后单击 OK（确

定）。
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图解 93: 设置更新时间
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注 意

PLC 程序的系统循环时钟必须与 PROFINET® 发送时钟相同，否则，可能会导致数据丢失、性能降低。

6.14.10 访问输入和输出
SIMOTION SCOUT® 通过使用 I/O 变量的循环任务的过程映像，提供对 SIMOTION 设备的输入和输出的访问权限。

操作步骤

打开 Project（项目）选项卡，双击设备子树中的 ADDRESS LIST（地址列表）元素，例如 C240 [C240 PN]。
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图解 94: 项目导航器中的地址列表

在下一窗口（详细视图）中，为每个设备的进出 PPO 数据创建一个变量。
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图解 95: 地址列表详细视图

为每个变量设置以下属性：

Name（名称）（I/O 变量的名称）

I/O address（I/O 地址）

Data type（数据类型）： ARRAY OF BYTE（字节数组）

Array length（数组长度）： 36

Process image（过程映像）： IPOsynchronousTask

注 意

I/O 地址必须适合 HW Config（硬件配置）工具中的设备配置。

I/O 变量只能在脱机模式下创建。

6.14.11 使用丹佛斯 VLT® Servo Motion Library 编程
使用库中的数据类型、功能或功能块之前，必须在接口部分使用以下构造：
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USELIB DDS_BasCam、DDS_Drive、DDS_LabCam、DDS_PSM, DDS_DAM、DDS_ACM；

有关如何使用库中的数据类型、功能和功能块的详细信息，请参阅 SIMOTION SCOUT® 联机帮助。打开 SIMOTION SCOUT® 然后

转到 [Help → Help Topics → Programming → Integration of ST in SIMOTION → Using libraries → Using data
types, functions and function blocks from libraries]（帮助 → 帮助主题 → 编程 → 在 SIMOTION 中集成 ST → 使
用库 → 使用库中的数据类型、功能和功能块）。

注 意

请勿在应用程序中使用以 iDD_ 开头的 POU、常量和用户定义的数据类型 (UDT)。

6.14.12 在 SIMOTION SCOUT® 中实例化 AXIS_REF_DDS
为必须控制或监测的每个伺服驱动器创建 AXIS_REF_DDS（位于文件夹 DDS_Drive 中）的一个实例。每个 AXIS_REF_DDS 实例

都是一个物理伺服驱动器的逻辑表示。

注 意

必须将 AXIS_REF_DDS 结构的实例创建为一个全局变量（使用 VAR_GLOBAL 声明的单元的接口部分中的变量）。

在 AXIS_REF_DDS 结构中，仅在应用程序开始时为每个轴分配一次变量 InputLogAddress。这是指定 HW Config（硬件配置）

中的 I/O 模块的输入逻辑基础地址。对于此初始化，使用系统函数 _getLogicalAddressOfIoVariable()。仅在第一个 PLC

循环中分配一次变量 InputLogAddress 以进行初始化。

在 AXIS_REF_DDS 结构中，在应用程序开始时为每个循环中的每个轴分配变量 Quality。使用系统函数 _quality.<I/Ovari‐

able>，其中，<I/Ovariable> 是包含在 ADDRESS LIST（地址列表）中分配的循环数据的变量。在每个 PLC 循环中执行此分

配。

在应用程序开始时为每个循环中的每个设备调用函数 DD_UpdateProcessInput_DDS。在应用程序结束时为每个循环中的每个

设备调用函数 DD_UpdateProcessOutput_DDS。

注 意

在调用 DD_UpdateProcessInput 和 DD_UpdateProcessOutput 之间，仅创建操作说明和其他程序部分。

6.14.13 在 SIMOTION SCOUT® 中实例化 PSM_REF
为每个必须控制或监测的电源模块 (PSM 510) 创建 PSM_REF（位于文件夹 DDS_PSM 中）的一个实例。每个 PSM_REF 实例都是

一个物理 PSM 的逻辑表示。

注 意

必须将 PSM_REF 结构的实例创建为一个全局变量（使用 VAR_GLOBAL 声明的单元的接口部分中的变量）。

在 PSM_REF 结构中，在应用程序开始时为每个循环中的每个电源模块分配变量 Quality。使用系统函数 _quality.<I/

Ovariable>，其中，<I/Ovariable> 是包含在 ADDRESS LIST（地址列表）中分配的循环数据的变量。在每个 PLC 循环中执行

此分配。

在应用程序开始时为每个循环中的每个设备调用函数 DD_UpdateProcessInput_PSM。在应用程序结束时为每个循环中的每个

设备调用函数 DD_UpdateProcessOutput_PSM。

注 意

在调用 DD_UpdateProcessInput 和 DD_UpdateProcessOutput 之间，仅创建操作说明和其他程序部分。

6.14.14 在 SIMOTION SCOUT® 中实例化 DAM_REF
为每个必须控制或监测的分布式访问模块 (DAM 510) 创建 DAM_REF（位于文件夹 DDS_DAM 中）的一个实例。每个 DAM_REF 实

例都是一个物理 DAM 的逻辑表示。
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注 意

必须将 DAM_REF 结构的实例创建为一个全局变量（使用 VAR_GLOBAL 声明的单元的接口部分中的变量）。

在 DAM_REF 结构中，在应用程序开始时为每个循环中的每个分布式访问模块分配变量 Quality。使用系统函数 _quality.<I/

Ovariable>，其中，<I/Ovariable> 是包含在 ADDRESS LIST（地址列表）中分配的循环数据的变量。在每个 PLC 循环中执行

此分配。

在应用程序开始时为每个循环中的每个设备调用函数 DD_UpdateProcessInput_DAM。在应用程序结束时为每个循环中的每个

设备调用函数 DD_UpdateProcessOutput_DAM。

注 意

在调用 DD_UpdateProcessInput 和 DD_UpdateProcessOutput 之间，仅创建操作说明和其他程序部分。

6.14.15 在 SIMOTION SCOUT® 中实例化 ACM_REF
为每个必须控制或监测的辅助电容器模块 (ACM 510) 创建 ACM_REF（位于文件夹 DDS_ACM 中）的一个实例。每个 ACM_REF 实

例都是一个物理 ACM 的逻辑表示。

注 意

必须将 ACM_REF 结构的实例创建为一个全局变量（使用 VAR_GLOBAL 声明的单元的接口部分中的变量）。

在 ACM_REF 结构中，在应用程序开始时为每个循环中的每个辅助电容器模块分配变量 Quality。使用系统函数 _quality.<I/

Ovariable>，其中，<I/Ovariable> 是包含在 ADDRESS LIST（地址列表）中分配的循环数据的变量。在每个 PLC 循环中执行

此分配。

在应用程序开始时为每个循环中的每个设备调用函数 DD_UpdateProcessInput_ACM。在应用程序结束时为每个循环中的每个

设备调用函数 DD_UpdateProcessOutput_ACM。

注 意

在调用 DD_UpdateProcessInput 和 DD_UpdateProcessOutput 之间，仅创建操作说明和其他程序部分。

6.14.16 全局编译器设置
激活全局编译器设置 Permit language extensions（允许语言扩展）。

操作步骤

打开菜单 [Options → Settings]（选项 → 设置）。

在下一窗口中，选择 Compiler（编译器）选项卡。

选中复选框 Permit language extensions（允许语言扩展）然后单击 OK（确定）。
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图解 96: 全局编译器设置

6.14.17 分配任务
要保证同步操作，应用程序必须使用 Synchronous Task（同步任务）和 Peripheral Fault Task（外设故障任务）来评估警

报。

操作步骤

打开 Project（项目）选项卡。

双击设备子树中的 EXECUTION SYSTEM（执行系统）。
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图解 97: 项目导航器中的执行系统

在下一窗口中，展开 Execution levels（执行级别）条目，然后在树结构中依次选择 OperationLevels（操作级别）

和 SynchronousTask（同步任务）。

在 SynchronousTask（同步任务）窗口中，选中复选框 Use task in execution system（使用执行系统中的任务）。

在树结构中单击新条目 IPOsynchronousTask（IPO 同步任务）。

在 Synchronous Task（同步任务）窗口左侧的 Program assignment（程序分配）区域中，通过选择相应程序然后单

击 [>>] 按钮分配该程序。然后，该程序将被移至右侧的 Programs used（所用程序）区域。
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图解 98: 执行系统中的 IPOsynchronousTask（IPO 同步任务）

在 Task configuration（任务配置）选项卡中，将 Number of level overflows in the IPO cycle clock（IPO 循

环时钟中的溢出等级数）设置为 1，并将 IPOsynchronousTask / IPO cycle clock（IPO 同步任务/IPO 循环时钟）

设置为 50%。
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图解 99: IPO 同步任务配置

展开树结构中的 SystemInterruptTasks（系统中断任务），然后选择新条目 PeripheralFaultTask（外设错误任务）。

在 PeripheralFaultTask（外设错误任务）窗口 中，选中复选框 Use task in execution system（使用执行系统中

的任务）。

在 PeripheralFaultTask（外设错误任务）窗口左侧的 Program assignment（程序分配）区域中，通过选择相应程序

然后单击 [>>] 按钮分配该程序。然后，该程序将被移至右侧的 Programs used（所用程序）区域。

单击 Close（关闭）可保存和编辑设置。
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6.15 SIMOTION SCOUT® 编程指南
实施建议：

仅需在程序开始时，在 AXIS_REF_DDS 结构中为每个轴分配变量 InputLogAddress 一次。使用系统函数 _getLogica‐

lAddressOfIoVariable 从地址列表的 I/O 变量获取此地址。使用模块的输入地址作为 I/O 变量。仅在第一个 PLC 循环

中分配此变量以进行初始化。

初始化通常不会在程序开始时只更改一次的参数。

仅需在程序开始时，在 AXIS_REF_DDS 结构中为每个轴分配变量 Quality 一次。使用系统函数 _quality.var-name。为每

个 PLC 循环执行此检查。

为每个轴调用 DD_UpdateProcessInput_DDS 和 DD_UpdateProcessOutput_DDS 以更新输入和输出的过程映像分区。在每

个 PLC 循环中调用这些功能块。

在调用功能块 DD_UpdateProcessInput_DDS 和 DD_UpdateProcessOutput_DDS 之间，仅创建操作说明和其他程序部分。

在程序开始时使用 Enable（启用）输入调用提供状态或错误信息的功能块。

对每个轴使用功能块 MC_Power_DDS 的一个实例来控制其功率级。在每个 PLC 循环中调用此功能块。

对每个电源模块 (PSM 510) 使用功能块 DD_Power_PSM 的一个实例来控制输出线路上的直流回路电压及其功率级。在每

个 PLC 循环中调用此功能块。

对每个分布式访问模块 (DAM 510) 使用功能块 DD_Power_DAM 的一个实例来控制输出线路上的直流回路电压以及该模块

的功率级。在每个 PLC 循环中调用此功能块。

对每个辅助电容器模块 (ACM 510) 使用功能块 DD_Power_ACM 的一个实例来控制输出线路上的直流回路电压以及该模块

的功率级。在每个 PLC 循环中调用此功能块。

调用在程序结束时执行（运动）命令的功能块。

请勿使用名称以前縀 iDD_ 开头的任何 UDT、POU、枚举或常量。

请勿在一个功能块正忙时更改对其轴的引用。

6.16 VLT® Servo Toolbox 软件

6.16.1 概述
VLT® Servo Toolbox 是一个独立的由 Danfoss  设计的 PC 软件。它用于对系统模块进行参数化和诊断。此外，还可在非生产

环境中操作设备。

VLT® Servo Toolbox 包含多个子工具，提供各种功能。

表 20: 重要子工具

子工具 说明

示波器 用于展示伺服驱动器、电源模块 (PSM 510)、分布式访问模块 (DAM 510) 和辅助电容器模块 (ACM 510) 的跟
踪功能的结果。

参数列表 用于读取/写入参数。

固件更新 用于更新设备上的固件。

驱动器控制 用于因测试目的而操作伺服驱动器。

PSM 控制 用于因测试目的而操作电源模块 (PSM 510)。

DAM 控制 用于因测试目的而操作分布式访问模块 (DAM 510)。

ACM 控制 用于因测试目的而操作辅助电容器模块 (ACM 510)。

CAM 编辑器 用于设计伺服驱动器的 CAM 轨迹。

配置参数 用于设置电机和反馈参数以及 PID 设置。

驱动器调试 用于电机反馈调整和惯量测量。
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有关 VLT® Servo Toolbox 功能的详细介绍以及完整参数列表，请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510

编程指南。

6.16.2 系统要求
要安装 VLT® Servo Toolbox 软件，计算机必须满足以下要求：

支持的硬件平台： 32 位、64 位。

支持的操作系统： Windows 7、Windows 8.1、Windows 10。

.NET Framework 版本： 4.7。

昀低硬件要求： 512 MB RAM，主频为 2.6 GHz 的 Intel Pentium 4 或同等产品，20 MB 硬盘空间。

推荐的硬件要求： 昀小 1 GB RAM，Intel Core i5/i7 或兼容产品。

6.16.3 安装 VLT® Servo Toolbox 软件
如果使用 Windows 操作系统，则需要具有管理员权限才能安装软件。如果需要，与系统管理员联系。

操作步骤

检查系统是否符合 6.16.2 系统要求 中指定的系统要求。

从 Danfoss  网站下载 VLT® Servo Toolbox 安装文件。

右键单击 .exe 文件，然后选择 Run as administrator（以管理员身份运行）。

按照屏幕上的操作说明完成安装过程。

6.16.4 VLT® Servo Toolbox 通信

6.16.4.1 概述
本章介绍了 VLT® Servo Toolbox 所需的特定于以太网的网络接口设置。共有两种基本通信方法： 直接通信和间接通信。与

它们相关的特定网络设置在相应章节中介绍。

仔细阅读并严格执行步骤。错误的网络配置可导致网络接口的连接断开。

6.16.4.2 防火墙
根据所用的防火墙设置和现场总线，由 VLT® Servo Toolbox 发送和接收的消息可能会被 VLT® Servo Toolbox 主机系统上的

防火墙拦截。这可能导致通信断开，无法与现场总线上的设备通信。因此，确保允许 VLT® Servo Toolbox 通过 VLT® Servo

Toolbox 主机系统上的防火墙进行通信。对防火墙设置的更改不当可能会导致安全问题。

注 意

使用专用网络接口时，必须允许 VLT® Servo Toolbox 通过此网络接口进行通信。

6.16.4.3 间接通信

6.16.4.3.1 概述
MSD 510  设备与 VLT® Servo Toolbox 之间通过 PLC 进行通信称为间接通信。基于以太网的现场总线通信（在图中标记为 A）

在 PLC 与 MSD 510  设备之间进行。但是，PLC 与 VLT® Servo Toolbox 主机系统（在图中标记为 B）之间无现场总线通信。

在图中所示情况下，PLC 具有主站功能，与设备之间使用循环通信。因此，并非 VLT® Servo Toolbox 的所有功能都可使用，

比如驱动器控制。

有关使用间接通信时的限制的详细信息，请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 编程指南。
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图解 100: 间接基于以太网的现场总线通信（通过 PLC 通信）的逻辑视图

注 意

该逻辑视图仅显示出从高层次软件视角看到的连接，不反映网络的实际物理拓扑结构。

6.16.4.3.2 用于间接通信的网络设置
任何网络接口都可用于通过 PLC 通信。无需使用专用网络接口。

通过 PLC 建立通信后，VLT® Servo Toolbox 使用所选的网络地址转换 (NAT) 配置一个路由表。在 Windows 路由表中添加一

个路由需要管理员权限。因此，初始化连接时可能要求提供管理员凭据。

6.16.4.3.3 启用间接通信
执行以下步骤以启用间接通信。

注 意
通过 Wireshark® 监测网络封包时，校验和卸载通常会导致混乱，因为要传输的网络封包在校验和被计算出之前被转交给

Wireshark®。Wireshark® 将这些空校验和标记为无效，即使相应封包在后面离开网络硬件时包含有效的校验和也是如此。

使用这两种方法之一可避免此校验和卸载问题：

如果可能，在网络驱动程序中关闭校验和卸载。

在 Wireshark® 首选项中关闭特定协议的校验和验证。

禁用在 PC 上通信时所使用的网络接口上的 IPv6：

操作步骤

打开 Network and Sharing Center（网络和共享中心）。

选择 Change adapter settings（更改适配器设置）。

右键单击用于现场总线通信的网络接口，然后选择 Properties（属性）。

如果网络接口可使用 TCP/IPv6，则禁用它。

6.16.4.3.4 使用 EtherCAT® 进行间接通信的附加设置
设置 EtherCAT® 主站的 IP 地址：

操作步骤

打开 TwinCAT® System Manager。

选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT®)]（I/O 配置 → I/O 设备 → 设备 1 (Ether‐

CAT)）然后在 Adapter（适配器）选项卡中检查 IP 地址。PLC 网络适配器的 IP 地址可能不是链路本地地址（因此，

不在 169.254.0.1 至 169.254.255.254 范围内）。
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如果需要，根据给定操作系统更改 IPv4 协议属性内的 IP 地址。这可在本地控制器上或通过 Remote Desktop（远程

桌面）完成。

6.16.4.3.5 在 EtherCAT® 主站中激活 IP 路由功能
此处所述的操作步骤可能因 PLC 的类型和所安装的操作系统的不同而异。

操作步骤

打开 TwinCAT® System Manager。

在菜单项中依次选择 [I/O-Configuration → I/O Devices → Device1 (EtherCAT)]（I/O 配置 → I/O 设备 → 设
备 1 (EtherCAT)）打开 EtherCAT 选项卡，在其中单击 Advanced Settings...（高级设置...）。

在 Advanced Settings（高级设置）窗口中选择 EoE Support（EoE 支持）。

在 Windows Network（Windows 网络）部分中，启用 Connect to TCP/IP Stack（连接到 TCP/IP 堆栈）。

在 Windows IP Routing（Windows IP 路由）部分中，启用 IP Enable Router（IP 启用路由器）。

重启 PLC 以便更改生效。

6.16.4.3.6 设置 EtherCAT® 从站的 IP 地址
用于设置 EtherCAT® 从站的 IP 地址的操作步骤适用于：

ISD 510/DSD 510 伺服驱动器

电源模块 (PSM 510)

分布式访问模块 (DAM 510)

辅助电容器模块 (ACM 510)

伺服驱动器模块 SDM 511/SDM 512

注 意

IP 地址的昀后一个数字是 VLT® Servo Toolbox 软件中使用的用来识别该设备的 ID。

操作步骤

打开 TwinCAT® System Manager。

在 EtherCAT® 选项卡中的 [I/O-Configuration → I/O Devices → Device1 (EtherCAT) → Box 1 (VLT® Decen‐

tral Access Module → Drive 2 (VLT® Integrated Servo Drive ISD 510)]（I/O 配置 → I/O 设备 → 设备 1

(EtherCAT) → 框 1（VLT Decentral Access Module → 驱动器 2 (VLT Integrated Servo Drive ISD 510））下，单
击 Advanced Settings...（高级设置...）。

在 Advanced Settings（高级设置）窗口中选择 [Mailbox → EoE]（邮箱 → EoE）。

启用 Virtual Ethernet Port（虚拟以太网端口）并输入一个有效的 IP 地址。

配置中的每个从站都需要一个 IP 地址。当从站状态机的状态每次从 INIT 转换到 Pre-Operational（运行前）时，

此地址将被重新分配。默认情况下，从站的 IP 通信将被停用。

6.16.4.3.7 使用 PROFINET® 进行间接通信的附加设置

6.16.4.3.7.1 概述
每个 PROFINET© 设备都需要一个设备名称和 IP 地址。建立与 I/O 设备的连接后，IP 地址和设备名称将由 I/O 控制器分

配。

要通过 PG/PC 接口使用 TCP/IP 自动检测可访问的节点，将这些节点连接到 PG/PC 所在的物理以太网子网。如果一个节点位
于其他物理以太网子网中，则可指定要寻找的节点的 IP 地址。

要与更多节点通信，通过可访问的节点，能够对 PG/PC 接口添加 IP 地址和子网。然后，新的 IP 地址和子网将被添加到 PG/
PC 的以太网接口。

6.16.4.3.7.2 添加 IP 地地和子网掩码

操作步骤

打开 SIMOTION SCOUT®。

选择菜单 [Project → Accessible nodes]（项目 → 可访问的节点）。
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如果可访问的节点位于另一子网中，则将出现 Add IP addresses / subnet masks（添加 IP 地址 / 子网掩码）窗

口，其中显示出这些节点。
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图解 101: 可访问的节点

单击 Yes（是）接受地址。

现在，IP 地址/子网掩码已添加。

注 意

如果在同一 PROFINET® 网络中使用了多个 Danfoss  伺服驱动器，则每个伺服驱动器都必须具有不同名称和 IP 地址。

IP 地址的昀后一个数字是 VLT® Servo Toolbox 软件中使用的用来识别该设备的 ID。

Accessible nodes（可访问的节点）选项卡关闭后，地址将保留。仅当 SIMOTION SCOUT® 关闭后才会丢弃新添加的地

址。

6.16.4.4 直接通信

6.16.4.4.1 概述
对于基于以太网的现场总线通信（直接通信），VLT® Servo Toolbox 必须使用 VLT® Servo Toolbox 主机系统上的专用网络接

口。请勿同时将此网络接口用于任何其他通信。
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图解 102: 直接基于以太网的现场总线通信的逻辑视图
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警 告

该逻辑视图仅显示出从高层次软件视角看到的连接，不反映网络的实际物理拓扑结构。

6.16.4.4.2 与以太网 POWERLINK® 直接通信的网络设置
在用于直接以太网 POWERLINK® 通信的网络接口上，禁用除 TCP/IPv4 以外的所有网络协议。这可防止其他计算机软件或操作

系统使用此网络接口来执行其他任务，比如文件和打印机共享以及网络发现。禁用这些协议可减少通过网络接口发送的非相关
数据包的数量，从而降低整个网络负载。

6.16.4.4.3 在 PC 上禁用网络接口上的未用协议

操作步骤

打开 Network and Sharing Center（网络和共享中心）。

单击左侧的 Change adapter settings（更改适配器设置）。

右键单击用于现场总线通信的网络接口，然后选择 Properties（属性）。

取消选中 Internet Protocol Version 4 (TCP/IPv4)（Internet 协议版本 4 (TCP/IPv4)）以外的所有复选框。

按 6.16.4.3.2 用于间接通信的网络设置 中所述禁用网络接口上的 IPv4 Checksum offload（IPv4 校验和卸载）。
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图解 103: 局域连接 2 属性

6.16.4.4.4 设置正确的以太网 POWERLINK® 主站 IP 地址

操作步骤

打开 Network and Sharing Center（网络和共享中心）。

单击左侧的 Change adapter settings（更改适配器设置）。

右键单击用于现场总线通信的网络接口，然后选择 Properties（属性）。

单击 Internet Protocol Version 4 (TCP/IPv4)（Internet 协议版本 4 (TCP/IPv4)）（必须选中该复选框），然后单

击 Properties（属性）。

选择 Use the following IP address（使用以下 IP 地址）然后将 192.168.100.240 用作 IP 地址，将

255.255.255.0 用作子网掩码。保留所有其他字段为空。
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图解 104: Internet 协议版本 4 (TCP/IPv4) 属性

6.16.4.4.5 与 EtherCAT® 直接通信的网络设置
无需在 VLT® Servo Toolbox 宿主计算机上配置特定于 EtherCAT® 的网络接口。

6.17 VLT® Servo Toolbox 调试

6.17.1 步骤 1： 打开主窗口
主窗口 是所有 VLT® Servo Toolbox 功能的基础。其中包含以下组件：
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图解 105: 主窗口
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表 21: 主窗口说明

图
例
编
号

名称 说明

1 菜单栏 包含用于保存和加载项目、管理连接、显示和更改设置、管理打开的子工具以及显示帮助目录的常规功
能。

2 工具栏 包含用于保护和加载项目、连接到网络和从网络断开、自动搜索联机设备以及手动添加设备的快捷方式。

3 联机状态
和状态信
息

联机设备由设备 ID 旁边发光的灯泡指示。

联机设备是 VLT® Servo Toolbox 所连接到的实际存在的物理设备的逻辑设备。

颜色指示设备状态，是特定于设备的。

脱机状态
和状态信
息

脱机设备由设备 ID 旁边的灰色灯泡指示。

脱机设备是无对应物理设备的逻辑设备。脱机设备可表示已保存的设备配置或状态，比如用于脱机
分析或故障排查。此外，它还包含要写入物理设备的预配置的参数值。

4 可用子工
具

要打开一个子工具，可在 Device Environment（设备环境）中用鼠标左键双击其名称，或选择相应条目

然后按键盘上的 Enter 键。

5 设备环境 主窗口 的 Device Environment（设备环境）部分列出了由 VLT® Servo Toolbox 管理的所有逻辑设备，

显示它们的状态并用作用户界面来访问设备功能。

Device Environment（设备环境）窗口列出了添加的每个设备的所有可用子工具。

请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 编程指南，了解有关子工具的更多信息。

6 工作区 这是用于托管子工具的空间，其大小取决于主窗口 的大小。可将这些子工具昀大化、昀小化、水平或垂

直对齐或层叠显示。

7 监视列表
窗口

通过从设备循环读取一个或多个设备的参数值来评估它们。允许将参数值记录并保存到文本文件中。此
外，还可在监视列表中修改/写入值。

8 输出窗口 显示操作信息、警告和错误。根据用户设置，昀多显示 3 个不同日志级别（高、中和低）的消息。用于
显示高级错误和警告信息。

9 状态栏 显示 VLT® Servo Toolbox 的通信状态。如果连接到网络，则将显示出所用的硬件接口（例如，网络适

配器）和网络名称。

6.17.2 步骤 2： 连接到网络
预先配置相应通信设置以连接到网络（请参阅 6.16.4.1 概述）。

操作步骤

在主窗口 工具栏中，单击连接到总线 图标以打开 Connect to Network（连接到网络）窗口。

选择要连接到的现场总线类型和网络接口。

单击 OK（确定）以连接。

查看主窗口 底部的状态栏确定连接是否成功。
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图解 106: “连接到网络”窗口（以太网 POWERLINK®）

6.17.3 步骤 3： 扫描设备

操作步骤

确认 VLT® Servo Toolbox 连接到所选网络后，单击工具栏中的 Scan for Devices（扫描设备）图标以触发设备扫描

过程。

注 意

如果在循环模式下连接到以太网 POWERLINK® 网络，则在下一窗口中选择扫描范围（昀小和昀大 ID）来缩短扫描所需

的时间。在所有其他条件下，将扫描整个 ID 范围。

完成扫描后，Select Devices（扫描设备）窗口中将显示出可用设备的列表。选择要添加到 Device Environment（设

备环境）中的设备然后单击 OK（确定）。

所有选中的设备都将出现在 Device Environment（设备环境）窗口中并自动联机（由每个设备名称旁边闪烁的灯泡指

示）。

6.18 运动库

6.18.1 功能块
PLC 库提供了支持伺服系统的功能的功能块并符合以下标准：

PLCopen® 技术规格 - 运动控制功能块（以前称为第 1 部分和第 2 部分），版本 2.0，2011 年 3 月 17 日。

除 PLCopen® 功能外，Danfoss  还为伺服系统提供更多功能。

以下 PLCopen® 特征适用于所有功能块：

命令（使用输入端）

发送信号（输出端的行为）

一般调用约定

注 意

请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 编程指南，了解有关可用功能块及其行为的更多信息。

6.18.2 简单编程模板
TwinCAT®：

用于启动带有 1 个电源模块 (PSM 510)、1 个分布式访问模块 (DAM 510) 和 2 个轴的伺服系统的基本示例 PLC 应用。项目
DDS_ServoMotion_SampleProject 可从 Danfoss  网站下载。

Automation Studio©：

有关如何在 Automation Studio© 中打开 ISD 包内的示例项目的详细信息，请参阅 Automation Studio© 帮助。打开 B&R

Help Explorer（B&R 帮助管理器），转到 [Programming → Examples → Adding sample programs]（编程 → 示例 → 添加
示例项目），然后按照库示例的说明进行操作。
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PROFINET®

项目 DDS_ServoMotion_SampleProject 是一个基本示例 PLC (C240PN) 应用，用于启动带有 1 个电源模块 (PSM 510)、1 个

分布式访问模块 (DAM 510) 和 2 个轴的伺服系统。
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7 运行

7.1 运行模式

7.1.1 支持的运行模式
伺服驱动器实施了多种运行模式。伺服驱动器的行为取决于激活的运行模式。可在启用伺服驱动器后在各模式间切换。

支持的运行模式遵循 CANopen® CiA DS 402，还存在特定于 ISD 的运行模式。所有支持的运行模式都对 EtherCAT®、以太网

POWERLINK® 和 PROFINET® 可用。

各种运行模式在 VLT® Servo Drive System ISD 510、MSD 510、DSD 510 编程指南中详细介绍。

表 22: 运行模式

模式 说明

惯量测量模式 此模式测量轴的惯量。它用于测量伺服驱动器和外部负载的惯量，优化控制环路设置。摩擦效应将被自动清
除。

轨迹速度模式 在轨迹速度模式下，伺服驱动器在速度控制下运行，并以恒定速度进行运动。其他参数也可进行参数化，比
如加速和减速。

轨迹位置模式 在轨迹位置模式下，伺服驱动器在位置控制下运行，并执行绝对和相对运动。其他参数也可进行参数化，比
如速度、加速和减速。

轨迹转矩模式 在轨迹转矩模式下，伺服驱动器在转矩控制下运行，并以恒定转矩进行运动。使用线性斜坡。其他参数也可
进行参数化，比如转矩斜坡和昀大速度。

归位模式 在归位模式下，可设置伺服驱动器的应用参考位置。可使用多种归位方法，比如在实际位置归位、在功能块
归位、限位开关或归位开关。

CAM 模式 在 CAM 模式下，伺服驱动器将根据主轴执行同步运动。同步由 CAM 轨迹完成，其中包含与主位置相对应的
从站位置。可使用 ISD Toolbox 软件以图形方式设计 CAM，也可通过 PLC 进行参数化。指导值可由外部编
码器、虚拟轴或另一轴的位置提供。不同 CAM 轨迹类型在 VLT® Servo Drive System ISD 510、MSD 510 编

程指南中介绍。

齿轮模式 在齿轮模式下，伺服驱动器将使用主站和从站位置之间的传动比，根据主轴执行同步运动。指导值可由外部
编码器、虚拟轴或另一轴的位置提供。

周期同步位置
模式

在周期同步位置模式下，位置的轨迹发生器位于控制设备而不是伺服驱动器内。

周期同步速度
模式

在周期同步速度模式下，速度的轨迹发生器位于控制设备而不是伺服驱动器内。

7.1.2 运动功能
表 23: 运动功能

功能 说明

数字 CAM 开
关

此功能控制数字输出是启用还是禁用，具体取决于轴位置。它执行的功能与电机主轴上的开关相当。允许
向前和向后移动轴位置。开关补偿和迟滞可通过参数进行设置。

接触探针 此功能在配置的数字输入中存储上升沿或下降沿之后的位置实际值。

7.2 运行状态指示灯
MSD 510  系统组件的运行状态通过每个模块上的 LED 来指示。

注 意

对于安全功能来说，状态指示灯并不可靠。只能使用它们在调试和故障排查过程中进行一般诊断。
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7.2.1 SDM 511 和 SDM 512 上的工作指示 LED

STATUS SDM

LINK/ACT

DEV

SVS ST

NET ST

X1

X2

e3
0b

g5
75

.1
1

图解 107: SDM 511 和 SDM 512 上的工作指示 LED

表 24: SDM 511 和 SDM 512 上的工作指示 LED

LED 颜色 闪烁状态 说明

DEV 绿色 亮 设备状态为 Operation enabled（允许运行）。

闪烁 应用辅助电压。

红色 亮 设备状态为 Fault（故障）或 Fault reaction active

（故障反应激活）。

闪烁 未应用直流回路。

SVS ST 绿色 亮 应用 24 V 安全电源。

不亮 未应用 24 V 安全电源。

NET ST 绿色/红色 取决于现场总
线

设备的网络状态（请参阅对应的现场总线标准）。

LINK/ACT X1

（In（输入端）的链路/活动状态）

绿色 亮 已建立以太网链路。

闪烁 已建立以太网链路并激活。

不亮 无链路。

LINK/ACT X2

（Out（输出端）的链路/活动状态）

绿色 亮 已建立以太网链路。

闪烁 已建立以太网链路并激活。

不亮 无链路。
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7.2.2 PSM 510 上的工作指示 LED

STATUS PSM

LINK/ACT

DEV

SVS ST

NET ST

X1

X2

e3
0b

g5
76

.1
1

图解 108: PSM 510 上的工作指示 LED

表 25: PSM 510 上的工作指示 LED

LED 颜色 闪烁状态 说明

DEV 绿色 亮 设备状态为 Operation enabled（允许运行）。

闪烁 设备状态为 Standby（待机）或 Power-up（加电）。

红色 亮 设备状态为 Fault（故障）或 Fault reaction active（故障反应

激活）。

闪烁 未应用输入电源。

SVS ST 绿色 亮 应用 24 V 安全电源。

不亮 未应用 24 V 安全电源。

NET ST 绿色 亮 已连接。

橙色 亮 联机。

红色 闪烁 初始化。

亮 初始化失败或出现其他错误。

LINK/ACT X1

（In（输入端）的链路/活动状态）

绿色 亮 已建立以太网链路。

闪烁 已建立以太网链路并激活。

不亮 无链路。

LINK/ACT X2

（Out（输出端）的链路/活动状态）

绿色 亮 已建立以太网链路。

闪烁 已建立以太网链路并激活。

不亮 无链路。
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7.2.3 DAM 510 上的工作指示 LED

STATUS DAM

LINK/ACT

DEV

SVS ST

NET ST

AUX

X1

X2

X3

e3
0b

g5
77

.1
1

图解 109: DAM 510 上的工作指示 LED

表 26: DAM 510 上的工作指示 LED

LED 颜色 闪烁状态 说明

DEV 绿色 亮 设备状态为 Operation enabled（允许运行）。

闪烁 设备状态为 Standby（待机）或 Power-up（加电）。

红色 亮 设备状态为 Fault（故障）或 Fault reaction active

（故障反应激活）。

闪烁 输入端未应用直流回路。

SVS ST 绿色 亮 应用 24 V 安全电源。

不亮 未应用 24 V 安全电源。

NET ST 绿色 亮 已连接。

橙色 亮 联机。

红色 闪烁 初始化。

亮 初始化失败或出现其他错误。

AUX

（辅助电压的状态）

绿色 亮 对输出连接器应用辅助电压。

不亮 未对输出连接器应用辅助电压。

红色 亮 在硬件中检测到辅助电压欠压。

LINK/ACT X1

（In 的链路/活动）

绿色 亮 已建立以太网链路。

闪烁 已建立以太网链路并激活。

不亮 无链路。

LINK/ACT X2

（Hybrid Out（混合输出）的链路/活动状态）

绿色 亮 已建立以太网链路。

闪烁 已建立以太网链路并激活。
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LED 颜色 闪烁状态 说明

不亮 无链路。

LINK/ACT X3

（Out（输出端）的链路/活动状态）

绿色 亮 已建立以太网链路。

闪烁 已建立以太网链路并激活。

不亮 无链路。

7.2.4 ACM 510 上的工作指示 LED

STATUS ACM

LINK/ACT

DEV

CAP ST

NET ST

X1

X2

e
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0
b

g
5

7
8

.1
0

图解 110: ACM 510 上的工作指示 LED

表 27: ACM 510 上的工作指示 LED

LED 颜色 闪烁状态 说明

DEV 绿色 亮 设备状态为 Operation enabled（允许运行）。

闪烁 设备状态为 Standby（待机）或 Power-up（加电）。

红色 亮 设备状态为 Fault（故障）或 Fault reaction active（故障反应

激活）。

闪烁 输入端未应用直流回路。

CAP ST 绿色 亮 电容器完全充电。

闪烁 电容器正在充电/放电。

不亮 电容器已放电。

NET ST 绿色 亮 已连接。

橙色 亮 联机。

红色 闪烁 初始化。

亮 初始化失败或出现其他错误。

LINK/ACT X1

（In 的链路/活动）

绿色 亮 已建立以太网链路。
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LED 颜色 闪烁状态 说明

闪烁 已建立以太网链路并激活。

不亮 无链路。

LINK/ACT X2

（Out（输出端）的链路/活动状态）

绿色 亮 已建立以太网链路。

闪烁 已建立以太网链路并激活。

不亮 无链路。

AQ262450196490zh-000101 / 175R1170 | 127Danfoss A/S © 2019.10

运行

VLT® Multiaxis Servo Drive MSD 510 System

操作指南



-

-

-

-

-

-

-

8 功能安全概念

8.1 功能说明
VLT® Multiaxis Servo Drive MSD 510  系统集成有安全功能 Safe Torque Off (STO)。该安全功能在菊花链形式的连接中可
用，除 ACM 510（不含电缆）以外的所有系统组件之间都可通过菊花链形式连接。混合电缆将 STO 信号从 DAM 510 传送到链
中的所有 ISD 510/DSD 510 伺服驱动器上。激活 STO 后（安全状态），ISD 510/DSD 510 伺服驱动器或连接到 SDM 511/SDM 512
的任何电机上不会产生转矩。复位安全功能后可通过 PLC 执行诊断。

注 意

在伺服系统或在受影响的机器部位执行机械作业时，使用 STO 功能可避免机械危害。但是，STO 功能不提供电气安全。

8.2 安全事项

警 告
不受控的移动

电机上的外力会导致不受控制且危险的移动，继而导致严重伤亡。

对电机采取额外措施，防止不受控制且危险的移动，比如机械制动。

警 告
电击危险

STO 功能不会切断伺服系统或辅助电路的主电源电压。如果不切断设备的主电源供电并等待规定的放电时间，则会导致严重

伤亡。

只能在切断主电源供电并等待放电时间过后，才能在 Danfoss  系统组件或 ISD 510/DSD 510 伺服驱动器的电气部件上
进行操作。

警 告
残余旋转的风险

由于驱动器的功率半导体出现故障，因某一故障引发的残余旋转可能会导致严重伤亡。旋转度可以按下述方式计算：角度 =

360°/(极数)。

考虑此残余旋转并确保不会引发安全风险。

警 告
LED 状态可靠性

对于安全功能来说，状态指示灯 (LED) 并不可靠。

只能使用状态指示灯在调试和故障排查过程中进行一般诊断。

注 意

安装 STO 功能后，执行启用测试。若要符合安全标准，则在昀初安装和每次做出改动后，系统都必须通过启用测试（请
参阅 8.8 启用测试）。

注 意

如果需要，按照 EN ISO 13849-1 执行手动复位功能。要在无手动复位的情况下自动重启，请遵守 EN ISO 12100:2010 段
落 6.3.3.2.5 或同等标准中详细规定的要求。
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注 意

执行风险评估，以按照 EN 60204-1 为每个停止功能选择正确的停止类别。

设计机器应用时，应考虑采用定时和距离来实现惯性停车（停止类别 0 或 STO）。有关详细信息，请参阅 EN 60204-1。

连接到 STO 的所有信号都必须由 PELV 电源供电。

8.3 由具备资质的人员处理功能安全
只能由具备相应资质的人员对 STO 功能进行安装、设置、调试、维护和退役处置。功能安全方面具备资质的人员是指有资质
的电气工程师，或者是经有资质的电气工程师培训过的人员，具有相应经验，能够按照安全技术的一般标准和规范来操作装
置、系统、设备和机械装置。

此外，他们还必须：

熟悉有关健康和安全/事故预防的基本法规。

已阅读并理解本手册中提供的安全指导原则。

熟悉与特定应用有关的一般标准和专门标准。

动力驱动系统（安全相关）(PDS(SR)) 的用户负责：

对应用进行危险和风险分析。

应用的总体安全。

确定所需的安全功能并为每个功能分配 SIL 或 PL，并确定其他子系统以及来自这些子系统的信号和命令的有效性。

设计适合的安全相关控制系统，比如硬件、软件和参数化等。

8.4 适用标准和合规性
使用 STO 功能时，需符合所有安全规定，包括相关法律、法规和准则的要求。

集成的 STO 功能符合下述标准：

IEC 60204-1： 2016 停止类别 0 – 不受控停止

EN 60204-1： 2018 停止类别 0 – 不受控停止

IEC/EN 61508： 2010 SIL 2

IEC 61800-5-2： 2016 SIL 2

EN 61800-5-2： 2017 SIL 2

IEC 62061： 2005、A1: 2012 和 A2: 2015

EN 62061： 2005、Cor.:2010、A1: 2013 和 A2: 2015

IEC/EN 62061： 2015 SIL CL2

EN ISO 13849-1： 2015 类别 3，PL d

EN ISO 13849-2： 2014

8.5 缩略语与约定
表 28: 安全相关缩略语与约定

缩略语 参考值 说明

Cat. EN ISO 13849-1 B 类，1–4

DC – 诊断覆盖率

FIT – 失效时间

失效率： 1E-9/小时

HFT EN IEC 61508 硬件故障承受力

HFT = n，即 n + 1 次故障可能造成安全功能丧失。

MTTFD EN ISO 13849-1 平均无危险故障时间

单位： 年
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缩略语 参考值 说明

PFH EN IEC 61508 单位小时的危险故障几率

这个值应在下述情况中测得：安全设备在高需求或持续工作模式下工作，与安全有关的系统
的使用需求频率每年超过一次。

PL EN ISO 13849-1 性能等级

用于规定系统的安全相关部件在可预见情况下执行安全功能的能力的离散等级。级别： a–
e。

SFF EN IEC 61508 安全故障率 [%]

安全功能或子系统所发生的安全故障和检测到的危险故障在所有可能故障中的占比。

SIL EN IEC 61508

EN IEC 62061

安全完整性级别

STO EN IEC 61800-5-2 Safe Torque Off

8.6 安装
带有加减开关输出信号的安全继电器可直接连接到伺服系统以激活 STO。

图解 111 中的示例为使用 STO 功能应进行的基本连接。Danfoss 不提供用于关闭该功能的适合的安全装置。通过打开 STO+
和 STO– 可激活 STO。

表 29: 激活 STO 功能

STO+ STO– STO 功能

24 V GND 禁用 STO

打开 GND 激活 STO

24 V 打开 激活 STO

打开 打开 激活 STO

注 意

STO 输入端的电压不得超过 30 V。

如果正输入介于 –3 V 至 +3 V 之间，则激活 STO。

如果正输入介于 +21.6 V 至 +26.4 V 之间，则禁用 STO。

图解 111: 带有正切换输出和负切换输出的安全继电器

带有测试脉冲的信号不得具有超过 1 ms 的测试脉冲。时间更长的脉冲可能会导致伺服系统的可用性降低。

8.6.1 保护措施

在符合 IEC 60529 标准的防护等级至少为 IP54 的机柜或同等环境中安装 MSD 510  系统组件。某些应用可能要求更高的
IP 防护等级。

如果电机轴受到外力的影响（比如悬挂负载），则须采取额外措施（比如安全夹持制动）来避免危险。
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8.7 应用示例
图解 112 中示出了一个可通过安全电路置于 Safe Torque Off 模式的应用的例子。

按照应用要求选择安全开关装置。

+24 VDC

GND

e
3

0
b

g
2

7
3

.1
0

8a

8b

53

42

1

X1

X2

X1

X2

9

7

6

图解 112: 应用示例： Safe Torque Off 功能

1 24 V 直流电源

2 安全装置

3 紧急停止按钮

4 安全装置触点

5 分布式访问模块 (DAM)

6 混合电缆

7 馈电电缆

8a/8b 伺服驱动器

9 环路电缆

8.8 启用测试

注 意

安装 STO 功能后、每次对安装的功能进行更改后或出现安全故障后，对整个伺服系统执行启用测试。

可通过两种方法实施启用测试，具体取决于用于对 PLC 进行编程的方法，但是，测试步骤是相同的：

使用 Danfoss  库或 TwinCAT® 库。

状态的位读数。

8.8.1 使用库进行启用测试
根据具体应用，需要使用以下库的一个或两个来设置启用测试：

Danfoss  库

MC_ReadAxisInfo_DDS

MC_ReadStatus_DDS

MC_ReadAxisError_DDS

MC_Reset_DDS

TwinCAT® 库
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MC_ReadStatus

MC_ReadAxisError

MC_Reset

表 30: 使用库进行启用测试

测试步骤 执行该测试步骤
的原因

Danfoss  库的预期结果 TwinCAT® 库的预期结果

1 运行应用程序（所有伺服
驱动器都已启用）。

检查应用程序能
否运行。

应用程序按预期运行。 应用程序按预期运行。

2 停止应用程序。 – 所有伺服驱动器的速度都达到 0 RPM。 所有伺服驱动器的速度都达
到 0 RPM。

3 禁用所有伺服驱动器。 – 所有伺服驱动器都将被禁用。 所有伺服驱动器都将被禁
用。

4 启用 STO。 检查能否在不出
现错误的情况下
激活 STO。

对于对应线路上的所有伺服驱动器，
MC_ReadAxisInfo_DDS 输出 SafeTor‐

queOff = True（真）。

–

5 禁用 STO。 检查能否在不出
现错误的情况下
禁用 STO。无需
复位。

对于对应线路上的所有伺服驱动器，
MC_ReadAxisInfo_DDS 输出 SafeTor‐

queOff = False（假）。

–

6 运行应用程序（所有伺服
驱动器都已启用）。

– 应用程序按预期运行。 应用程序按预期运行。

7 启用 STO。 检查能否在伺服
驱动器运行过程
中激活 STO 时正
确生成错误。

电机无转矩。电机在一段时间后惯性停
止。

MC_ReadAxisInfo_DDS 输出 SafeTor‐

queOff = True（真）

且

MC_ReadStatus_DDS 输出 ErrorStop =

True（真）

且

在所有启用的伺服驱动器上，MC_Read‐

AxisError_DDS 输出 AxisErrorID =

0xFF80。

电机无转矩。电机在一段时
间后惯性停止。

对于启用的电机：

MC_ReadStatus output

ErrorStop = True（真）

且

在所有启用的伺服驱动器
上，MC_ReadAxisError

output AxisErrorID =

0xFF80。

8 尝试运行应用程序（启用
1 个或多个伺服驱动
器）。

检查 STO 功能的
运行是否正常。

应用程序未运行。 应用程序未运行。

9 禁用 STO。 检查错误信号是
否仍禁止 STO 启
动。

MC_ReadAxisInfo_DDS 输出 SafeTor‐

queOff = False（假）

且

MC_ReadStatus_DDS 输出 ErrorStop =

True（真）

MC_ReadStatus output

ErrorStop = True（真）

10 尝试运行应用程序（启用
1 个或多个伺服驱动
器）。

检查是否需要复
位。

应用程序未运行。 应用程序未运行。

11 通过 MC_Reset(_DDS)

发送复位信号。

– MC_ReadAxisInfo_DDS 输出 SafeTor‐

queOff = False（假）

且

MC_ReadStatus output

ErrorStop = False（假）
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测试步骤 执行该测试步骤
的原因

Danfoss  库的预期结果 TwinCAT® 库的预期结果

MC_ReadStatus_DDS 输出 ErrorStop =

False（假）

12 尝试运行应用程序（所有
伺服驱动器都已启用）。

– 应用程序按预期运行。 应用程序按预期运行。

8.8.2 使用 PROFINET® 设备执行启用测试
表 31: 使用 PROFINET® 设备执行启用测试

测试步骤 执行该测试步骤的原因 预期结果

1 运行应用程序（所有伺服驱动器都
已启用）。

检查应用程序能否运行。 应用程序按预期运行。

2 停止应用程序。 – 所有伺服驱动器的速度都达到 0 RPM。

3 禁用所有伺服驱动器。 – 所有伺服驱动器都将被禁用。

4 启用 STO。 检查能否在不出现错误的情况
下激活 STO。

未出现错误。成功激活 STO 可通过检查设备上
的 LED 来确认。

5 禁用 STO。 检查能否在不出现错误的情况
下禁用 STO。无需复位。

未出现错误。STO 状态可通过检查设备上的 LED
来确认。

6 运行应用程序（所有伺服驱动器都
已启用）。

– 应用程序按预期运行。

7 启用 STO。 检查能否在伺服驱动器运行过
程中激活 STO 时正确生成错
误。

电机无转矩。电机在一段时间后惯性停止。

所有伺服驱动器上的对象 0x603F 中显示出错误
0x11E。

8 尝试运行应用程序（启用 1 个或
多个伺服驱动器）。

检查 STO 功能的运行是否正
常。

应用程序未运行。

9 禁用 STO。 检查错误信号是否仍禁止 STO
启动。

所有伺服驱动器上的对象 0x603F 中显示出错误
0x11E。

10 尝试运行应用程序（启用 1 个或
多个伺服驱动器）。

检查是否需要复位。 应用程序未运行。

11 通过 PLC 发送复位信号。 – 所有伺服驱动器中的 STO 错误 0x11E 都将被清
除。

12 尝试运行应用程序（所有伺服驱动
器都已启用）。

– 应用程序按预期运行。

8.9 STO 功能的操作
STO 功能无需任何参数化，始终启用。

伺服驱动器模块 (SDM 511/512) 通过现场总线提供 STO 状态信号。

通过现场总线传输的所有信号都不是安全功能的一部分，只能用于操作目的。

请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 编程指南了解：

有关如何访问和映射数据对象的一般信息。

有关为了简化现场总线功能的使用而提供的库的信息。
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如果在禁用伺服驱动器后激活 STO，且未尝试在激活 STO 后启用伺服驱动器，则不必在对 STO 端子重新加电后复位 STO 功
能。

如果在启用伺服驱动器后激活 STO，则将发出错误代码。

8.9.1 错误代码
如果设置了状态字的位 3，则表示伺服驱动器上出错。如果由于 STO 电路而出错，则可在对象 0x603F 中找到错误原因。

表 32: 错误代码

错误代码 PROFINET® 错误
代码

类别 说明 复位

0xFF80 0x11E 故障 启用伺服驱动器后激活 STO，或尝试在激活 STO 后启用伺服
驱动器。

通过 PLC 复位。

0xFF81 0x11F 安全故障 伺服驱动器内部诊断故障。 执行重启。

0xFF85 0x120 安全故障 功率卡上的内部 STO 电源不在限值内。 执行重启。

错误代码 0xFF80/0x11E 可能是应用的正常状态。在此情况下，伺服驱动器需要从 PLC 获得复位信号。要在需要使用控制防
护的应用中使用 STO 功能（请参阅 ISO 12100 了解详细信息），可由 PLC 自动提供此复位信息。同一线路上的所有伺服驱动
器将同时显示出此错误。在 PLC 上进行检查以比较一条线路上的所有伺服驱动器的错误。

错误代码 0xFF81/0x11F 表示伺服驱动器上出错，只能通过执行重启来复位。重启后将完成启用测试。仅当成功完成测试后，
伺服系统才能继续运行。如果再次报告错误代码 0xFF81/0x11F 或 0xFF85/0x120，则联系 Danfoss  服务部门。

8.9.2 故障复位
要复位故障，将控制字的位 7 从 0 更改为 1。请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 编程指南，了

解更多信息。

8.10 功能安全特性数据
表 33: 功能安全特性数据

数据 PSM 510 SDM 511 SDM 512 DAM 510

一般信息

响应时间（从打开输入直到转矩生成被禁用） <100 ms

使用寿命 20 年

EN/ISO 13849-1 的数据

性能等级 (PL) – d d –

类别 – 3 3 –

平均无危险故障时间 (MTTFD) – >5000 年 >5000 年(1) –

诊断覆盖率 (DC) – 60% 60% –

EN/ISO 61508 和 EN/IEC 62061 的数据

安全完整性级别 (SIL) – 2 2 –

单位小时的危险故障几率 (PFH) 0 /h <4 x 10-9/h <4 x 10-9/h 0 /h

安全故障率 (SFF) 100% >95% >95% 100%

子系统类别 类型 A
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数据 PSM 510 SDM 511 SDM 512 DAM 510

功能测试间隔 1 年

1 对于每个轴。

注 意

PSM 510、DAM 510 和 ACM 510 不会影响 Danfoss  系统的危险故障率，因此，可从与安全相关的计算中排除。

8.11 维护、安全性和用户可访问性
维护： 每年对 STO 安全功能至少执行一次测试，如下所述：

断开 STO 输入电压。

检查电机是否停止运行。

检查是否出现异常错误代码。

安全性： 如果存在安全风险，则采取适当措施来防止。

用户可访问性： 如果对 ISD 510/DSD 510 伺服驱动器和其他系统组件的访问会导致安全风险，则限制对它们的访问。
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9 诊断

9.1 故障
如果在 MSD 510  系统操作过程中出现故障，则检查：

伺服驱动器、伺服驱动器模块 SDM 511/SDM 512 和 ACM 510 上的 LED 用于指示与通信或设备状态相关的一般问题。

PSM 510 和 DAM 510 上的 LED 用于指示与通信、辅助电源或 STO 电压相关的一般性问题。

错误代码。

可使用 VLT® Servo Toolbox 软件、LCP 或 PLC 读取错误代码。LCP 仅显示出与它所连接的设备相关的故障。

注 意

如果无法使用故障排查表中列出的措施之一清除故障，则通知 Danfoss  服务部门。

准备好以下信息，以便 Danfoss  快速有效地提供帮助：

型号

错误代码

固件版本

系统设置（例如，伺服驱动器、系统模块和线路的数量）。

出现故障时的系统状态。

环境条件。

9.2 故障排查

9.2.1 伺服驱动器模块 SDM 511/SDM 512 故障排查

9.2.1.1 驱动器不运行/启动慢
可能原因

轴承磨损。

参数设置不正确。

控制环路参数错误

转矩设置不正确。

故障排查

检查轴承和主轴。

检查参数设置。

9.2.1.2 驱动器发出嗡嗡声且消耗高电流
可能原因

驱动器故障。

故障排查

联系 Danfoss。

9.2.1.3 驱动器突然停机，无法重启。
可能原因

与驱动器之间无通讯。

驱动器处于错误模式。

故障排查

检查驱动器的现场总线连接及 LED 指示灯。
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9.2.1.4 电机旋转方向错误
可能原因

镜像模式已激活。

故障排查

检查参数设置。

9.2.1.5 电机无法产生期望的转矩
可能原因

驱动器故障。

参数错误。

故障排查

检查参数设置。

联系 Danfoss。

9.2.1.6 驱动器发出尖啸声
可能原因

校准不正确。

电流测量故障。

控制环路参数错误

故障排查

检查参数设置。

联系 Danfoss。

9.2.1.7 运行不平稳
可能原因

轴承失灵。

故障排查

检查主轴。

9.2.1.8 振动
可能原因

轴承失灵。

控制环路参数错误

故障排查

检查主轴。

检查参数设置。

9.2.1.9 异常运行噪音
可能原因

轴承失灵。

连接的机械装置有故障。

控制环路参数错误

故障排查

检查主轴。

检查连接的机械装置中是否有机械部件松脱。

检查参数设置。
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9.2.1.10 驱动器速度突降至欠载状态
可能原因

驱动器在极限电流情况下运行。

驱动器在参数不正确的情况下运行。

故障排查

检查应用程序。

检查参数设置。

9.2.1.11 制动不松开
可能原因

制动控制有故障。

机械制动参数不正确。

故障排查

检查参数设置。

联系 Danfoss。

9.2.1.12 夹持制动而不夹持伺服驱动器
可能原因

机械制动故障。

主载负载超出制动的保持转矩。

故障排查

联系 Danfoss。

9.2.1.13 制动接合延迟
可能原因

软件错误。

故障排查

联系 Danfoss。

9.2.1.14 断电制动接合时发出噪音
可能原因

机械制动已坏。

故障排查

联系 Danfoss。

9.2.1.15 LED 指示灯不亮
可能原因

无电源。

故障排查

检查电源。

9.2.1.16 驱动器立即出现保护跳闸
可能原因

电路。

控制环路参数错误

故障排查

检查接线。

联系 Danfoss。
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9.2.2 伺服系统故障排查

9.2.2.1 LCP 黑屏/无法使用
ISD 510/DSD 510 伺服驱动器、SDM 511/SDM 512 伺服驱动器模块、PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

可能原因

无输入电源。

熔断器缺失或开路，或者断路器跳闸。

LCP 无电。

对比度设置错误。

显示屏存在缺陷。

故障排查

表 34: 错误, LCP 黑屏/无法使用

可能原因 可能解决方案

无输入电源。 检查输入电源。

熔断器缺失或开路，或者断路器跳闸。 检查熔断器和断路器。

LCP 无电。 检查 LCP 电缆是否正确连接或是否损坏。

更换有问题的 LCP 电缆或连接电缆。

对比度设置错误。 按 [Status]（状态）+ [▵]/[▿] 可调整对比度。

显示屏存在缺陷。 更换有问题的 LCP 电缆或连接电缆。

9.2.2.2 电源熔断器开路或断路器跳闸
PSM 510 和 DAM 510 可能会出现此错误。

可能原因

相到相短路。

背部链路出现短路。

SDM 511/SDM 512 输出短路

混合电缆短路。

EXM 510 连接器或电缆短路。

故障排查

检查接线

检查有无松脱的连接。

9.2.2.3 直流回路电压过高（错误 0x3210/0x103）
PSM 510 可能会出现此错误。

可能原因

没有连接制动电阻器。

制动电阻器电阻过高。

制动电阻器功能未被激活。

多个伺服驱动器的减速斜坡时间不足。
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制动电阻器配置错误。

主电源电压超出范围。

故障排查

表 35: 错误, 直流回路电压过高

可能原因 可能解决方案 适用于：

没有连接制动电阻器。 检查制动电阻器接线。 PSM 510

制动电阻器电阻过高。 检查是否已输入昀低电阻值。 PSM 510

制动电阻器功能未被激活。 激活制动功能。 PSM 510

多个伺服驱动器的减速斜坡时间不足。 避免多个伺服驱动器同时减速。

更改减速速度。

DAM 510、PSM 510、ISD 510/DSD 510 伺服驱动
器，SDM 511/SDM 512 伺服驱动器模块

主电源电压超出范围 检查主电源电压和接线。

9.2.2.4 直流回路电压过低（错误 0x3220/0x104）
所有系统模块都可能会出现此错误。

可能原因

主电源的输入电源错误。

故障排查

检查电源电压是否符合允许的规格。

9.2.2.5 直流回路过电流（错误 0x2396/0x15C）
PSM 510 和 DAM 510 可能会出现此错误。

可能原因

伺服驱动器电流总和超过 DAM 510 的昀大额定值。

系统模块的电流总和超过 PSM 510 的昀大额定值。

背部链路出现短路。

故障排查

检查伺服驱动器电流消耗。

避免所有伺服驱动器同时加速。

降低加速值。

9.2.2.6 直流回路过功率（错误 0x2313/0x161）
PSM 510 可能会出现此错误。

可能原因

PSM 510 在超过额定功率 140% 的情况下工作了太长时间。

故障排查

检查电流消耗情况。

9.2.2.7 PT 功率过载（错误 0x2314/0x162）
PSM 510 可能会出现此错误。

可能原因

PSM 510 在功率达到额定值的 100–140% 的情况下工作了太长时间。

故障排查

检查电流消耗情况。

9.2.2.8 UAUX 过电流（错误 0x2391/0x125）
DAM 510 可能会出现此错误。
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可能原因

伺服驱动器在 UAUX 线路上消耗的功率超过允许的值。

故障排查

参考 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 设计指南中的壳层图，查看连接的伺服驱动器的数量。

避免同时起吊伺服驱动器制动器。

9.2.2.9 UAUX 过电压（错误 0x3292/0x133）
DAM 510 可能会出现此错误。

可能原因

UAUX 电源错误。

故障排查

检查电源是否符合辅助电源要求。

9.2.2.10 UAUX 欠压（错误 0x3294/0x135）
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

可能原因

UAUX 电源错误。

电源设备的电流大小错误。

故障排查

检查电源是否符合辅助电源要求。

检查电源的输出功率是否足够。

9.2.2.11 主电源缺相（错误 0x3130/0x12F）
PSM 510 可能会出现此错误。

可能原因

供电侧存在相位丢失现象。

电压严重失衡。

故障排查

检查设备的供电电压和电流。

9.2.2.12 接地故障
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

可能原因

接地故障。

并联安装 2 个 PSM510 模块时，超过加电的昀长延迟时间（请参阅 6.7 加电时间）。

故障排查

检查是否正确接地并且接地线路是否松脱。

检查混合电缆是否发生短路或存在泄漏电流。

检查 EXM 510 连接和电缆。

9.2.2.13 制动电阻器出错
PSM 510 可能会出现此错误。

可能原因

制动电阻器出现故障。

未连接内部/外部制动电阻器。

故障排查

切断设备电源，等待放电时间过去，然后更换制动电阻器。
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9.2.2.14 制动斩波器出错
PSM 510 可能会出现此错误。

可能原因

制动斩波器出错。

制动斩波器的功率超过功率循环限制。

参数化错误。

故障排查

检查制动斩波器的参数化。

检查制动斩波器连接。

测量制动斩波器的电阻并将它与参数设置进行比较。

9.2.2.15 内部风扇出错
PSM 510 和 SDM 511/SDM 512 可能会出现此错误。

可能原因

未安装风扇。

风扇堵塞。

故障排查

检查风扇是否堵塞。

检查风扇电缆是否正确连接或是否损坏。

9.3 错误代码

9.3.1 无错误 (0x0000 / 0x0)
此错误代码对 PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 有效。

表 36: 无错误 (0x0000 / 0x0)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x0000 0x0 无错误 错误 无错误。 -

9.3.2 一般性错误 (0x1000 / 0x100)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 37: 一般性错误 (0x1000 / 0x100)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x1000 0x100 一般性应用错误 错误 一般性应用错误。 generic err

9.3.3 输出端过电流 (0x2310 / 0x101)
SDM 511/SDM 512 可能会出现此错误。

表 38: 输出端过电流 (0x2310 / 0x101)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2310 0x101 输出端过电流 错误 输出端过电流。 overcurr out

9.3.4 高电流过载 (0x2311 / 0x15F)
DAM 510 和 SDM 511/SDM 512 可能会出现此错误。
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表 39: 高电流过载 (0x2311 / 0x15F)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2311 0x15F 高电流过载 错误 高电流过载错误。 High curr ovld

9.3.5 I2T 电流过载 (0x2312 / 0x160)
DAM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 40: I2T 电流过载 (0x2312 / 0x160)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2312 0x160 I2T 电流过载 错误 I2T 电流过载错误。 IIT curr ovld

9.3.6 高功率过载 (0x2313 / 0x161)
PSM 510 可能会出现此错误。

表 41: 高功率过载 (0x2313 / 0x161)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2313 0x161 高功率过载 警告, 错误 高功率过载错误。 High pwr ovld

9.3.7 PT 功率过载 (0x2314 / 0x162)
PSM 510 可能会出现此错误。

表 42: PT 功率过载 (0x2314 / 0x162)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2314 0x162 PT 功率过载 警告, 错误 PT 功率过载错误。 pt pwr ovld

9.3.8 短路 (0x2320 / 0x163)
PSM 510 和 ACM 510 可能会出现此错误。

表 43: 短路 (0x2320 / 0x163)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2320 0x163 短路 跳闸锁定 直流过电流短路错误。 DC over curr

9.3.9 接地漏电 (0x2330 / 0x151)
PSM 510、DAM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 44: 接地漏电 (0x2330 / 0x151)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2330 0x151 接地漏电 警告, 错误 电流泄漏到接地线。 接地漏电

9.3.10 辅助线路过电流 (0x2391 / 0x125)
DAM 510 可能会出现此错误。
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表 45: 辅助线路过电流 (0x2391 / 0x125)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x2391 0x125 辅助线路过电流 错误 辅助线路上的电流已达到过电
流极限。

AUX overcurr

9.3.11 辅助线路用户限制电流 (0x2393 / 0x127)
DAM 510 可能会出现此错误。

表 46: 辅助线路用户限制电流 (0x2393 / 0x127)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x2393 0x127 辅助线路用户限制
电流

错误 辅助线路上的电流已达到用户定
义的故障极限。

AUX curr
limit

9.3.12 辅助线路用户限制电流警告 (0x2394 / 0x128)
PSM 510 和 ACM 510 可能会出现此错误。

表 47: 辅助线路用户限制电流警告 (0x2394 / 0x128)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x2394 0x128 辅助线路用户限制电
流警告

警告 辅助线路上的电流已达到用户定
义的警告极限。

AUX curr
warn

9.3.13 辅助线路熔断器出错 (0x2395 / 0x129)
DAM 510 可能会出现此错误。

表 48: 辅助线路熔断器出错 (0x2395 / 0x129)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x2395 0x129 辅助线路熔断器
出错

错误 熔断器出错。辅助线路上的电流
或电压超出极限。

AUX fuse
fail

9.3.14 直流过电流跳闸 (0x2396 / 0x15C)
DAM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 49: 直流过电流跳闸 (0x2396 / 0x15C)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2396 0x15C 直流过电流跳闸 错误 直流过电流跳闸。 overcurr trip

9.3.15 输出功率跳闸 (0x2397 / 0x12B)
PSM 510 可能会出现此错误。

表 50: 输出功率跳闸 (0x2397 / 0x12B)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x2397 0x12B 输出功率跳闸 错误 超过设备的峰值输出功率。 Out pow

9.3.16 电机 I2T 过载 (0x239B / 0x102)
SDM 511/SDM 512 可能会出现此错误。
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表 51: 短路 (0x239B / 0x102)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x239B 0x102 电机 I2T 过载 警告, 错误 电机 I2T 过载错误。 IIT ovld motor

9.3.17 主电源缺相 (0x3130 / 0x12F)
PSM 510 可能会出现此错误。

表 52: 主电源缺相 (0x3130 / 0x12F)

代码 PROFINET© 代
码

名称 严重程度（警告/错
误/跳闸锁定）

说明 LCP 名称

0x3130 0x12F 主电源缺
相

错误 检测到主电源缺相。

当主电源上的相位缺失或主电源不平衡时，会
出现此情况。

phase loss

9.3.18 直流回路过电压 (0x3210 / 0x103)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 53: 直流回路过电压 (0x3210 / 0x103)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3210 0x103 直流回路过电压 错误 直流回路电压超过极限。 UDC overvolt

9.3.19 软件过电流跳闸 (0x3210 / 0x103)
SDM 511/SDM 512 可能会出现此错误。

表 54: 软件过电流跳闸 (0x3210 / 0x103)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3210 0x103 软件过电流跳闸 错误 直流回路电压超过极限。 UDC overvolt

9.3.20 直流回路欠压 (0x3220 / 0x104)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 55: 直流回路欠压 (0x3220 / 0x104)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x3220 0x104 直流回路欠
压

错误 低于限值的直流回路电压处于 Operation

enabled（允许运行）状态。

UDC 欠压

9.3.21 UDC 充电错误 (0x3230 / 0x152)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 56: UDC 充电错误 (0x3230 / 0x152)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/跳
闸锁定）

说明 LCP 名称

0x3230 0x152 UDC 充电错
误

错误 已超过为直流回路充电的昀长
时间限制。

UDC charging
err

9.3.22 直流回路电压不平衡 (0x3280 / 0x153)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。
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表 57: 直流回路电压不平衡 (0x3280 / 0x153)

代码 PROFINET© 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x3280 0x153 直流回路电压不平
衡

跳闸锁定 直流回路电压不平
衡。

DC link unbal

9.3.23 UAUX 电压过高 (0x3291 / 0x132)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 58: UAUX 电压过高 (0x3291 / 0x132)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3291 0x132 UAUX 电压过高 警告 UAUX 超过警告极限。 UAUX high volt

9.3.24 UAUX 过电压 (0x3292 / 0x133)
DAM 510 可能会出现此错误。

表 59: UAUX 过电压 (0x3292 / 0x133)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3292 0x133 UAUX 过电压 错误 UAUX 超过过电压极限。 UAUX overvolt

9.3.25 UAUX 电压过低 (0x3293 / 0x134)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 60: UAUX 电压过低 (0x3293 / 0x134)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3293 0x134 UAUX 电压过低 警告 UAUX 低于警告极限。 UAUX low volt

9.3.26 UAUX 欠压 (0x3294 / 0x135)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 61: UAUX 欠压 (0x3294 / 0x135)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x3294 0x135 UAUX 欠压 错误 UAUX 低于欠压极限。 UAUX undervolt

9.3.27 UDC 电压过高 (0x3295 / 0x136)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 62: UDC 电压过高 (0x3295 / 0x136)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x3295 0x136 UDC 电压过高 警告 直流回路电压高于高压警告极
限。

UDC high volt

9.3.28 UDC 电压过低 (0x3296 / 0x137)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。
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表 63: UDC 电压过低 (0x3296 / 0x137)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x3296 0x137 UDC 电压过低 警告 直流回路电压低于低压警告极
限。

UDC low volt

9.3.29 UAUX 充电错误 (0x3297 / 0x154)
DAM 510 可能会出现此错误。

表 64: UAUX 充电错误 (0x3297 / 0x154)

代码 PROFINET® 代
码

名称 严重程度（警告/错
误/跳闸锁定）

说明 LCP 名称

0x3297 0x154 UAUX 充电错

误

错误 当 UAUX 正在充电时出现加载错误。已超过

为辅助线路充电的昀长时间限制。

UAUX charg
err

9.3.30 UDC 关闭错误 (0x3298 / 0x165)
DAM 510 可能会出现此错误。

表 65: UDC 关闭错误 (0x3298 / 0x165)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x3298 0x165 UDC 关闭错误 错误 当 UDC 处于关闭阶段时出
错。

UDC shutdwn err

9.3.31 UAUX 关闭错误 (0x3299 / 0x155)
DAM 510 可能会出现此错误。

表 66: UAUX 关闭错误 (0x3299 / 0x155)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x3299 0x155 UAUX 关闭错误 错误 当 UAUX 处于关闭阶段时出

错。

UAUX shtdwn err

9.3.32 UAUX 欠压硬件 (0x329A / 0x156)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 67: UAUX 欠压硬件 (0x329A / 0x156)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x329A 0x156 UAUX 欠压硬件 错误 硬件电路检测到 UAUX 欠

压。

AUX undervol HW

9.3.33 自动故障复位出错 (0x329B / 0x168)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。
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表 68: 自动故障复位出错 (0x329B / 0x168)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/跳
闸锁定）

说明 LCP 名称

0x329B 0x168 自动故障复位出
错

跳闸锁定 在原定时间间隔内，执行了太多次
自动故障复位。

afr failure

9.3.34 设备温度过高 (0x4210 / 0x157)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 69: 设备温度过高 (0x4210 / 0x157)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/跳
闸锁定）

说明 LCP 名称

0x4210 0x157 设备温度过
高

警告, 错误 超过主设备组件的昀高温度时触发。

PSM： 可控硅整流器模块。

DAM： 高侧和低侧 IGBT 的昀高温度。

overtemp de‐
vice

9.3.35 温度过低 (0x4220 / 0x138)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 70: 温度过低 (0x4220 / 0x138)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x4220 0x138 温度过低 错误 设备温度过低，无法运行。 low temp device

9.3.36 温度过高： 电源模块 (0x4290 / 0x105)
SDM 511/SDM 512 可能会出现此错误。

表 71: 温度过高： 电源模块 (0x4290 / 0x105)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x4290 0x105 温度过高： 电源模块 错误 电源模块上温度过高。 overtemp PM

9.3.37 温度过高： 控制卡 (0x4291 / 0x106)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 72: 温度过高： 控制卡 (0x4291 / 0x106)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x4291 0x106 温度过高： 控制卡 错误 超过控制卡的昀高温度。 overtemp CC

9.3.38 温度过高： 功率卡 (0x4292 / 0x107)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 73: 温度过高： 功率卡 (0x4292 / 0x107)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x4292 0x107 温度过高： 功率卡 警告, 错误 超过功率卡的昀高温度。 overtemp PC
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9.3.39 浪涌导致温度过高： 直流回路 (0x4293 / 013C)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 74: 浪涌导致温度过高： 直流回路 (0x4293 / 0x13C)

代码 PROFINET®

代码
名称 严重程度（警告/错

误/跳闸锁定）
说明 LCP 名称

0x4293 0x13C 浪涌导致温度过高：
直流回路

错误 浪涌电流冲击故障。

短时间内太多次转换到状态 Operation

enabled（允许运行）。

inrush
UDC

9.3.40 AUX 线路浪涌导致温度过高 (0x4294 / 0x13D)
DAM 510 可能会出现此错误。

表 75: AUX 线路浪涌导致温度过高 (0x4294 / 0x13D)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x4294 0x13D AUX 线路浪涌导致
温度过高

错误 浪涌电流冲击故障。

短时间内 AUX 电压的上电次数太
多。

inrush
UAUX

9.3.41 温度过高： 电机 (0x4310 / 0x108)
SDM 511/SDM 512 可能会出现此错误。

表 76: 温度过高： 电机 (0x4310 / 0x108)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x4310 0x108 温度过高： 电机 错误 电机温度过高。 overtemp motor

9.3.42 UAUX 欠压 (0x5112 / 0x109)
SDM 511/SDM 512 可能会出现此错误。

表 77: 短路 (0x5112 / 0x109)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x5112 0x109 UAUX 欠压 错误, 跳闸锁定 辅助电压欠压。 undervolt UAUX

9.3.43 充电开关故障电压 (0x5121 /0x158)
PSM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 78: 充电开关故障电压 (0x5121 / 0x158)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x5121 0x158 充电开关故障电
压

跳闸锁定 指示内部充电电路出现
故障。

Chg switch
fail

9.3.44 EE 校验和错误（参数缺失）(0x5530 / 0x10A)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。
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表 79: EE 校验和错误（参数缺失）(0x5530 / 0x10A)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x5530 0x10A EE 校验和错误（参数
缺失）

跳闸锁定 内部设备配置中缺失参
数。

config err

9.3.45 参数错误 (0x6320 / 0x10B)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 80: 参数错误 (0x6320 / 0x10B)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x6320 0x10B 参数错误 跳闸锁定 参数值无效。 param err

9.3.46 配置参数版本错误 (0x6382 / 0x15D)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 81: 配置参数版本错误 (0x6382 / 0x15D)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/跳
闸锁定）

说明 LCP 名称

0x6382 0x15D 配置参数版本
错误

跳闸锁定 配置参数集版本不匹配： 参数集
对此设备无效。

conf par
ver

9.3.47 配置参数限值错误 (0x6383 / 0x164)
PSM 510、DAM 510 和 ACM 510 可能会出现此错误。

表 82: 配置参数限值错误 (0x6383 / 0x164)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x6383 0x164 配置参数限值
错误

跳闸锁定 配置参数集中的 1 个或多个参数超出极
限： 该参数集对此设备无效。

conf par
lim

9.3.48 功率 EEprom 配置错误 (0x6384 / 0x166)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 83: 功率 EEprom 配置错误 (0x6384 / 0x166)

代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x6384 0x166 功率 EEprom 配置
错误

跳闸锁定 功率设备 Eeprom 损坏或与此控
制板不兼容。

conf par EE‐
PROM

9.3.49 制动斩波器出错 (0x7111 / 0x141)
PSM 510 可能会出现此错误。

表 84: 制动斩波器出错 (0x7111 / 0x141)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x7111 0x141 制动斩波器出
错

警告, 错误 运行过程中监测制动斩波器。

制动检查功能已检测到制动错误。

brake ch
fail
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9.3.50 制动斩波器过电流 (0x7112 / 0x167)
PSM 510 可能会出现此错误。

表 85: 制动斩波器过电流 (0x7112 / 0x167)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x7112 0x167 制动斩波器过电
流

跳闸锁定 制动斩波器电流超过极
限。

brake ch over‐
curr

9.3.51 制动电阻器昀大功率极限 (0x7181 / 0x142)
PSM 510 可能会出现此错误。

表 86: 制动电阻器昀大功率极限 (0x7181 / 0x142)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x7181 0x142 制动电阻器昀大功率
极限

警告, 错误 超过制动电阻器昀大功率
极限。

brake pwr
lim

9.3.52 制动电阻器用户功率极限 (0x7182 / 0x143)
PSM 510 可能会出现此错误。

表 87: 制动电阻器用户功率极限 (0x7182 / 0x143)

代码 PROFI-

NET® 代
码

名称 严重程度
（警告/错误/

跳闸锁定）

说明 LCP 名称

0x7182 0x143 制动电阻
器用户功
率极限

警告, 错误 超过制动电阻器功率极限。

传输给制动电阻器的功率是按昀近 300 秒钟运行时间内的平均
值来计算的。

-该计算基于直流回路电压以及在参数 2-16 (Brake resistor

power 300 s)（制动电阻 300 秒功率）中设置的制动电阻值。

当在 300 秒内超过该值时，将报告此错误。

brake
usr pwr
lim

9.3.53 制动电压过高 (0x7183 / 0x159)
PSM 510 可能会出现此错误。

表 88: 制动电压过高 (0x7183 / 0x159)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x7183 0x159 制动电压过高 警告 制动电阻器电压过高。 brake volt high

9.3.54 内部位置传感器错误 (0x7320 / 0x10C)
SDM 511/SDM 512 可能会出现此错误。

表 89: 内部位置传感器错误 (0x7320 / 0x10C)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0x7320 0x10C 内部位置传感器错
误

跳闸锁定 绝对位置传感器错
误。

int sensor err

9.3.55 外部位置传感器错误 (0x7380 / 0x10D)
DAM 510 和 SDM 511/SDM 512 可能会出现此错误。
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表 90: 外部位置传感器错误 (0x7380 / 0x10D)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0x7380 0x10D 外部位置传感器错
误

错误 无法读取外部编码器数
据。

ext sensor err

9.3.56 跟随性错误 (0x8611 / 0x10E)
SDM 511/SDM 512 可能会出现此错误。

表 91: 跟随性错误 (0x8611 / 0x10E)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x8611 0x10E 跟随性错误 警告, 错误 出现跟随性错误。 following err

9.3.57 进入归位模式时出现归位错误 (0x8693 / 0x10F)
SDM 511/SDM 512 可能会出现此错误。

表 92: 进入归位模式时出现归位错误 (0x8693 / 0x10F)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0x8693 0x10F 进入归位模式时出现归
位错误

警告 无法进入归位模式（例如，
速度不为 0）。

Homing mode
fail

9.3.58 启动归位方法时出现归位错误 (0x8694 / 0x110)
SDM 511/SDM 512 可能会出现此错误。

表 93: 启动归位方法时出现归位错误 (0x8694 / 0x110)

代码 PROFINET® 代
码

名称 严重程度（警告/错
误/跳闸锁定）

说明 LCP 名称

0x8694 0x110 启动归位方法时出现
归位错误

警告 无法启动归位方法（例如，驱动
器未处于静止状态）。

Homing method
fail

9.3.59 归位错误距离 (0x8695 / 0x111)
SDM 511/SDM 512 可能会出现此错误。

表 94: 归位错误距离 (0x8695 / 0x111)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0x8695 0x111 归位错误距离 警告 已达到归位距离。 Homing distance

9.3.60 机械制动故障 (0xFF01 / 0x112)
SDM 511/SDM 512 可能会出现此错误。

表 95: 机械制动故障 (0xFF01 / 0x112)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF01 0x112 机械制动故障 跳闸锁定 无制动或线缆故障。 brake mech fail

9.3.61 机械制动控制中出现短路 (0xFF02 / 0x113)
SDM 511/SDM 512 可能会出现此错误。
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表 96: 机械制动控制中出现短路 (0xFF02 / 0x113)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0xFF02 0x113 机械制动控制中出现
短路

跳闸锁定 制动控制中出现短
路。

brake mech
short

9.3.62 外部接口电源故障 (0xFF0A / 0x114)
SDM 511/SDM 512 可能会出现此错误。

表 97: 外部接口电源故障 (0xFF0A / 0x114)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF0A 0x114 外部接口电源故障 错误 外部接口电源故障。 ext IF pwr fail

9.3.63 通信中断 (0xFF10 / 0x14F)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 98: 通信中断 (0xFF10 / 0x14F)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁
定）

说明 LCP 名称

0xFF10 0x14F 通信中断 错误 现场总线通信已在设备启用后中
断。

Comm interrupt

9.3.64 风扇反馈不一致 (0xFF21 / 0x145)
PSM 510 和 SDM 51x 可能会出现此错误。

表 99: 风扇反馈不一致 (0xFF21 / 0x145)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF21 0x145 风扇反馈不一致 警告 内部风扇故障。

内部风扇未在运行或未安装。

风扇反馈

9.3.65 风扇使用寿命到期 (0xFF22 / 0x15A)
PSM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 100: 风扇使用寿命到期 (0xFF22 / 0x15A)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0xFF22 0x15A 风扇使用寿命到期 警告 已超过风扇的理论使用寿
命。

fan lifetime

9.3.66 定时违规 1 (0xFF60 / 0x115)
SDM 511/SDM 512 可能会出现此错误。

表 101: 定时违规 1 (0xFF60 / 0x115)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF60 0x115 定时违规 1 跳闸锁定 联系 Danfoss。 timing err 1

9.3.67 定时违规 2 (0xFF61 / 0x116)
SDM 511/SDM 512 可能会出现此错误。
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表 102: 定时违规 2 (0xFF61 / 0x116)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF61 0x116 定时违规 2 跳闸锁定 联系 Danfoss。 timing err 2

9.3.68 定时违规 3 (0xFF62 / 0x117)
SDM 511/SDM 512 可能会出现此错误。

表 103: 定时违规 3 (0xFF62 / 0x117)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF62 0x117 定时违规 3 跳闸锁定 联系 Danfoss。 timing err 3

9.3.69 定时违规 4 (0xFF63 / 0x118)
SDM 511/SDM 512 可能会出现此错误。

表 104: 定时违规 4 (0xFF63 / 0x118)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF63 0x118 定时违规 4 跳闸锁定 联系 Danfoss。 timing err 4

9.3.70 定时违规 5 (0xFF64 / 0x119)
SDM 511/SDM 512 可能会出现此错误。

表 105: 定时违规 5 (0xFF64 / 0x119)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF64 0x119 定时违规 5 跳闸锁定 联系 Danfoss。 timing err 5

9.3.71 定时违规 6 (0xFF65 / 0x11A)
SDM 511/SDM 512 可能会出现此错误。

表 106: 定时违规 6 (0xFF65 / 0x11A)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF65 0x11A 定时违规 6 跳闸锁定 联系 Danfoss。 timing err 6

9.3.72 定时违规 7 (0xFF66 / 0x168)
SDM 511/SDM 512 可能会出现此错误。

表 107: 定时违规 7 (0xFF66 / 0x168)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF66 0x168 定时违规 7 跳闸锁定 联系 Danfoss。 timing err 7

9.3.73 定时违规 8 (0xFF67 / 0x16B)
SDM 511/SDM 512 可能会出现此错误。

表 108: 定时违规 8 (0xFF67 / 0x16B)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF67 0x16B 定时违规 8 跳闸锁定 联系 Danfoss。 timing err 8
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9.3.74 定时违规 9 (0xFF68 / 0x16C)
SDM 511/SDM 512 可能会出现此错误。

表 109: 定时违规 9 (0xFF68 / 0x16C)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF68 0x16C 定时违规 9 跳闸锁定 联系 Danfoss。 timing err 9

9.3.75 固件： 程序包描述不匹配 (0xFF70 / 0x11B)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 110: 固件： 程序包描述不匹配 (0xFF70 / 0x11B)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0xFF70 0x11B 固件： 程序包描述不
匹配

跳闸锁定 找到的固件与程序包描述
不匹配。

FW pack err

9.3.76 固件： 需要重启 (0xFF71 / 0x11C)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 111: 固件： 需要重启 (0xFF71 / 0x11C)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/跳闸
锁定）

说明 LCP 名称

0xFF71 0x11C 固件： 需要重启 警告, 错误 已完成传输固件更新，但需要重启才
能激活新固件。

需要重启

9.3.77 固件： 已开始更新 (0xFF72 / 0x11D)
PSM 510、DAM 510、ACM 510 和 SDM 511/SDM 512 可能会出现此错误。

表 112: 固件： 已开始更新 (0xFF72 / 0x11D)

代码 PROFINET®

代码
名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0xFF72 0x11D 固件： 已开始
更新

警告, 错误 正在进行固件更新。

在此状态下尝试启用设备时，将警告进行更
改会导致错误。

FW update

9.3.78 固件： 更新无效 (0xFF73 / 0x15B)
PSM 510 和 ACM 510 可能会出现此错误。

表 113: 固件： 更新无效 (0xFF73 / 0x15B)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0xFF73 0x15B 固件： 更新无效 错误 固件程序包的更新无效或已损坏。

已加载昀后有效的固件程序包。

FW upd invalid

9.3.79 启用驱动器后激活 STO (0xFF80 / 0x11E)
SDM 511/SDM 512 可能会出现此错误。
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表 114: 启用驱动器后激活 STO (0xFF80 / 0x11E)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/

跳闸锁定）
说明 LCP 名称

0xFF80 0x11E 启用驱动器后激
活 STO

错误 启用驱动器后激活 STO，或尝试在激
活 STO 后启用驱动器。

STO active

9.3.80 STO 不匹配 (0xFF81 / 0x11F)
SDM 511/SDM 512 可能会出现此错误。

表 115: STO 不匹配 (0xFF81 / 0x11F)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF81 0x11F STO 不匹配 跳闸锁定 STO 电压的双重诊断不可信。 STO 不匹配

9.3.81 P_STO 错误 (0xFF85 / 0x120)
SDM 511/SDM 512 可能会出现此错误。

表 116: P_STO 错误 (0xFF85 / 0x120)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF85 0x120 P_STO 错误 跳闸锁定 功率卡上的 P_STO 电压超过限
值。

P_STO 错误

9.3.82 指导值相反 (0xFF90 / 0x121)
SDM 511/SDM 512 可能会出现此错误。

表 117: 指导值相反 (0xFF90 / 0x121)

代码 PROFINET® 代
码

名称 严重程度（警告/错误/跳
闸锁定）

说明 LCP 名称

0xFF90 0x121 指导值相反 错误 当伺服驱动器处于 CAM 模式时，位置
指导值与此相反。

guide val
rev

9.3.83 指导值不可信 (0xFF91 / 0x122)
SDM 511/SDM 512 可能会出现此错误。

表 118: 指导值不可信 (0xFF91 / 0x122)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF91 0x122 指导值不可信 错误 后继值之间的增量太大。 guide val impl

9.3.84 运行迹象错误 (0xFF95 / 0x14E)
仅带有 PROFINET® 的 SDM 511/SDM 512 可能会出现此错误。

表 119: 运行迹象错误 (0xFF95 / 0x14E)

代码 PROFINET® 代码 名称 严重程度（警告/错误/跳闸锁定） 说明 LCP 名称

0xFF95 0x14E 运行迹象错误 错误 运行迹象错误。 SOL error
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10 维护、报废和处置

10.1 警告

警 告
高电压

连接器上存在可能致命的电压，这可能会导致严重伤亡。

在接触电源或信号连接器（断开或连接电缆）或执行任何维护工作之前，应将电源模块 (PSM 510) 与主电源断开，并等
待放电完毕。

警 告
放电时间

MSD 510  系统包含直流回路电容器，该电容器在电源模块 (PSM 510) 的主电源关闭后保持充电一段时间。如果切断电源后

在规定的时间结束之前就执行维护或修理作业，可能导致死亡或严重伤害。

为避免电击，将电源模块 (PSM 510) 与主电源完全断开，并等待电容器完全放电后，再在伺服系统或其组件上执行任何
维护或维修工作。

昀短等待时间（分钟）

15

10.2 维护任务
MSD 510  系统组件很大程度上不需要维护。

维护任务必须由具备相应资质的人员来完成。不需要执行任何其他任务。

表 120: 维护任务概述

组件 维护任务 维护时间间隔 说明

MSD 510  系统组件 执行目视检查。 每隔 6 个月 检查组件表面有无任何异常。

检查风扇。 每隔 12 个月 检查风扇能否转动并擦除所有灰尘或脏物。

功能安全 执行系统重启并检查 STO 功能。 每隔 12 个月 激活 STO 并检查 PLC 的运行状态。

10.3 运行期间的检查

10.3.1 系统组件
在运行期间执行定期检查。

检查：

冷却通风管是否阻塞。

风扇有无发出任何异常噪声。

电气线路和电缆的状况。

10.4 维修
务必联系当地的 Danfoss  销售公司，了解有关维修政策的信息。

10.5 系统组件更换

10.5.1 拆装系统组件

断开 PSM 510 的主电源和所有辅助电源，等待放电时间过去。

拔下电机反馈连接器（仅限 SDM511/SDM512）。

断开系统组件底部的 EMC 板的连接。请勿从 EMC 板上拆除连接器。
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图解 113: 断开 EMC 板的连接

拔下 RJ45 连接器 [2]（仅限 DAM 510）。

拧下 EMC 板上的螺钉 [4]。

按固定夹 [3] 松开 EMC 板。

拧下 PE 螺钉 [1]。

断开系统组件顶部的 I/O 屏蔽板的连接：

2

1

e
3

0
b

g
8

1
4

.1
0

图解 114: 断开 I/O 屏蔽板的连接

拔下顶部连接器 [1]。

拧下 I/O 屏蔽板 [2] 上的螺钉。

向上拉动 I/O 屏蔽板以拆除。

松开模块顶部的固定夹具。
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图解 115: 松开固定夹具

将模块向前倾斜，将它从背板上拆除。

X2
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STATUS PSM
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SVS ST

NET ST

LINK/ACT
LIN

S

X2

LCP

STATUS DAM
DEV

SVS ST
NET ST

AUX

LINK/ACT

X1

X1
X

X2

X3

X3

LCP

图解 116: 拆除模块

10.5.2 安装和调试系统组件
检查是否需要准备（请参阅 4.6.1 系统模块）。

安装系统模块（请参阅 4.7.3 系统模块安装说明）。

连接电气电缆（请参阅电气安装一章）。

打开系统（请参阅 6.9 打开 MSD 510 系统）。

AQ262450196490zh-000101 / 175R1170 | 159Danfoss A/S © 2019.10

维护、报废和处置

VLT® Multiaxis Servo Drive MSD 510 System

操作指南



5.

6.

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

1.

2.

3.

-

根据所用现场总线配置系统模块的参数（请参阅 6.4 EtherCAT® ID 分配、6.5 以太网 POWERLINK® ID 分配 和 6.6
PROFINET® ID 分配）。

执行试运行。

10.6 电缆更换

10.6.1 概述
当已达到额定弯曲次数或电缆损坏时，应更换电缆。

注 意

请勿强制连接或安装连接器。错误连接可能会对连接器造成永久损坏。

10.6.2 馈电电缆更换

10.6.2.1 断开馈电电缆的连接

操作步骤

断开电源模块 (PSM 510) 与电源（电网和所有辅助电源）的连接。

等待必需的放电时间。

断开连接到两个 ISD 510/DSD 510 伺服驱动器上的 X3、X4 或 X5 端口的任何电缆，方便对馈电电缆进行处理。

断开 PE 线缆与分布式访问模块 (DAM 510) 上的 PE 螺钉的连接。

断开以太网连接器的连接。

拆除分布式访问模块 (DAM 510) 上的 EMC 板。

打开固定 STO 电缆的电缆扎带。

打开将馈电电缆固定在分布式访问模块 (DAM 510) 上的电缆扎带。

拧松 DAM 510 上的馈电电缆连接器。

从 DAM 510 上断开馈电电缆的连接。

拧松伺服驱动器上连接器的螺纹环。

从伺服驱动器上断开馈电电缆的连接。

10.6.2.2 更换馈电电缆
使用具有相同类型和长度的电缆更换馈电电缆。请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 设计指南查看

部件号。

10.6.2.3 连接馈电电缆
将馈电电缆的母接头连接到第一个伺服驱动器的公接头。

用手将连接器的螺纹压圈拧紧。

确保电缆上无机械应力。

将馈电电缆插入分布式访问模块 (DAM 510) 底部的 EMC 板上的正确连接器。

使用电缆扎带固定馈电电缆。

使用电缆扎带固定 STO 电缆。

在 DAM 510 上安装 EMC 板。

将以太网连接器连接到 DAM 510。

将 PE 线缆连接到 DAM 510 上的 PE 螺钉。

重新连接以前连接到 X3、X4 或 X5 端口的任何电缆。

10.6.3 环路电缆更换

10.6.3.1 断开环路电缆的连接

操作步骤

断开电源模块 (PSM 510) 与电源（电网）和所有辅助电源的连接。

等待必需的放电时间。

断开连接到两个 ISD 510/DSD 510 伺服驱动器上的 X3、X4 或 X5 端口的任何电缆，方便对环路电缆进行处理。
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1.



2.

拧松两个伺服驱动器上环路电缆连接器的螺纹压圈。

断开环路电缆与伺服驱动器的连接。

10.6.3.2 更换环路电缆
使用具有相同类型和长度的电缆更换环路电缆。请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 设计指南查看

部件号。

10.6.3.3 连接环路电缆
将环路电缆的公接头连接到伺服驱动器的母接头。

将环路电缆的母接头连接到邻近伺服驱动器的公接头。

用手将两个伺服驱动器上的螺纹压圈拧紧。

确保电缆上无机械应力。

拧紧两个伺服驱动器上的连接器的螺纹压圈。

重新连接两个伺服驱动器上以前连接到 X3、X4 或 X5 端口的任何电缆。

10.7 在分布式访问模块 (DAM 510) 中更换熔断器
如果一个熔断器熔断，则使用同一批次的熔断器更换所有熔断器（熔断器 CAT 编号为 5012006.25，SIBA）。

操作步骤

拆除螺钉 [1] 然后拆除盖板。

1

e
3

0
b

g
8

0
0

.1
0

图解 117: 打开 DAM 510 上的盖板

使用螺丝刀拆除熔断器，然后使用相同数量的同一类型的熔断器（请参阅 5.4.1 熔断器）替换它们。
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图解 118: 拆除熔断器

重新装回盖板并拧紧螺钉 [1]。紧固力矩为 2 Nm。

10.8 更换风扇

e
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g
8

1
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0

图解 119: 更换 50 毫米模块上的风扇
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图解 120: 更换 100 毫米模块上的风扇
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-

注 意

有关风扇类型的更多信息，请参阅 VLT® Servo Drive System ISD 510、DSD 510、MSD 510 设计指南。

操作步骤

使用螺丝刀作为撬杆，松开风扇支架。

拆下风扇。

使用同类风扇进行更换。

10.9 产品退回
可以将 Danfoss  产品退回来进行免费处置。前提条件是这些产品上不带有影响处置的沉积物，如油、油脂或其他类型污染物。
此外，在退回的产品中不能包括任何异物或第三方组件。

将产品以船上交货形式发运到当地的 Danfoss  销售公司。

10.10 回收
将金属和塑料送至回收站。

伺服驱动器和系统模块被分类为电子废弃物，包装被分类为包装废弃物。

10.11 处置
包含电子元件的设备不能与正常生活垃圾一起处置。

按照适用的地方法规，将伺服驱动器和系统模块作为危险废弃物、电气废弃物、可回收废弃物等进行处置。
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11 规格

11.1 铭牌
查看铭牌并将它与订单数据进行比较。使用部件编号作为参考。部件编号用于唯一标识模块类型。

确保铭牌清晰可辨。

11.1.1 系统模块正面的铭牌示例
确保铭牌清晰可辨。

MSD 510  系统模块正面的铭牌上显示出以下数据：

VLT PSM 510

DANGER

PART NO:     175G0166

SERIAL NO:  966001Q368

OUTPUT: Pnom: 30kW

Notes:

MAC PSM
X1 IN:

X2 OUT:

15 MIN

00:1B:08:15:B3:XX
00:1B:08:15:B3:XX

00:1B:08:15:B3:XX

e3
0b

g2
76

.1
01

2

3
4

5

6

7

8

9
Motor over-temperature sensing is required

图解 121: MSD 510 系统模块正面的铭牌示例

1 丹佛斯徽标

2 MSD 510 模块名称

3 部件编号

4 序列号

5 输出

6 二维码

7 注释

8 MAC 地址

9 警告符号

11.1.2 系统模块侧面的铭牌示例
系统模块正面的铭牌上显示出以下数据：
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图解 122: PSM 510 的系统模块侧面的铭牌示例

1 类型代码

2 供电电压

3 输出电压

4 昀大功率

5 环境温度范围

6 防护等级： IP20，符合 IEC/EN 60529（连接器除
外，它的防护等级为 IP00）。

7 UAUX 电源

8 短路电流额定值

9 额定功率

11.2 电源模块 (PSM 510)

11.2.1 PSM 510 的尺寸
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图解 123: PSM 510 的尺寸
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11.2.2 PSM 510 的特性数据
表 121: 电源模块 (PSM 510) 的特性数据

定义 单位 功率规格 1 功率规格 2 功率规格 3

输入

主电源输入电压 V AC 400–480 ±10%，3 相（请参阅 5.2 电气环境条件）

输入电流（UMIN 时） A 20 34 50

输入电源 VA 12.5 22 32

UAUX 输入电压 V DC 24/48 ±10%

UAUX 电流消耗（24 V DC 时） A DC 2.0

UAUX 电流消耗（48 V DC 时） A DC 1.0

输出

直流回路电压 V DC 565–680 ±10%

直流回路电容 µF 1800

额定电流 IN A 20 40 60

额定功率 PN kW 10 20 30

峰值功率 Pmax t <3.0 s) kW 20 40 60

内部制动电阻器(1)

峰值功率 Pmax kW 8

额定功率 PN W 150

额定电阻 Ω 15

外部制动电阻器

峰值功率 Pmax kW 60

额定功率 PN kW 7.5

昀小电阻 Ω 10

通用

符合 EN 61800-3 标准的线路滤波器 – 类别 C3

冷却 – 集成式风扇

安装方式 – 使用背部链路连接器采用壁挂式安装在背板上

重量 kg 6

尺寸（宽 x 高 x 深） mm 137.3 x 406.3 x 270

1 可连接外部制动电阻器。
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11.3 伺服驱动器模块 (SDM 511/SDM 512)

11.3.1 电机过载保护

注 意

内部电机过载保护功能以电机满负荷电流的 105% 工作。

指导具有标称电机电流（电机技术标签上的满负荷电流）的 SDM 511/SDM 512 正确使用保护功能。

SDM 511/SDM 512 在实际设置为电流设置的以下倍数的情况下集成了内部过载保护功能：

表 122: 电流设置的倍数

电流设置的倍数 昀长跳闸时间

7.2 20 秒

1.5 8 分钟

1.2 2 小时

11.3.2 电机温度过高保护
SDM 511/SDM 512 中实施的内部电机过载保护功能不具有热存储器保持或速度敏感性。

注 意

未集成内部电机温度过高保护功能，因此，需要探测电机温度是否过高。SDM 511/SDM 512 带有一个用于连接电机温度
传感器的输入端。
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11.3.3 尺寸
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图解 124: SDM 511/SDM 512，机箱规格 1 (FS1) 的尺寸
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图解 125: SDM 511，机箱规格 2 (FS2) 的尺寸

11.3.4 SDM 511 特性数据
表 123: SDM 511 的特性数据

规格 单位 机箱规格 1

(FS1)，2.5 A

机箱规格 1

(FS1)，5 A

机箱规格 1

(FS1)，10 A

机箱规格 1

(FS1)，20 A

机箱规格 2

(FS2)，40 A

输入

直流回路 V DC 565–680 ±10%

直流回路电容 μF 330 900

UAUX V DC 24/48 ±10%

UAUX 电流消耗（24 V DC 时） A DC 1.8 2.5

UAUX 电流消耗（48 V DC 时） A DC 0.9 1.3

输出

输出相数 – 3

输出电压 V AC VIN PSM

额定电流 IN Arms 2.5 5 10 20 40

额定功率 PN kW 0.5 2.2 4 11 22

峰值电流（rms 值）Imax t

<2.65 s

Arms 10 20 30 40 80

额定开关频率 kHz 4/5
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规格 单位 机箱规格 1

(FS1)，2.5 A

机箱规格 1

(FS1)，5 A

机箱规格 1

(FS1)，10 A

机箱规格 1

(FS1)，20 A

机箱规格 2

(FS2)，40 A

可能开关频率 kHz 8/10

8 kHz 开关频率下额定电流
和峰值电流的降容

% 65

10 kHz 开关频率下额定电
流和峰值电流的降容

% 55

保护措施 – 过载、短路和接地故障保护

昀大输出频率 Hz 590

功能安全 – STO

冷却 – 集成式风扇

安装方式 – 使用背部链路连接器采用壁挂式安装在背板上

电机连接器的数量 – 1

重量 kg 3.9 6.2

尺寸

(W x H x D)

mm 84.3 x 471 x 270 134.3 x 471 x
270

11.3.5 SDM 512 特性数据
表 124: SDM 512 的特性数据

规格 单位 机箱规格 1 (FS1)，2 x

2.5 A

机箱规格 1 (FS1)，2 x

5 A

机箱规格 1 (FS1)，2 x

10 A

输入

直流回路 V DC 565–680 ±10%

直流回路电容 µF 330

UAUX V DC 24/48 ±10%

UAUX 电流消耗（24 V DC 时） A DC 2.3

UAUX 电流消耗（48 V DC 时） A DC 1.2

输出

输出相数 – 3

输出电压 V AC VIN PSM

额定电流 IN Arms 2 x 2.5 2 x 5 2 x 10

额定功率 PN kW 2 x 0.75 2 x 2.2 2 x 4

峰值电流（rms 值）Imax t <2.65 s Arms 2 x 10 2 x 15 2 x 20

额定开关频率 kHz 4/5

可能开关频率 kHz 8/10

8 kHz 开关频率下额定电流和峰值电流
的降容

% 65
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规格 单位 机箱规格 1 (FS1)，2 x

2.5 A

机箱规格 1 (FS1)，2 x

5 A

机箱规格 1 (FS1)，2 x

10 A

10 kHz 开关频率下额定电流和峰值电
流的降容

% 55

保护措施 – 过载、短路和接地故障保护

昀大输出频率 Hz 590

功能安全 – STO

冷却 – 集成式风扇

安装方式 – 使用背部链路连接器采用壁挂式安装在背板上

电机连接器的数量 – 2

重量 kg 4.0

尺寸

(W x H x D)

mm 84.3 x 471 x 270

11.4 分布式访问模块 (DAM 510)

11.4.1 DAM 510 的尺寸
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图解 126: DAM 510 的尺寸
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11.4.2 DAM 510 的特性数据
表 125: 分布式访问模块 (DAM 510) 的特性数据

定义 单位 功率规格 1 功率规格 2

输入

直流回路 V DC 565–680 ±10%

直流回路电容 µF 660

昀大输入电流 A DC 15 25

UAUX V DC 24/48 ±10%

UAUX 电流消耗（24 V DC 时） A DC 0.5

UAUX 电流消耗（48 V DC 时） A DC 0.3

输出

输出电压 V DC VOUT PSM

输出电流直流回路 A DC 15 25

直流回路峰值电流（rms 值）t <1.0 s Arms 30，持续不到 1 秒 48，持续不到 1 秒

输出电流 UAUX A DC 15

保护措施 – 过载、短路和接地故障保护

冷却 – 自然对流

安装方式 – 使用背部链路连接器采用壁挂式安装在背板上

重量 kg 3.05

尺寸（宽 x 高 x 深） mm 84.3 x 467.9 x 270

11.4.3 混合电缆保护
辅助 24/48 V 线路具有 3 个保护等级：

软件（秒定时范围）： 如果出现过载 (>15 A)，控制板将打开 24/48 V 辅助线路。

硬件（微秒定时范围）： 如果出现大于 36 A 的短路电流，则自动打开。

硬件： 如果前两个熔断器出现故障，则使用 20 A 不可更换的 SMD（ 表面安装器件）型熔断器。
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11.5 辅助电容器模块 (ACM 510)

11.5.1 尺寸
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图解 127: ACM 510 的尺寸

11.5.2 ACM 510 的特性数据
表 126: 辅助电容器模块 (ACM 510) 特性数据

定义 单位 值

直流回路 V DC 565–680 ±10%

直流回路电容 µF 2750

UAUX V DC 24/48 ±10%

UAUX 电流消耗（24 V DC 时） A DC 0.5

UAUX 电流消耗（48 V DC 时） A DC 0.3

冷却 – 自然对流

安装方式 – 使用背部链路连接器采用壁挂式安装在背板上

重量 kg 3.54

尺寸（宽 x 高 x 深） mm 84 x 371 x 270
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11.6 扩展模块 (EXM 510)

11.6.1 尺寸
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图解 128: EXM 510 的尺寸

11.6.2 EXM 510 的特性数据
表 127: 扩展模块 (EXM 510) 特性数据

定义 单位 值

直流回路 V DC 565–680 ±10%

昀大电流 A DC 62

安装方式 – 使用背部链路连接器采用壁挂式安装在背板上

重量 kg 0.6

尺寸（宽 x 高 x 深） mm 87 x 380 x 145

11.7 系统模块上的连接器

11.7.1 背部链路连接器
背部链路连接器位于所有 MSD 510  系统模块的背部顶部。
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图解 129: 背部链路连接器的引脚分配

表 128: 背部链路连接器的引脚分配

引脚 说明

1 24/48 V

2 GND

3 FE： 功能地

4 DC–

5 DC+
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11.7.2 制动连接器
制动连接器位于电源模块 (PSM 510) 和伺服驱动器模块 (SDM 511/SDM 512) 上。

11.7.2.1 PSM 510 上的制动电阻器连接器

e
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b

g
4

5
0

.1
0

图解 130: PSM 510 上的制动连接器

表 129: PSM 510 上制动连接器的引脚分配

引脚（从左至右） 说明 注释 额定值

1 DC+/R+ 用于连接制动电阻器。 额定电压： 560–800 V DC

昀大制动电流： 80 A

导体横截面积范围： 0.75–16 mm2 (AWG 18–AWG 4)
2 R–

注 意

制动电缆的昀大长度为 30 米（屏蔽）。

11.7.2.2 SDM 511/SDM 512 上的制动和电机温度传感器连接器
SDM 511/SDM 512 上的制动连接器用于机械制动和温度传感器（如果有）。

1 2 3 4
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g4
58
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1

图解 131: SDM 511/SDM 512 上的制动连接器

表 130: SDM 511/SDM 512 上的制动连接器

连接器名称 说明 引脚 额定值/注释

机械制动和电机温度传感
器连接器

用于连接电机的机械制
动（如果有）。

请参阅 表
131。

额定电压： 24 V

昀大（峰值）电压： 48 V ±10%

昀大制动电流： 2.5 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)

表 131: SDM 511/SDM 512 上的机械制动和电机温度传感器连接器的引脚分配

引脚 说明 注释 额定值/参数

1 TEMP– 用于连接电机的温度传感器（如果有）。 KTY83–110

KTY84–130
2 TEMP+
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引脚 说明 注释 额定值/参数

PT1000

3 BRAKE– 用于连接电机的机械制动（如果有）。 额定电压： 24 V

昀大（峰值）电压： 48 V ±10%

昀大制动电流： 2.5 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)

4 BRAKE+

注 意

可将温度测量端连接到伺服驱动器模块 SDM 511/SDM 512 上的电机反馈连接器（请参阅 11.7.13 电机反馈连接器）或
制动和电机温度传感器连接器。这些连接器不能以并联方式连接。

注 意

此连接器上的信号称为 GND，因此，必须进行加强绝缘以防止电机相干扰。内部绝缘装置必须能够承受 4240 V DC 和
8000 Vpeak 脉冲。

注 意

只能将 PELV 电势连接到温度传感器输入端。

注 意

制动电缆的昀大长度为 80 米（屏蔽）。

11.7.3 以太网连接器
以太网连接器位于所有系统模块上。
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图解 132: 以太网连接器

注 意

只能将 PELV 电势连接到数字输入和输出端。

11.7.3.1 PSM 510 和 ACM 510 上的以太网连接器
表 132: PSM 510 和 ACM 510 上的以太网连接器

连接器名称 说明 引脚 额定值

X1 IN 以太网输入端 1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

符合标准 100BASE-T。

X2 OUT 以太网输出端 1
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连接器名称 说明 引脚 额定值

8: –

11.7.3.2 DAM 510 上的以太网连接器
表 133: DAM 510 上的以太网连接器

连接器名称 说明 引脚 额定值

X1 IN 以太网输入端 1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

符合标准 100BASE-T。

X2 OUT 以太网输出端 1

X3 OUT 以太网输出端 2（连接至混合电缆）

11.7.3.3 SDM 511/SDM 512 上的以太网连接器
表 134: 以太网连接器

连接器名称 说明 引脚 额定值

SDM1 X1 IN 以太网输入端 1 1: Tx+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

符合标准 100BASE-T。

SDM1 X2 OUT 以太网输出端 1

SDM2 X1 IN(1) 以太网输入端 2

SDM2 X2 OUT(1) 以太网输出端 2

1 仅限 SDM 512

11.7.4 I/O 连接器

11.7.4.1 PSM 510/ACM 510 上的 I/O 连接器

1 2 3 4

e3
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g4
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.1
1

图解 133: PSM 510 (I/O PSM) 和 ACM 510 (I/O ACM) 上的 I/O 连接器

表 135: PSM 510/ACM 510 上 I/O 连接器的引脚分配

引脚 说明 注释 额定值/参数

1 DIN1– 数字输入 输入电压： 0–48 V DC

高（逻辑 "1"）电压： 15–48 V DC
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引脚 说明 注释 额定值/参数

低（逻辑 "0"）电压： <5 V DC

昀大输入信号频率： 50 Hz

48 V 时的昀大输入电流： 11 mA

昀大输入电阻： 4.5 KΩ

2 DIN1+

3 DIG_OUT– 数字输出 端子间的昀大电压： 24 V DC 或 AC

昀大电流： 1 A

昀大输出开关频率： 50 Hz
4 DIG_OUT+

导体横截面积范围为 0.2–1.5 mm2 (AWG 24–AWG 16)。

注 意

只能将 PELV 电势连接到数字输入和输出端。

11.7.4.2 SDM 511/512 上的 I/O 连接器

10 9 8 7 6 5 4 3 2 1
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图解 134: SDM 511/512 上的 I/O 连接器

表 136: SDM 511/SDM 512 上 I/O 连接器的引脚分配

引脚 说明 注释 额定值/参数

1 24 V AUX – –

2 接地 – –

3 DigInOut1 数字输入/输出（可通过软件切换） 数字输入：

额定电压： 0–24 V

带宽： ≦100 kHz

数字输出：

额定电压： 24 V ±20%

昀大电流： 150 mA
()

昀大开关频率： 100 Hz

4 DigOut1 数字输出 额定电压： 24 V ±20%

昀大电流： 150 mA
(1)

昀大开关频率： 100 Hz

5 DigOut2

6 DigOut3

7 DigIn4 数字输入 数字输入：

电隔离

高（逻辑 "1"）电压： 10–30 V DC

低（逻辑 "0"）电压： <5 V DC

额定电压： 0–24 V

昀大电流： 3 mA

输入电阻： 10 kΩ

8 DigIn3

AQ262450196490zh-000101 / 175R1170 | 179Danfoss A/S © 2019.10

规格

VLT® Multiaxis Servo Drive MSD 510 System

操作指南



-

-

引脚 说明 注释 额定值/参数

昀大开关频率： 100 Hz

9 DigIn2 模拟/数字输入 数字输入：

额定电压： 0–24 V

带宽： ≦100 kHz

模拟输入

额定电压： 0–10 V

输入阻抗： 5.46 kΩ

带宽： ≦25 kHz

10 DigIn1

1 所有 4 个数字输出的昀大总和输出电流。如果使用全部 4 个数字输出，则每个输出的昀大输出电流为 30 mA。

导体横截面积范围为 0.2–1.5 mm2 (AWG 24–AWG 16)。

注 意

只能将 PELV 电势连接到数字输入和输出端。

11.7.5 UAUX 连接器
UAUX 连接器位于电源模块 (PSM 510) 上。
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图解 135: UAUX 连接器

表 137: UAUX 连接器的引脚分配

引脚

（从左至
右）

说明 注释 额定值/参数

1 24 V
AUX

用于为电源模块 (PSM 510) 提供
24–48 V 直流输入。

额定输入电压： 24 V/48 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 50 A

昀大横截面积： 16 mm2

昀大电缆长度： 3 米

导体横截面积范围为 0.75–16 mm2，实芯或软质 (AWG 18–AWG 4)

2 GND

注 意

只能将 PELV 电势连接到 UAUX 输入端。

11.7.5.1 PSM 510 的 24/48 V 电缆横截面积

符合 CE 标准的昀小电缆横截面积（昀低 70 °C，铜芯） 16 mm2

符合 UL 标准的昀小电缆横截面积（昀低 60 °C，铜芯） 4 AWG
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11.7.6 LCP 连接器（M8，6 芯）
LCP 连接器位于系统模块正面。它用于通过电缆直接连接 LCP。
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图解 136: LCP 连接器（M8，6 芯）

表 138: LCP 连接器的引脚分配

引脚 说明 注释 额定值/参数

1 未连接 – –

2 /LCP RST 复位 ≦0.5 V 时激活

3 LCP RS485 RS485 正电平信号 速度：

38.4 kBd

该级别满足 RS485 规范。
4 /LCP RS485 RS485 负电平信号

5 GND GND –

6 VCC 用于 LCP 的 5 V 电源 120 mA 昀大负载下为 5 V ±10%

注 意

只能将 PELV 电势连接到 LCP 输入端。

11.7.7 交流主电源连接器
交流主电源连接器位于电源模块 (PSM 510) 的底部。
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图解 137: 交流主电源连接器

表 139: 交流主电源连接器的引脚分配

引脚

（从左至右）

说明 注释 额定值/参数

1 L3 用于连接 L1/L2/L3 额定电压： 400–480 V AC ±10%

额定功率： 30 kW

昀大横截面积： 16 mm2 (AWG 4)

导体横截面积范围为 0.75–16 mm2，实芯或软质 (AWG 18–AWG 4)

2 L2

3 L1
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11.7.7.1 PSM 510 的电源电缆横截面积
表 140: PSM 510 的电源电缆横截面积

PSM 510 (10 kW) PSM 510 (20 kW) PSM 510 (30 kW)

符合 CE 标准的昀小电缆横截面积 4 mm2

（昀低 70 °C，铜芯）

16 mm2

（昀低 70 °C，铜芯）

16 mm2

（昀低 90 °C，铜芯）

符合 UL 标准的昀小电缆横截面积 AWG 10

（昀低 60 °C，铜芯）

AWG 6

（昀低 60 °C，铜芯）

AWG 4

（昀低 75 °C，铜芯）

11.7.8 电机连接器
电机连接器位于伺服驱动器模块（SDM 511 和 SDM 512）底部。
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图解 138: 电机连接器

表 141: 电机连接器的引脚分配

引脚

（从左
至右）

说
明

注释 额定值/参数

1 U SDM 511 配有 1 个电
机连接器。

SDM 512 配有 2 个电
机连接器。

额定电压： 400–480 V AC±10%

额定功率： 取决于伺服驱动器的规格。

导体横截面积范围：

SDM 511 2.5–20 Arms： 导体横截面积范围为 0.2–6 mm2，软质 (AWG 24–AWG 8)

SDM 511 40 Arms： 导体横截面积范围为 0.75–16 mm2，实芯或软质 (AWG 18–

AWG 4)

SDM 512 2.5–10 Arms： 导体横截面积范围为 0.2–6 mm2，软质 (AWG 24–AWG 8)

2 V

3 W

11.7.8.1 SDM 511 的电机电缆横截面积
表 142: SDM 511 的电机电缆横截面积

SDM 511

(2.5 Arms)

SDM 511

(5 Arms)

SDM 511

(10 Arms)

SDM 511

(20 Arms)

SDM 511

(40 Arms)

符合 CE 标准的昀小电缆横截面积（昀低
70 °C，铜芯）

1.5 mm2 4 mm2 10 mm2

符合 UL 标准的昀小电缆横截面积（昀低
60 °C，铜芯）

14 AWG 10 AWG 6 AWG

11.7.8.2 SDM 512 的电机电缆横截面积
表 143: SDM 511 的电机电缆横截面积

SDM 512 (2.5 Arms) SDM 512 (5 Arms) SDM 512 (10 Arms)

符合 CE 标准的昀小电缆横截面积（昀低 70 °C，铜芯） 1.5 mm2

符合 UL 标准的昀小电缆横截面积（昀低 60 °C，铜芯） 14 AWG
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11.7.9 继电器连接器
继电器连接器用于提供由用户定义的反应，分布情况如下所示：

伺服驱动器模块 SDM 511： 1 个继电器连接器

伺服驱动器模块 SDM 512： 2 个继电器连接器

电源模块 PSM 510： 1 个继电器连接器

辅助电容器模块 ACM 510： 1 个继电器连接器

注 意

只能将 PELV 电势连接到继电器输出端。

11.7.9.1 PSM 510/ACM 510 上的继电器连接器

11 12 13

e3
0b

g4
53

.1
1

图解 139: PSM 510/ACM 510 上的继电器连接器

表 144: PSM 510 (REL PSM) 和 ACM 510 (REL ACM) 上的继电器连接器的引脚分配

引脚 说明 注释 额定值/参数

11 NC 常闭，24 V DC 额定电流： 2 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)
12 NO 常开，24 V DC

13 COM 公用

11.7.9.2 SDM 511/SDM 512 上的继电器连接器
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图解 140: SDM 511 机箱规格 1 (FS1)/SDM 512 的继电器连接器
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图解 141: SDM 511 机箱规格 2 (FS2) 的继电器连接器

表 145: SDM 511/SDM 512 上继电器连接器的引脚分配

名称 引脚 说明 注释 额定值/参数

REL SDM1 11 NC 常闭，24 V DC 额定电流： 2 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)
12 NO 常开，24 V DC

13 COM 公用

REL SDM2(1) 21 NC 常闭，24 V DC

22 NO 常开，24 V DC

23 COM 公用

1 仅限 SDM 512。

11.7.10 STO 连接器

11.7.10.1 SDM 511 和 SDM 512 上的 STO 连接器
STO 连接器位于伺服驱动器模块上，如下所示：

SDM 511： 1 个输入和 1 个输出 STO 连接器

SDM 512： 2 个输入和 2 个输出 STO 连接器
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图解 142: SDM 511/SDM 512 上的 STO 连接器
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表 146: SDM 511/SDM 512 上的 STO 连接器的引脚分配

连接器名称 引脚 说明 注释 额定值/参数

SDM511：

STO SDM

SDM512：

STO SDM1

STO SDM2

1 STO– 用于连接到 PSM 510、DAM 510 或
SDM 511/2 的输入端的 STO 输出电
压 1/2。

额定电压： 24 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 1 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)

2 STO+

3 STO– 用于 STO 输入电压 1/2。

4 STO+

注 意

只能将 PELV 电势连接到 STO 输入端。

11.7.10.2 PSM 510 上的 STO 连接器
电源模块 (PSM 510) 上有一个输入和一个输出 STO 连接器。
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图解 143: PSM 510 上的 STO 输出连接器
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图解 144: PSM 510 上的 STO 输入连接器
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表 147: PSM 510 上的 STO 连接器的引脚分配

连接器名
称

引脚 说明 注释 额定值/参数

STO PSM 1 STO– 用于将 STO 输出电压连接到其他系统
模块的输入端。

额定电压： 24 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 1 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)

2 STO+

3 STO– 用于 STO 输入电压。

4 STO+

注 意

只能将 PELV 电势连接到 STO 输入端。

11.7.10.3 DAM 510 上的 STO 连接器

11.7.10.3.1 DAM 510 顶部的 STO 连接器
分布式访问模块 (DAM 510) 顶部有一个输入和一个输出 STO 连接器。
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图解 145: DAM 510 顶部的 STO 输出连接器
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图解 146: DAM 510 顶部的 STO 输入连接器
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表 148: DAM 510 顶部的 STO 连接器的引脚分配

连接器名
称

引脚 说明 注释 额定值/参数

STO DAM 1 STO– 用于将 STO 输出电压连接到其他系统
模块的输入端。

额定电压： 24 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 1 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)

2 STO+

3 STO– 用于 STO 输入电压。

4 STO+

注 意

只能将 PELV 电势连接到 STO 输入端。

11.7.10.3.2 DAM 510 底部的 STO 连接器
分布式访问模块 (DAM 510) 底部有一个输出 STO 连接器。该输出用于混合电缆。
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图解 147: DAM 510 底部的 STO 连接器

表 149: DAM 510 底部的 STO 连接器的引脚分配

连接器名称 引脚

（从左至右）

说明 注释 额定值/参数

STO DAM 1 STO+ 用于从 DAM 至混合电缆的 STO
输出。

额定电压： 24 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 1 A

导体横截面积范围： 0.2–1.5 mm2 (AWG 24–AWG 16)

插头端子紧固力矩： 0.22–0.25 Nm

2 STO–

11.7.11 UDC 连接器
UDC 连接器位于分布式访问模块 (DAM 510) 底部。
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图解 148: UDC 连接器
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表 150: UDC 连接器的引脚分配

引脚

（从左至
右）

说明 注释 额定值/参数

1 UDC+ 用于将直流回路电压从分布式访问模块 (DAM 510)
连接到 ISD 线路的混合电缆。

额定电压： 560–800 V DC

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 25 A

导体横截面积范围： 0.2–6 mm2 (AWG 24–AWG 10)

插头端子紧固力矩： 0.5–0.8 Nm

2 UDC–

11.7.12 AUX 连接器
AUX 连接器位于分布式访问模块 (DAM 510) 底部。
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图解 149: AUX 连接器

表 151: AUX 连接器的引脚分配

引脚

（从左
至右）

说明 注释 额定值/参数

1 AUX+

(24/48 V)

用于将 AUX 输出从分布式访问模块
(DAM 510) 连接到伺服驱动器线路的混合
电缆。

额定电压： 24/48 V DC ±10%

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 15 A

导体横截面积范围： 0.2–2.5 mm2 (AWG 24–AWG 12)

插头端子紧固力矩： 0.5–0.6 Nm

2 AUX– (GND)

注 意

只能将 PELV 电势连接到 AUX 输出端。

11.7.13 电机反馈连接器
使用电机反馈连接器，可将编码器或旋变连接到伺服驱动器模块 SDM 511/SDM 512。

SDM 511 具有 1 个电机反馈连接器 (E SDM1)。

SDM 512 具有 2 个电机反馈连接器（E SDM1 和 E SDM2）。

电机反馈连接器满足以下规范：

BISS B

旋变

HIPERFACE®

HIPERFACE® DSL

EnDat 2.1

EnDat 2.2
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使用满足所用的反馈类型的要求的屏蔽反馈电缆。昀大电缆长度为 80 米。
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图解 150: SDM 511/SDM 512 上的电机反馈连接器

表 152: 电机反馈连接器 E SDM1 和 E SDM2 的引脚分配

引脚 说明 旋变 BISS B HIPERFACE HIPERFACE

DSL

EnDat 2.1

和 2.2

额定值/参数

1 \RESCOS X – X – (1) 旋变负电平余弦输入

2 RESCOS X – X – (1) 旋变正电平余弦输入

3 SUPPLY+(2) – X X – X +5/11 V（取决于反馈类型），昀高 250 mA

4 \RXTX – X X – X 编码器负电平数据信号

5 RXTX – X X – X 编码器正电平数据信号

6 HIPERFACE_DSL+ – – – X – HIPERFACE DSL 正电平线路

7 – – – – – – –

8 – – – – – – –

9 TEMP– X X X – X 电机温度传感器输入

10 \RESSIN X – X – (1) 旋变负电平正弦输入

11 SUPPLY+(2) – – – – – +5/11 V（取决于反馈类型），昀高 250 mA

12 SUPPLY–(2) – X X – X GND

13 \RESSY X – – – (1) 旋变负电平激励器输出

14 RESSY X – – – (1) 旋变正电平激励器输出

15 HIPERFACE_DSL– – – – X – HIPERFACE DSL 负电平线路

16 – – – – – – –

17 – – – – – – –

18 TEMP+ X X X – X 电机温度传感器输入

19 RESSIN X – X – (1) 旋变正电平正弦输入

20 ENC_CLK – X – – X 编码器正电平时钟信号

21 \ENC_CLK – X – – X 编码器负电平时钟信号

22 SUPPLY+(2) – X X – X +5/11 V（取决于反馈类型），昀高 250 mA

23 SENS+(3) – X X – X 正电源感应线路

24 SENS–(3) – X X – X 负电源感应线路

25 SUPPLY–(2) – X X – X GND
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-
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引脚 说明 旋变 BISS B HIPERFACE HIPERFACE

DSL

EnDat 2.1

和 2.2

额定值/参数

26 – – – – – – –

1 正弦和余弦信号对于 EnDat 是可选的

2  电源自动在 5 V 和 11 V 之间切换，具体取决于所选的反馈类型。引脚 3、11 和 22 的功能是等同的，不必同时连接所有三个引脚。为降

低反馈电缆的压降，可并联使用多个电源线路。

3 要激活内部电源补偿，将电机侧的 2 个感应线路（SENS+ 和 SENS–）连接到电源（SUPPLY+ 和 SUPPLY–）。这将自动根据电缆长度调整电

源电压，并补偿反馈电缆上的压降。

注 意

可将电机温度测量端连接到伺服驱动器模块 SDM 511/SDM 512 上的电机反馈连接器或制动和电机温度传感器连接器（请
参阅 11.7.2.2 SDM 511/SDM 512 上的制动和电机温度传感器连接器）。这些连接器不能以并联方式连接。

注 意

只能将 PELV 电势连接到电机反馈连接器。

11.7.14 外部编码器连接器
该连接器用于将外部编码器连接到 SDM 511/SDM 512 和 DAM 510。它为 CAM 模式和齿轮模式提供了一个指导值。

外部编码器连接器位于伺服驱动器模块 (SDM 511/SDM 512) 和分布式访问模块 (DAM 510) 上，如下所示：

SDM 511： E SDM1

SDM 512： E SDM1 和 E SDM2

DAM 510： E DAM

5 1

69 e3
0b

g4
61

.1
0

图解 151: 外部编码器连接器

表 153: 外部编码器连接器

连接器名称 说明 引脚 额定值/注释

E SDM1/ E SDM2/
E DAM

用于将外部编码器连接到
SDM 511/SDM 512/DAM 510。

请参阅 表 154。 额定电压： 24 V DC，隔离（请参阅 表 154）

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 150 mA（请参阅 表 154）

满足以下规格：

BISS/SSI

表 154: 外部编码器连接器 (X1/X2) 的引脚分配

引脚 说明 注释

SSI/BiSS

注释

1 24 V 24 V DC ±10%（用于为编码器供电） 昀大电流： 150 mA

2 – – –

3 – – –
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引脚 说明 注释

SSI/BiSS

注释

4 RS422 RXD 正值数据 总线速度：

SSI： 时钟频率昀高可达 10 Mhz，带 30 米电缆。

BiSS： 满足 RS485 规范。
5 RS422 TXD 正值数据

6 GX 隔离接地。

如果编码器由外部供电，则必须将外部电源的接地
端连接到 GX。

–

7 – – –

8 /RS422 RXD 负值数据 总线速度：

SSI： 0.5 Mbit，带 25 米电缆。

BiSS： 满足 RS485 规范。
9 /RS422 TXD 负值数据

注 意

只能将 PELV 电势连接到外部编码器。

11.7.15 扩展模块连接器

e3
0b

h3
90

.1
0

DC+ DC- GND
24 V
48 V

图解 152: 扩展模块连接器

表 155: 扩展模块连接器的引脚分配

引脚

（从左
至右）

说明 注意 额定值/参数

1 DC+ 使用 EXM 510 EMC 板上的电缆
扎带对直流电缆进行屏蔽。

额定电压： 560–800 V DC

额定电流： 取决于应用中的伺服驱动器的数量。

昀大电流： 62 A
(1)

导体横截面积范围： 0.75–16 mm2，实芯或软质 (AWG 18–AWG 4)

只能使用无塑料套筒的箍和 CRIMPFOX 16 S。

对 UDC (DC+, DC–) 使用屏蔽导体。

插头端子紧固力矩： 1.7–1.8 Nm

2

3 DC–

4

5 FE（功能
地）

–

6 GND –

7 24/48 V –

1 1 对 EXM 的昀大额定电流为 62 A。在带有 2 个 PSM 510 模块的系统中，2 对 EXM 510 模块可用于实现昀高 124 A 的额定电流。
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11.8 MSD 510 系统的一般规格和环境条件
表 156: MSD 510 系统的一般规格和环境条件

规格 值

防护等级 IP20，符合 IEC/EN 60529（连接器除外，它的防护等级为 IP00）。

警 告
电击危险

如果使用未连接到背板的模块来操作系统，则系统无法达到 IP20 等级。这可能会

导致严重伤亡。

请勿在从背板上拆除模块后接触背板。

振动测试 随机振动： 1.14 g（每轴 2 小时，符合 EN 60068-2-64）

正弦振动： 0.7 g（每轴 2 小时，符合 EN 60068-2-6）

昀高相对湿度 存放/运输： 5–95%（无冷凝）

固定使用： 5–93%（无冷凝）

环境温度范围 工作： 额定温度范围 5–40 °C，昀高 55 °C 并降容（请参阅 图解 153）

运输： –25 °C 至 +55 °C

存放： –25 °C 至 +55 °C

安装海拔 额定电流，海拔不超过 1000 米。

1000–3000 米时，输出电流降容 (1% / 100 m)。

不允许在海拔超过 3000 米的位置操作。

辐射和抗扰度的 EMC 标准 EN 61800-3

功能安全的 EMC 抗扰度 EN 61800-5-2 附录 E

符合 EN 60664-1 的污染度 2

符合 EN 61800-5-1 的过电压类别 III
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图解 153: 降容

11.9 存放
在干燥、无尘且低振动 (veff ≦0.2 mm/s) 的位置存放伺服系统。

存放位置不得有腐蚀气体。

避免温度突变。

长期存放

要对电解电容器进行重整，必须将未使用的伺服驱动器和系统组件每年连接到电源一次，以便电容器充电并放电。否则，电容
器会出现永久损坏。
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VLT Servo Drive 系统术语表

A
A 翼 伺服电机轴侧的 A 侧。

ACM 辅助电容器模块。

Automation Studio© Automation Studio© 是 B&R 的注册商标。它是用于 B&R 控制器的集

成软件开发环境。

B
B 侧 带有接插件连接器的伺服驱动器后侧。

B&R 跨国公司，专业生产工厂和流程自动化软件和系统，适合广泛的工业应
用。

Beckhoff® Beckhoff® 是德国 Beckhoff Automation GmbH 的注册商标，许可证由

该公司授予。

C
CANopen® CANopen® 是 CAN in Automation e.V. 的注册社区商标。

CE 欧洲测试和认证标志。

CIA DS 402 用于变频器和运动控制的设备子协议。CIA® 是 CAN in Automation

e.V. 的注册社区商标。

D
DAM 分布式访问模块

DSD 分布式伺服驱动器

E
EPSG 以太网 POWERLINK® 标准化联盟 (Ethernet POWERLINK Standardiza‐

tion Group)。

ETG EtherCAT® 技术协会 (EtherCAT Technology Group)

EtherCAT® EtherCAT®（用于控制自动化技术的以太网 (Ethernet for Control

Automation Technology)）是一个开放式高性能基于以太网的现场总线
系统。EtherCAT® 是德国 Beckhoff Automation GmbH 的注册商标和专

利技术，许可证由该公司授予。

I
IGBT 绝缘栅双极晶体管是一个 3 端点半导体设备，主要用作电子开关，效率

高且切换速度快。

IRT 同步实时。

ISD 集成伺服驱动器

L
LCP 本地控制面板 (Local control panel)。

M
M23 连接器 ISD 510/DSD 510 伺服驱动器标准版和高级版 B 侧用于连接混合馈电电

缆和环路电缆的连接器（X1 和 X2）。

MSD 多轴伺服驱动器
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P
PELV 保护特低电压是一种导致危险电击的风险较低的电压范围内的电压。

PLC 可编程逻辑器是一个用于自动执行电机过程的数字计算机，比如控制装
配线上的机械。

PLCopen® PLCopen® 是一个注册商标，连同 PLCopen® 徽标都由 PLCopen® 协会拥

有。PLCopen® 是一个独立于生产商和产品的全球性协会，制定了工业控

制编程标准。

POU 程序组织单元。可以是一个程序、功能块或功能。

PSM 电源模块。

PWM 脉冲宽度调制。

R
RCCB 漏电断路器。

S
SDM 伺服驱动器模块。

SIL 2 安全集成等级 II。

SSI 同步串行接口。

STO Safe Torque Off 功能。激活 STO 后，ISD 510 伺服驱动器将不再能够
产生电机转矩。

T
TwinCAT® TwinCAT® 是德国 Beckhoff Automation GmbH 的注册商标，许可证由该

公司授予。它是用于 Beckhoff 生产的控制器的集成软件开发环境。

U
UAUX 辅助电源，为伺服驱动器的控制电子组件、电源模块 (PSM 510)、分布式

访问模块 (DAM 510) 和辅助电容器模块 (ACM 510) 供电。

V
VLT® Servo Toolbox 用于 VLT® Servo Drive 系统的参数设置和诊断的 Danfoss  计算机软

件工具。

W
Wireshark® Wireshark® 是 GNU 通用公共许可证版本 2 中发布的网络协议分析软

件。

以
以太网 POWERLINK® 以太网 POWERLINK® 是标准以太网的确定性实时协议。它是一个由以太

网 POWERLINK® 标准化联盟 (EPSG) 管理的开放式协议。由奥地利自动

化公司 B&R 于 2001 引入。

冷
冷却 分布式伺服驱动器通过自然对流（无风扇）冷却。伺服驱动器模块

SDM 511/SDM 512 和 ACM 510 以外的所有系统模块都由内部风扇冷却。

制
制动 伺服驱动器上的机械夹持制动。
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功
功能块 设备功能可通过工程环境软件来访问。

单
单圈编码器 一种绝对值型编码器，在该编码器中，转动一次后的绝对位置保持已知。

反
反馈系统 反馈系统用于测量转子位置。

固
固件 设备中的软件， 在控制板上运行。

多
多圈编码器 一种绝对值型编码器，在该编码器中，多次转动后绝对位置仍保持已知。

安
安全 (STO) 关闭 IGBT 的驱动器组件电压的伺服驱动器安全电路。

安装海拔 在普通海平面以上的安装高度，通常与降容因数有关。

旋
旋变 一种用于伺服电机的反馈装置，通常带有 2 个模拟轨迹（正弦和余弦）。

环
环境温度 伺服系统或组件邻近位置的温度。

环路电缆 带有两个 M23 连接器的两个分布式伺服驱动器之间的混合连接电缆。

现
现场总线 控制器与伺服轴和系统模块之间的通信总线， 一般位于控制器和现场节

点之间。

电
电机主轴 伺服电机 A 侧的旋转轴，通常不带键槽。

直
直流回路 每个伺服驱动器都有自己的直流回路，由电容器组成。

直流回路电压 由并联的多个伺服驱动器共享的直流电压。

直流电压 直流恒定电压。

示
示波器 示波器是 DDS Toolbox 软件的组成部分，用于诊断。使用它，可绘制出

内部信号。

系
系统模块 该术语包括电源模块 (PSM 510)、分布式访问模块 (DAM 510) 和可选的

辅助电容器模块 (ACM 510)。
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轴
轴承 伺服电机的滚珠轴承。

连
连接器 (M23) 伺服驱动器混合连接器。

静
静止（伺服驱动器） 电源打开，轴中无故障，且轴上无活动的运动命令。

馈
馈电电缆 分布式访问模块 (DAM 510) 与 ISD 510/DSD 510 伺服驱动器之间的混合

连接电缆。
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